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About Introduction
This wiki provides instructions for the installation, configuration and operation of the BlackTrax system.

An offline copy of the wiki can be downloaded from the link below. This version is current as of
April 2021. Offline BlackTrax Wiki Download 

 

 

 

© CAST Group of Companies Inc., 2002-2021 All rights reserved. BlackTrax, WYSIWYG, CAST Software,
and Autofocus are trademarks of the CAST Group of Companies Incorporated. All other trademarks and
logos are the property of their respective owners. Depending on your product/version, CAST incorporates
source code or libraries which are licensed to CAST and copyright protected. For more information, go
to http://cast-soft.com/third-party-libraries/. 

PATENT: https://cast-soft.com/ip/ 

A BlackTrax License will authorize the use of the BlackTrax system for a restricted number of output
connections based on the type of License that was purchased. For more information, go to Licensing.
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Text Conventions
The following text conventions are used in this wiki:

Instructions titles appear in Bold and Orange. For example, "To view a BTCamera’s video feed
in the visible spectrum"
Menus and menu commands appear in Bold and Navy. For example, “To open the window if
closed, go to the View menu and click Cameras.”
User interface elements such as buttons, tools, shortcuts, and dialog boxes appear in Italics and
Medium Blue. For example, “To close the project, click Yes.”
Keyboard keys are indicated in CAPITALS AND BLUE. For example, “To call up the save menu, enter
in the command CTRL+SHIFT+B.”
References to manuals appear in Italics Underlined in Blue. For example, “For an in depth
understanding on BTWYSIWYG and its capabilities, please refer to the WYSIWYG Reference Guide.”
Instructions to direct you to different features of the BTSystem or areas in the physical Space are
indicated by being Green and Underlined. For Example “In the Physical Space, take the BTBeacon.”
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BTSensor Installation
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Environment Considerations for BTSensor Installation
Installing a BTSensor Lens
BTSensor Placement and Orientation
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Environment Considerations for
BTSensor Installation
The environment of the Space has a great impact on the capacity of BlackTrax to function as intended.
When you install the BTSystem, always remember the following precautions to limit interference and
make the ideal tracking environment.

Infrared interference: External infrared sources and reflections may cause interference with
BTSensors. For best results, ensure the venue is free from sunlight, lights which emit infrared
spectrum, infrared based devices, fire, and highly reflective materials. For infrared sources and
reflections which cannot be removed from the venue, there are provisions within the software to
mask out the affected areas of the BTSensor's field of view.

Note: Infrared interference is more critical during the BTSensor calibration than during
tracking operation. Since the BTSystem looks for a unique signal during tracking, there is
some tolerance for other infrared sources.

Reflective surfaces: Reflective materials that are present in a venue might reflect and mimic a
BTBeacon’s unique LED pulse, creating errors with tracking. Complex objects inside the tracking
area must be covered to block reflections. Reflective objects outside the tracking area can be
blocked out.
Cabling: Ethernet connected BTSensors are subject to the limitation of Ethernet communication
standards. The total Ethernet connection between any component to the BTServer can not be
longer than 91.44m for BlackTrax to function correctly. This range may be extended with a PoE
switch to link cables together.
Sensor stability: Ensure that the location where you choose to install BTSensors is stable, sturdy
and always stationary. Any movement of a BlackTrax sensor will require recalibration of the entire
sensor system.

Example: If a BTSensor is hung on a truss system which sways, the accuracy and
performance of the BTSystem will be affected. If the sway is small, you can decrease
accuracy in the system and may be able to track with lesser accuracy.

Sensor blocking: Ensure that BTSensors have an unimpeded view of the intended tracking area.
Multiple BTSensors need to see the same area at the same time for tracking to occur. Care should
be taken to ensure temporary objects do not obscure tracking.
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Installing a BTSensor Lens
To install a BTSensor lens

Note: Only used on s250e and Slim 13E sensors.

Screw the lens onto the BTSensor with the included plastic lens tensioner between the M12 lens1.
adapter and the lens itself. Tighten until proper focus is achieved.
Once you achieve the desired focus, hold the lens in place while you tighten down the lens2.
tensioner.

 

 

 

Note: The s250e comes with a spring for the lens instead of a tensioner. No tightening is required for
this lens.
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BTSensor Placement and Orientation
In order for tracking to function correctly, multiple BTSensors must be arranged to have overlapping
fields of view of the Space. A BTSensor's field of view is the part of the Space that is visible through the
BTSensor while the BTSensor is in a fixed position and orientation.

Attention: Sensors must not be installed closer than 1m apart to help ensure optimal sensor calibration.
Good sensor placement and orientation are absolutely critical to proper operation of the BTSystem! 
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BTSystem Hardware Configuration
Table of contents:

BTSystem Configuration
Optional Equipment Configuration
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BTSystem Configuration
System Configuration Overview
Hardware modules that connect directly to the BTServer should be located in the same location outside
of the tracking area. BTSensors must be positioned where they will not be disturbed and have the best
unblocked view of the tracking area. TimeKeeper, BTRouter and eSync 2 Controller can be positioned
closer to the tracking space.

The following diagram outlines a typical hardware configuration and demonstrates how all BlackTrax
hardware modules are connected together.

Attention: The Timekeeper and BTRouter Ethernet port are designed only to connect to a commercially
available Power over Ethernet (PoE) network switch. The TimeKeeper and BTRouter are not designed to
be a peripheral device to a Class B personal computer. As such, the Ethernet port shall not be connected
to a Class B personal computer in any operating configuration.

BlackTrax System Configuration Diagram
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Optional Equipment Configuration
Optional Equipment Overview
Depending on your tracking needs, additional components must be connected with the BTSystem. The
following outlines how to connect this optional equipment with the BTSystem.

 

Tracking with Moving Light Fixtures Diagram
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BTSystem Components
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Standard System Components
List of Standard System Components
Note: The quantity of BTSensors, BTBeacons, BTSmart Chargers, and Stringers delivered with a
BTSystem are dependent on each user’s needs and on the individual sale.

(1) BTServer (pre-installed software below)
Hardware secured inside the server

BTX Dongle
Motive Dongle

Pre-installed software
BTWYSIWYG
Motive for BlackTrax
BlackTrax Software Suite
Device Manager

(1) BTRouter
(1) TimeKeeper
Ferrite filters
(1) eSync 2 Controller*

BNC/RCA Adapter
BTSensors
BTBeacons
Mini Beacons
Stringers
BTSmart Charger
Sync Dock
(1) BTCalibration Kit

(1) BTCalibration Wand Head
(1) BTCalibration Triangular Wand Holder
(1) BTCalibration Telescopic Wand Handle
(1) BTCalibration Ground Plane
(1) BTCalibration Hybrid Power Supply Unit
(1) BTLighting Calibration Wand
(1) Carrying case

Attention: *The original eSync Controller is discontinued.

Not Included Mandatory Components
Category 6 Ethernet cable
Power over Ethernet (PoE) gigabit Switch

Optional Components
DMX/Ethernet Node (for tracking with moving lights)
Additional Power over Ethernet (PoE) gigabit Switches
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BTServer 2.0
BTServer 2.0 (Rev 7)

 

Product ID
Model: BTServer 2.0 (Rev 7)

Physical Characteristics
Width: 48 cm (19")
Height: 9 cm (3.5")
Depth: 48.5 cm (19")
Weight: 15.2 kg (33.5 lb.)

Operating Temperature
0°C - 40°C

Technical Specifications
BTServer 2.0 (Rev 7):

(2x) Intel Xeon Silver 4210 @ 2.2GHz (3.20 GHz Turbo, 2400 MHz, 13.75MB Cache, 10 Core, 85W)
(2x) 2.5" 480GB SSD SATA in RAID1 on LSI MegaRAID SAS 9341-4i
32GB (8x4GB) RAM (DDR4, ECC, 2666 MHz) or 32GB (4x8GB, ECC, 2933MHz DDR4)
PNY Nvidia Quadro RTX 4000 8GB GPU
100-240VAC, 800W redundant power supply with IEC
(2x) Intel I350 Quad-Port Gigabit Ethernet Controller (1 dedicated, 1 definable)
Windows 10 IoT Enterprise 2019 LTSC

Default User Login
User name: btuser

Note: There is no password associated with the default user account for the BTServer

Default Network Address (Main)
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Default Network Address (Backup)
 

Note: 

The BTServer is built with 2 Network Interface Cards (NIC) with 4 ports on each card, and the
functions are: (see BlackTrax detailed system diagram)

Port 1:  BTNet (PoE Switch - Tracking, BTSensors, BT Smart Chargers)
Port 2:  RTTrPL and Lighting Input (Network Switch - Lighting)
Port 3:  RTTrPM (Network Switch - 3rd Party)
Port 4:  BTLink (links to BTServers)
Port 5-8:  (User Defined)

Lighting Input and RTTrPL are combined into the RTTrPL port.
BTLink is the network connection link to the other BTServers.

Attention: Windows Remote Desktop Connection should not be used with a BlackTrax system. Security
measures on the BTX dongle installed in the BTServer will prevent it from working. Users should use
TeamViewer or VNC if remote access to a BTServer is required.
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Controller Kit
Table of contents:

TimeKeeper
BTRouter
eSync 2 Controller
Ferrite Filter
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TimeKeeper
TimeKeeper (Rev J) Diagram

 

 

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number: BTTKV01

 

Physical Characteristics
Width: 6.46 cm (2.545")
Height: 7.50 cm (2.951")
Depth: 2.50 cm (0.968")
Weight: 86.64 g (3.056 oz)

 

Operating Temperature
0°C to +40°C (32°F to 104°F)

 

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

 

Status LEDs

 

Note: The Ethernet status lights on the TimeKeeper are not enabled while the TimeKeeper is in use.
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TimeKeeper Functions
The TimeKeeper is a single wireless access point that uses a proprietary radio system running on the 2.4
Ghz frequencey to send data to all BTBeacons. Data sent includes a signal used to synchronize the
BTBeacons with the BTSensors and configuration commands sent to the eSync Controller via a BNC
cable.

When USB based cameras are used in BlackTrax, TimeKeeper is connected to the Sync port of an
OptiHub via RCA connection. USB camera systems require different synchronization settings for Motive.
TimeKeeper must be configured in the Device Manager for the specific use of USB camera systems.

 

TimeKeeper Transmitter Characteristics
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BTRouter
BTRouter Diagram

  

 

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number BTTKV01

 

Physical Characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)

 

Operating Temperature
0°C to +40°C (32°F to 104°F)

 

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoE Network Switch via Ethernet port (No input power via USB port)

 

Status LEDs
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BTRouter Functions
The BTRouter is a single wireless access point that uses a proprietary radio system running on 2.4 Ghz
frequency to receive data from all BTBeacons. Data received includes BTBeacon button presses, battery
status, configuration details as well as inertial measurement unit (IMU) data. IMU data can be used to
calculate the BTBeacon’s orientation.

Note: Upon delivery of a new BTSystem shipment, the IMU on most of the Beacons included are disabled
by default, and the IMU of the Beacon with ID 1 will be switched on by default to help with Fixture
Calibration.

 

BTRouter Transmitter Characteristics
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eSync 2 Controller
eSync 2 Controller Diagram

 

Physical Characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

 

Input/Output & Power
PoE: IEEE 802.3af-2003
Adapter: 12V @ 0.6A power supply
Data: Ethernet

 

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

 

eSync 2 Controller Functions
The eSync 2 Controller synchronizes BTSensors so that the shutters of BTSensors open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

 

eSync 2 Controller Connection to the TimeKeeper
The eSync 2 Controller connects to the TimeKeeper over RCA cable. A BNC/RCA adapter is used to plug
the RCA into input 3 of the eSync 2 Controller.
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Ferrite Filter
Ferrite Filter Diagram

 

 

Product ID
Manufacturer: API
Model number: BF1835

 

Physical Characteristics
Width: 1.8 cm (0.709”)
Height:  1.96 cm (0.776”)
Depth: 3.48 cm (1.378”)
Center diameter: 0.89 cm (0.354”)
Weight: 15 g (.53 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)
Impedance: 172 Ohm

 

Ferrite Function
The ferrite filter is a cylindrical clamp fastened over cables to conform with regulatory standards. A
ferrite filter must be clamped over any cables connected to the TimeKeeper and BTRouter. Ferrite filters
should be fastened on any connected cables as close to the respective device as possible.
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BTSensors
Table of contents:

SLIMX 13 and SLIM 13E
PRIME 41
FLEX 13
FLEX 3
Included Mounting Hardware
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SLIMX 13 and SLIM 13E

SLIMX 13 and SLIM 13E Diagram  

 

Product ID
SLIMX 13 Model number: CAM-PAK-SMX
SLIM 13E Model number: CAM-CAM-S13

 

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)

Note: Warm-up time of 30 minutes is recommended for optimal tracking performance. Watch
out for condensation when used in temperatures below 0°C.

Case: Aluminum and Polycarbonate
Width: 6.86 cm (2.7”)
Height: 6.86 cm (2.7”)
Depth: 2.3 cm (0.9”)
Weight: 320 g (11.29 oz)

 

Lens & Filter
Stock lens: 3.5 mm F#1.8 (wide band AR coated)

Horizontal FOV: 56°
Vertical FOV: 46°

Optional Lens: 8.0 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°

Optional Lens: 3.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 82°
Vertical FOV: 70°

Adjustable focus with wave spring assist
850nm band-pass filter
850nm (Infrared) / 700nm (Visible) Filter Switcher

Note: BTSensors that have the "NFS" label printed on the side do not have the Filter
Switcher.
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Image Sensor
Resolution: 1280 × 1024
Frame Rate: 30–240 FPS (100 FPS average usage)
Accuracy: +/-0.3 mm
Latency: 4.2 ms
Shutter type: global
Shutter speed:

Default SLIM 13E: 0.5 ms (500 µs)
Default SLIMX 13: 0.25 ms (250 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.9 ms (3,900 µs) at 240 FPS

 

Input/Output & Power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 8.0 watts 

 

Sensor Status
Front LCD Status
In normal operation mode, the front LCD panel of the SLIM Series will display the sensor's ID number to
easily identify the unit.

When updating the software on your BTServer, the sensor may need a firmware update in order to
communicate to the new version. Firmware updates are automatic when starting the connection to the
BTServer. Reverting back to an older version of the firmware is also an automatic process.

The front LCD panel will display the flashing progress during the firmware update. The front LCD panel
will go from 0 to 99 to indicate the flashing progress.

Front Light Status
The Slim Series sensors have a front LED status light to indicate their current state in relation to the
BTServer. The following table lists the default status light colors.

 

Back Light Status
The Slim Series sensors also have a status indicator on the back panel and indicates the state of the
sensor only. When updating the software on your BTServer, the sensor may need a firmware update in
order to communicate to the new version. Firmware updates are automatic when starting the connection
to the BTServer. If you revert back to an older version of the firmware as well. This process is automatic.
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BTSensor Functions
BTSensors are used to view BTBeacon positions in the Space. A BTBeacon's position in 3 dimensions (X,
Y, and Z) can be determined when two or more BTSensors simultaneously have a direct line-of-sight to a
connected Stringer’s LED. This information is then sent to the BTServer.

 

Attention:
The switch must provide consistent power to every port simultaneously in order to power each
sensor.
Standard PoE switches must provide a full 15.4 watts to every port simultaneously.
Note that PoE Midspan devices or power injectors are not suitable for Ethernet camera systems.
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PRIME 41
PRIME 41 Diagram

 

Product ID
Model number: CAM-CAM-P41

 

Physical Characteristics
Mounting: 0.635 cm (1/4")-20 tripod thread (x2)
Operating temperature: 0°C to +51°C (32°F to 123.8°F)

Note: Warm-up time of 30 minutes is recommended for optimal tracking performance. Watch
out for condensation when used in temperatures below 0ºC.

Case: Aluminum and Polycarbonate
Width: 12.6 cm (4.96”)
Height: 12.6 cm (4.96”)
Depth: 13.6 cm (5.34”)
Weight: 1.45 kg (3.2 lb)

 

Lens & Filter
Stock lens: 12 mm F#1.8 (wide band AR coated)

Horizontal FOV: 51°
Vertical FOV: 51°

Adjustable focus and f-stop
850nm band-pass filter

 

Image Sensor
Resolution: 2048 x 2048
Pixel Size: 5.5 µm x 5.5µm
Frame Rate: 30–180Hz during focus mode, 100Hz during tracking mode 
Accuracy: +/- 0.10mm
Latency: 5.5ms
Shutter type: global
Shutter speed:
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Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum:

8.1ms (8100 µs) at 120 FPS
5.3 ms (5300 µs) at 180 FPS

 

Input/Output & Power
Data: GigE (1000BASE-T)
Synchronization: Ethernet
Power: PoE or PoE+¹

 

 

Attention:
The switch must provide consistent power to every port simultaneously in order to power each
sensor.
Standard PoE switches must provide a full 15.4 watts to every port simultaneously.
Note that PoE Midspan devices or power injectors are not suitable for Ethernet camera systems.
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FLEX 13

FLEX 13 Diagram  
 

Product ID
Model number: CAM-CAM-F13

 

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)

Note: Warm-up time of 30 minutes is recommended for optimal tracking performance. Watch
out for condensation when used in temperatures below 0°C.

Case: Aluminum and Polycarbonate
Width: 5.38 cm (2.12”)
Height: 8.10 cm (3.19”)
Depth: 4.24 cm (1.67”)
Weight: 187 g (6.6 oz)

 

Lens & Filter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)

Horizontal FOV: 56°
Vertical FOV: 46°

Optional Lens: 8.0 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°

Optional Lens: 3.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 82°
Vertical FOV: 70°

Adjustable focus with wave spring assist
850nm band-pass filter
850nm (Infrared) / 700nm (Visible) Filter Switcher

 

Image Sensor
Resolution: 1280 × 1024
Frame Rate: 30–240Hz during focus modes, 100Hz during tracking mode
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Latency: 4.2 ms
Shutter type: global
Shutter speed:

Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.9 ms (3,900 µs) at 240 FPS

 

Input/Output & Power
Data: USB 2.0
Synchronization: USB 2.0 (via Optisync)
Power: USB 2.0 @ 1A 

 

BTSensor Functions
BTSensors are used to view BTBeacon positions in the Space. A BTBeacon's position in 3 dimensions (X,
Y, and Z) can be determined when two or more BTSensors simultaneously have a direct line-of-sight to a
connected Stringer’s LED. This information is then sent to the BTServer.

 

Attention:
Note that USB extensions of any kind are not suitable for connections between USB Sensors and the
system's OptiHub.
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FLEX 3

FLEX 3 Diagram   
 

Product ID
Model number: CAM-CAM-F03

 

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)

Note: Warm-up time of 30 minutes is recommended for optimal tracking performance. Watch
out for condensation when used in temperatures below 0°C.

Case: Aluminum and Polycarbonate
Width: 4.52 cm (1.78”)
Height: 7.47 cm (2.94”)
Depth: 3.66 cm (1.44”)
Weight: 100 g (4.2 oz)

 

Lens & Filter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)

Horizontal FOV: 56°
Vertical FOV: 46°

Optional Lens: 8.0 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°

Optional Lens: 3.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 82°
Vertical FOV: 70°

Adjustable focus with wave spring assist
850nm band-pass filter
850nm (Infrared) / 700nm (Visible) Filter Switcher

 

Image Sensor
Resolution: 1280 × 1024
Frame Rate: 30–240Hz during focus modes, 100Hz during tracking mode
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Latency: 4.2 ms
Shutter type: global
Shutter speed:

Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.9 ms (3,900 µs) at 240 FPS

 

Input/Output & Power
Data: USB 2.0
Synchronization: USB 2.0 (via Optisync)
Power: USB 2.0  

Standard: 5V @ 490mA
High Power: 680mA

 

BTSensor Functions
BTSensors are used to view BTBeacon positions in the Space. A BTBeacon's position in 3 dimensions (X,
Y, and Z) can be determined when two or more BTSensors simultaneously have a direct line-of-sight to a
connected Stringer’s LED. This information is then sent to the BTServer.

 

Attention:
Note that USB extensions of any kind are not suitable for connections between USB Sensors and the
system's OptiHub.
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Included Mounting Hardware
The list and specifications of mounting hardware included with the BTSensors. 

Super Clamp
Attachment: 16 mm hexagonal + M5 and 1/4" thread attachment type.
Clamp range - maximum (round tube): 55 mm
Color: Black
Safety payload: 15 kg
Weight: 0.5 kg

 Super Clamp with Heavy Ball Head Adapter

Heavy Ball Head Adapter
Thread: 3/8"
Removable insert: 3/8" - 1/4" thread

Hex Spigot
Thread: Male 1/4" - Male 3/8"

 Hex Spigot

Safety Chain
Each BTSensor comes with a safety chain and a bolt for attachment.
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BTBeacon
BTBeacon Diagram

 

 

Product ID
FCC ID: RKT- BTBCV01
IC: 10858A- BTBCV01
Model: BTBCV01P

 

Physical Characteristics
Case: Plastic with Velcro strap attachments
Width: 4.94 cm (1.945”)
Height: 8.08 cm (3.18”)
Depth: 1.87 cm (.737”)
Weight: 70 g (2.5 oz)

 

Input/Output & Power
Data: USB, Radio 2.4 (GHz) 10Hz
Power: Rechargeable Lithium-ion Battery, charged by 5V USB and 1,350 mAh capacity
Watt hour: 4.44 Wh normal operation, 5.04 Wh while charging

 

Operating Temperature
0°C to +40°C (32°F to 104°F)

 

BTBeacon Status LEDs (During Operation)
 

Warning: If a BTBeacon experiences a charge error, there could be a potential issue with the Lithium-ion
battery. Discontinue use immediately. For more information about Lithium-ion battery safety see “Health
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and Safety Information”.  Alternately, no battery may be in the BTBeacon. 

 

BTBeacon Status LEDs (During Boot
Loader Mode)

 

  

BTBeacon Functions
Each BTBeacon has three ports, each of which can power a single connected Stringer. When a Stringer is
connected to a BTBeacon’s LED port, the Stringer’s LED will emit infrared light in a unique pattern. These
infrared pulses create a unique ID used to identify BTBeacons. When the LED infrared pulse is seen by 2
or more BTSensors, the positional coordinates (XYZ) for the Stringer LED is calculated by the BTServer.
Position is based on the location of visible Stringer LEDs connected to a BTBeacon. Orientation data (roll,
pitch, yaw) is determined by an internal inertial measurement unit (IMU). The IMU also functions as a
backup for determining the BTBeacon's position. The IMU measures acceleration and rotation. 

Note: IMU is disabled by default. It is still possible to generate orientation data through the use of Rigid
Frames. For more information please refer to the Frame Calibration View section of this wiki.

The BTBeacons have a red power and reset button, and two white auxiliary buttons. The auxiliary buttons
are used during fixture calibration.

The BTBeacon transmits the following data over radio to the BTRouter, which is relayed to the BTServer:
IMU data, button presses, battery status, configuration details, and Stringer IDs.

To enter the BTBeacon into Boot Loader Mode, turn the beacon off and hold A or B while inserting the
BTBeacon into the BTSmart Charger. This mode is used to update firmware.

 

BTBeacon Transmitter Characteristics

 

BTBeacon Battery Life
1 LED: 10 hours
2 LEDs: 8 hours
3 LEDs: 5.5 hours
1 Stringer: 10 hours
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2 Stringers: 8 hours 
3 Stringers: 5.5 hours

 

BTBeacon Charging Information
A BTBeacon’s rechargeable lithium-ion battery is not fully charged when shipped. Please read the
following instructions carefully:

Never charge BTBeacon near heat or flammable objects.
The temperature range which the BTBeacon can be charged is 0°C to 40°C (32°F to 104°F).
Charging outside the recommended temperature range may automatically be blocked by the
protection circuitry of the device.
Do not charge or use the BTBeacon if any damage has occurred to the device.
The temperature range over which the BTBeacon’s battery can operate is 0°C to 40°C (32°F to
104°F). Operation outside of this temperature range may damage the performance of the battery
or may reduce its life expectancy.
Battery performance will naturally decay over time. If a battery can not maintain charge for long
periods, even when it is being charged correctly, this may indicate it is time to replace the battery.

 

BTBeacon Battery Replacement
After a period of time the battery of the BTBeacon will naturally decay through normal use and require
replacement. Contact your BTE for details on replacing the BTBeacon battery.

Attention: Any unauthorized modification to the BTBeacon or its battery will invalidate any warranty
claim and may damage the device.
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Mini Beacon
Mini Beacon Diagram

  

 

Physical Characteristics
Case: Plastic on a wearable band
Diameter: 3.487 cm (1.37")
Height: 1.549 cm (0.61")
Weight: 15 g (0.53 oz)

 

Operating Temperature
0°C to +40°C (32°F to 104°F)

  

Mini Beacon Functions
A Mini Beacon emits infrared light in a unique pattern. These infrared pulses create a unique ID used to
identify Mini Beacons. When the LED infrared pulse is seen by 2 or more BTSensors, the positional
coordinates (XYZ) for the Stringer LED is calculated by the BTServer.  

The Mini Beacon's internal rechargeable battery can be recharged with the use of the Sync Dock. The
Sync Dock sets the Mini Beacons to automatically sync with the TimeKeeper of the BlackTrax system,
while charging.

Attention:  The Mini Beacon must connect to the new TimeKeeper model. Contact BlackTrax Technical
Support (CAST) for the firmware required to run the Mini Beacons with TimeKeeper, Router and Beacons.

Note:

When a Mini Beacon is docked in the Sync Dock, it will take around 1 minute for the Mini Beacon to
fully sync with the TimeKeeper.
The Mini Beacon does not transmit a radio signal.
The default brightness of a Mini Beacon is 2.5ms.
The battery life of a Mini Beacon at default brightness is 8 hours.
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Mini Beacon Charging Information
A Mini Beacon’s rechargeable lithium-ion battery is not fully charged when shipped. Please read the
following instructions carefully:

A Mini Beacon will take about 2 hours to fully charge.
Never charge Mini Beacons in the Sync Dock near heat or flammable objects.
The temperature range which the MIni Beacon can be charged is 0°C to 40°C (32°F to 104°F).
Charging outside the recommended temperature range may automatically be blocked by the
protection circuitry of the device.
Do not charge or use the Mini Beacon if any damage has occurred to the device.
The temperature range over which the Mini Beacon’s battery can operate is 0°C to 40°C (32°F to
104°F). Operation outside of this temperature range may damage the performance of the battery
or may reduce its life expectancy.
Battery performance will naturally decay over time. If a battery can not maintain charge for long
periods, even when it is being charged correctly, this may indicate it is time to replace the battery.
Contact your BTE for details on replacement.

Attention: Any unauthorized modification to the Mini Beacon or its battery will invalidate any warranty
claim and may damage the device.
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BTSmart Charger
BTSmart Charger Diagram

 

 

Size and Weight
Case: Steel 
Width: 36 cm (14.2”)
Height: 9.6 cm (3.8”)
Depth: 17.2 cm (6.8”) 
Weight: 2200 g (77.6 oz)

 

Input/Output & Power
Data: Ethernet, USB
Power: 20 Watt
Voltage range: 100V - 240V

Note: BTSmart Charger Rev 6 is built with a momentary contact type power button with the blue LED
that will light up only after the "boot up" is complete. To turn the device power off, press the power
button, then wait until the blue LED light turns off before you disconnect from the power source. 

 

BTSmart Charger Functions
The BTSmart Charger is a device used to recharge the battery of a BTBeacon. BTBeacons are connected
to the BTSmart Charger using the BTBeacon’s USB port. While connected, the BTSystem can read the
status of the battery, regulate charging and maximize battery life. The BTSmart Charger can hold a
maximum of 6 BTBeacons at one time.

 

BTSmart Charger Configurations
The BTSmart Charger can be configured to either be horizontal and sit flat on a desk, or be vertical and
be mounted on a wall. 
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Horizontal Configuration Diagram
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Sync Dock
Sync Dock Diagram

 

 

Size and Weight
Case: Steel 
Width: 23.88 cm (9.40”)
Height: 32 cm (12.60”)
Depth: 5.28 cm (2.08”) 
Weight: 461 g (16.27 oz)

 

Input/Output & Power
Data: BNC (Sync In/Out), Ethernet (Device Manager)
Power: 30 Watt
Voltage range: 100V - 240V

 

Input/Output Panel Diagram

 

Sync Dock Functions
The Sync Dock is a device used to recharge the battery of Mini Beacons. A maximum of 20 Mini Beacons
can be docked onto 20 docking cases in the Sync Dock. While docked, the Mini Beacons automatically
sync with the TimeKeeper of the BTSystem.

Sync Dock Panel Connections and Indicators
Power: Plug power input into the Power Jack Connector from the AC power adapter.
Sync Input (BNC): Connect and receive sync calibration data from the TimeKeeper of the
BlackTrax System through the BNC connector.
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Note: From the TimeKeeper, use a BNC splitter to split the BNC connection. One end of the
BNC split connects to the eSync (normal connection) and the other end of the BNC split
connects to the Sync Dock.

Sync Output (BNC): Connect and send sync calibration data to another Sync Dock through the
BNC connector.

Note: You can daisy chain multiple Sync Docks through the Sync Input and Sync Output
connections to sync several Sync Docks and Mini Beacons at once. You can daisy chain a
maximum of 16 Sync Docks with 320 Mini Beacons at once.

Ethernet: Connect to the Device Manager through the ethernet connection.
Blue LED: When the Sync Dock is plugged into a power source, the blue LED at the front panel
lights up.
Green LED: When the Sync Dock is receiving sync transmission from the BTSystem, the green LED
at the front panel lights up.

Mini Beacon Docking
Mini Beacon Sync: When a Mini Beacon is placed on the Sync Dock, it will take about 1 minute for
the Mini Beacon to fully sync with the TimeKeeper. When the Mini Beacon is placed on the Sync
Dock, its LED is turned off until it is removed. 
Blue LED (on each single dock casing): Indicates the sync status of the docked Mini Beacon. This
LED flashes while the Mini Beacon is syncing and turns solid when sync is complete.

Note: If a Mini Beacon is removed from the Sync Dock before calibration is complete, the
Mini Beacon will not turn its LED on.

Green LED (on each single dock casing): Indicates power of the docked Mini Beacon. This LED
flashes while the Mini Beacon is charging, and turns solid when charging is complete. 
Mini Beacon Charging: A Mini Beacon will take about 2 hours to complete charge.
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Calibration Kit
Table of contents:

Calibration Kit functions
Wand Head
Triangular Wand Holder
Telescopic Wand Handle
Ground Plane
Hybrid Power Supply Unit (HPSU)
Lighting Wand
BTCalibration Kit Case
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Calibration Kit functions
BlackTrax Calibration Kit Functions
The Calibration Kit is used for calibrating the BTSensors and Lighting Fixtures position in the Space. The
function of each equipment in the Kit are:

The Wand Head is attached to the Wand Handle and connected to the Power Supply Unit.1.
When you move the Wand Head inside the Space, the BTSensors look for active LEDs located on2.
the Wand Head.
When multiple BTSensors see the LEDs on the Wand Head, the BTSystem is able to generate a3.
measurement point for BTSensor calibration.
BTSensors use the measurement point data to determine their position relative to each other.4.
The Ground Plane is connected to the Power Supply Unit and placed in the designated origin of the5.
Space.
The Ground Plane LEDs are used in the BlackTrax system to calculate the BTSensor positions6.
relative to the origin and the orientation of the Cartesian axes.
The Lighting Calibration Wand is used for fixture calibration.7.
The Lighting Calibration Wand can be attached to a BTBeacon instead of a Stringer to extend the8.
range of a BTBeacon LEDs. This is used to calibrate fixtures in areas that are difficult to reach.
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Wand Head
Wand Head

Size and Weight
Width: 105.92 cm (41.7”)
Height: 26.92 cm (10.6”)
Depth: 2.03 cm (0.8”)
Weight: 715 g (25.22 oz)
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Triangular Wand Holder
Triangular Wand Holder 

 

Size and Weight
Length: 24 cm (9.45”)
Height: 17.5 cm (6.89”)
Width: 4.45 cm (1.75”)
Weight: 420g (14.82 oz)
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Telescopic Wand Handle
Telescopic Wand Handle 

Size and Weight
Length: 2.03 cm (0.8”)
Height: 149.86 cm (59”)
Width: 2.03 cm (0.8”)
Weight: 365 g (12.86 oz)
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Ground Plane
Ground Plane

Size and Weight
Width: 76.96 cm (30.3”)
Length: 98.04 cm (38.6”)
Depth: 5.08 cm (2”)
Weight: 1905 g (67.2 oz)
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Hybrid Power Supply Unit (HPSU)
Hybrid Power Supply Unit (HPSU)

 

Size and Weight 
Width: 1.35 cm (0.5")
Height: 0.45 cm (0.2")
Depth: 1.1 cm (0.4")

Power Run Time
High: 1:00
Med: 2:45 
Low: 3:15 

Notes
Most applications (comparable to the previous PSU) use Medium, depending on the size of the1.
venue and how far the sensors are. You may try out low or high to conserve power or boost the IR.
A USB port is available where you can use to charge an external Beacon.  2.

An External Beacon can be charged approximately 90% if the HPSU is fully charged, and the
Beacon Battery is completely out of charge. This assumes no Stringers are attached to the
Beacon.
The HPSU can also be used to extend the life of a Beacon Battery if it is required to run past
its normal usage time. A Beacon with 1 Stringer has approximately 7.5 hours of additional
usage time. Beacons with either 2 or 3 Stringers attached have approximately 1 hour of
additional usage time.

Changing Internal Batteries in the HPSU
Attention: Please use an anti-static mat while being grounded.

Tool Required: *1/16 hex bit key.

To add batteries to the second pack
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 Side A       Side B

Remove the 4 screws from Side A using the 1/16 hex bit.1.
Once the screws are removed, pull the panel away to reveal the interior of the HPSU.2.
Remove the board half way to expose the attachment for the power switch.3.
Carefully remove the power switch pin. Pull the pin straight upwards.  4.

     

Attention: AVOID MOVING THE PIN IN THE DIRECTION SHOWN IN THE PICTURE WITH
ARROWS (below).

   

Once the pin is removed, push the board back into the HPSU.5.
Turn the HPSU to Side B and remove the screws.6.
Remove the HPSU all the way to expose the second battery pack.7.
Add the batteries.8.
Tighten the straps.    9.
Reattach the power switch on Side A. Carefully pushing down the pin until it is locked in place.10.

 

Push the board back into the case, making sure not to pinch any wires on Side B.11.
Close Side A.12.

To change the pre installed HPSU batteries

Remove the 4 screws from Side A using the 1/16 hex bit.1.
Once the screws are removed, pull the panel away to reveal the interior of the HPSU. 2.

 

Note: HPSU board slides into the bottom slot of the interior.        
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Carefully pull the board out from the HPSU. You only need to remove the board half way to replace3.
the batteries.  

 

Once you have replaced the batteries, tighten the Velco straps on the batteries.4.
Slowly and carefully push the board back into the HPSU.5.
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Lighting Wand
Lighting Wand 

Size and Weight
Size: 2 m (6.56’)
Weight: 235 g (8.29 oz)
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BTCalibration Kit Case
BTCalibration Kit Case

Outside dimensions: 134.6 x 40.6 x 15.5 cm (53” x 16” x 6.12”)
Weight: (with foam lining only): 11.6 kg (25.57 lbs.)
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Stringer 2
Stringer 2 Diagram

 

 

Physical Characteristics
Cable length: 1.37 m (4.5') Custom sizes are available
Cable thickness:  2.8 mm (0.11")
LED Diffuser diameter: 8 mm (5/16")
Strain relief: 28 mm (1.1")
Male SMA Connector: 9 mm x 8 mm (0.35" x 0.32")

Male SMA Connector diagram

 

 

Stringer 2 Functions
When the Stringer 2 is connected to a BTBeacon LED port, the LED portion of Stringer 2 will pulse that
BTBeacon’s unique ID signal. The pulse is viewed by BTSensors, sent to the BTServer and used to
calculate the BTBeacon position in the Space.
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Discontinued
 Table of contents:

eSync Controller
S250e Slim
Power Supply Unit (PSU)
BTServer (Legacy)
TimeKeeper (Legacy)
Stringer
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eSync Controller
eSync Controller Diagram

 

Physical Characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

 

Input/Output & Power
PoE: IEEE 802.3af-2003
Adapter: 12V DC and 3 Amps
Data: Ethernet

 

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

 

eSync Controller Functions
The eSync Controller synchronizes BTSensors so that the shutters of BTSensors open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

eSync Controller Connection to the TimeKeeper
The eSync Controller connects to the TimeKeeper over RCA cable. The RCA cable is plugged into the RCA
port of the eSync Controller.
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S250e Slim
S250e SLIM diagram

 

 

Product ID
Model Number: BT-S250-15

 

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 8.1 cm (3.19”)
Height: 8. cm (3.16”)
Depth: 6.76 cm (2.66”)
Weight: 430.91 g (15.2 oz)

 

Lens & Filter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)

Horizontal FOV: 56°
Vertical FOV: 46°

Optional lens: 8 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°

M12 Lens Mount
Adjustable focus with wave spring assist
800nm IR long pass filter with Filter Switcher

 

Image Sensor
Resolution: 832 × 832
Frame Rate: 30–250 FPS (100 FPS average usage)
Accuracy: Sub-millimeter
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Latency: 4 ms
Shutter Type: global
Shutter Speed:

Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.8 ms (3,800 µs) at 100 FPS

 

Input/Output & Power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 15.4 watts 
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Power Supply Unit (PSU)
Power Supply Unit (PSU) 

Size and Weight
Width: 10.5 cm (4.1”)
Height: 9.8 cm (3.8”)
Depth: 4.57 cm (1.8”)
Weight: 335 g (11.82 oz)

 

Power
Power: 10 Watt 
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BTServer (Legacy)
BTServer (Rev 1-4) Diagram

 

 

Physical Characteristics

 

Technical Specifications
BTServer Rev 4:

(2x) Intel Xeon Processor E5-2620 v4 (8C, 2.1GHz, 3.0GHz Turbo, 2133MHz, 20MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1
16GB (4x4GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Intel I350 Quad-Port Gigabit
Ethernet Controller
Windows Embedded 8.1 Industry Pro

BTServer Rev 3:
(2x) Intel Xeon Processor E5-2620 v3 (6C, 2.4GHz, 3.2GHz Turbo, 1866MHz, 15MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1 -or- (2x) 2.5" 500GB HDD SATA in RAID 1
64GB (8x8GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060 -or- NVidia GeForce GTX 960 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Broadcom BCM5719 Quad-Port
Gigabit Ethernet Controller
DVD-ROM Optical Disk Drive
Newer Systems: Windows 8.1 Pro; Legacy Systems: Windows 7 Professional

BTServer Rev 2:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 2.5" 500GB HDD SATA in RAID 1
16GB (4x4GB) 1866MHz DDR3 ECC RDIMM
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Intel X520-T2 Dual Port 10GbE Network Interface Card
DVD-ROM Optical Disk Drive
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Windows 7 Professional

BTServer Rev 1:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 3.5" 500GB HDD SATA in RAID 1
4GB RDIMM, 1600MT/s, Low Volt, Single Rank, x8 Data Width
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Broadcom 5720 Quad Port 1Gb Network Interface Card
DVD-ROM Optical Disk Drive
Windows 7 Professional
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TimeKeeper (Legacy)
TimeKeeper (Rev G) Diagram

 

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number: BTTKV01

 

Physical Characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)

 

Operating Temperature
0°C to +40°C (32°F to 104°F)

 

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

 

Status LEDs

 

Note: The Ethernet status lights on the TimeKeeper are not enabled while the TimeKeeper is in use.
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TimeKeeper Functions
The TimeKeeper is a single wireless access point that uses a proprietary radio system running on the 2.4
Ghz frequencey to send data to all BTBeacons. Data sent includes a signal used to synchronize the
BTBeacons with the BTSensors and configuration commands sent to the eSync Controller via an RCA
cable.

 

TimeKeeper Transmitter Characteristics
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Stringer
Stringer Diagram

 

 

Physical Characteristics
Cable length: 1.37 m (4.5') Custom sizes are available
Cable thickness:  2.9 mm (0.11")
LED Diffuser diameter: 7.93 mm (5/16")
Strain relief: 30 mm (1.18")
Male SMA Connector: 9 mm x 8 mm (0.35" x 0.32")

Male SMA Connector diagram

 

 

Stringer Functions
When a Stringer is connected to a BTBeacon LED port, the LED portion of a Stringer will pulse that
BTBeacon’s unique ID signal. The pulse is viewed by BTSensors, sent to the BTServer and used to
calculate the BTBeacon position in the Space.
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General System Information
Table of contents:

BTSystem Information Flow and Connections
BTX Dongle
Saved System Data
FCC Information
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BTSystem Information Flow and
Connections
Introduction
The following diagram outlines how the components of the BTSystem are connected and how data flows
between the different modules of the system.

 

BlackTrax Detailed System Diagram
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BTX Dongle
Embedded inside each BTServer is a BTX dongle which serves two principal uses. The primary function of
a dongle is to act as a key. The dongle is the only way that BlackTrax software will open and operate. The
dongle has dynamic embedded information that controls the level of the software you can open/use, as
well as the expiry date of the Membership Period. A BTX Dongle grants the server access to the
BlackTrax software package as well as a custom version of WYSIWYG for BlackTrax. The expiry date for
the BTX dongle is set for April, 2021.

Secondly, a dongle is a security device used by CAST to prevent unauthorized use of the software and
protects an End User's work as well as their investment in the Product.

Attention: Windows Remote Desktop Connection should not be used with a BlackTrax system. Security
measures on the BTX dongle will prevent it from working. Users should use TeamViewer or VNC if remote
access to a BTServer is required.
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Saved System Data
In BlackTrax, when system information is saved, the information is saved to a general folder on the
BTServer. Information saved this way includes configuration files and system lists from sub-processes.

By default this folder can be found at the following location, depending on your server version and
BlackTrax release version:

All BlackTrax Servers running v2.0.0 or later - C:\bt_run_time
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FCC Information
Important FCC Information
These devices comply with Part 15 of the FCC Rules. Operation is subject to the following conditions:

This device must not cause harmful, interference, and1.
This device must accept any interference received, including interference that may cause2.
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications.

Certificate Numbers
Model BTTKV01:     Radio Cert. No.: IC: 10858A-BTTKV01
Model BTBCV01P:   Radio Cert. No.: IC: 10858A-BTBCV01 
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Not Included Mandatory Components
Attention: BlackTrax requires additional components to function which are not included with purchase
of the BTSystem.

Category 6 Ethernet Cabling
Power Over Ethernet Gigabit Switch for BTSensors
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Category 6 Ethernet Cabling
All Ethernet cabling used to connect the system components together must be of Category 6 (Cat6)
quality or greater. Cat6 is necessary for the transmission of data at gigabit speeds, which is required by
BlackTrax. The amount of cable needed will vary depending on the Space dimensions and user needs.

Attention: The maximum allowed length of a Cat6 cable is 91.44 meters. Cat6 standards should be
followed when connecting modules together to ensure the BTSystem operates as intended. This range
can be extended by using Gigabit switches to connect Cat6 cable of 91.44 meter length or less.
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Power Over Ethernet Gigabit Switch for
BTSensors
BlackTrax requires a dedicated Power over Ethernet (PoE) gigabit switch or dedicated virtual local area
network (VLAN) to connect all the BTSensors with the rest of the system. The switch should have the
following:

A PoE gigabit switch.
A PoE port for each BTSensor, plus 4 extra to connect to the TimeKeeper, BTRouter, eSync
Controller and BTServer.
PoE switches must support 15.4 watts per Ethernet port.
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Optional Components
Depending on the purpose of tracking, you may need additional hardware components that are not
included with the BTSystem.

DMX/Ethernet Node for Tracking with Moving Lights
Compatible DMX/Ethernet nodes
Luminex Ethernet - DMX Node Settings
Luminex Luminode Settings
ArtGate Node Settings
ELC Node Settings
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DMX/Ethernet Node for Tracking with
Moving Lights
Table of contents:

Compatible DMX/Ethernet nodes
Luminex Ethernet - DMX Node Settings
Luminex Luminode Settings
ArtGate Node Settings
ELC Node Settings

 

Merging Channel:
The merging channel is a single DMX channel that is patched into your lighting console to
enable the control of moving fixtures from BlackTrax.
The merging channel can be a dimmer channel that controls intensity fading between BlackTrax
and the lighting console, or as a simple non-dim On/Off control.
The merging channel must be patched in your console and set as the trigger channel in your merge
node.
When the merging channel is at full (100%) intensity, BlackTrax has complete control over the
channels connected to the BlackTrax project. When the merging channel is at zero (0) intensity, the
lighting console has full control over the channels in the BlackTrax project.
In the Project Properties widget in BlackTrax, you can activate and set the monitoring of the Merge
Channel that was set in your merge node.
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Compatible DMX/Ethernet nodes
To connect BlackTrax downstream to a lighting console, a DMX to Ethernet/Ethernet to DMX node is
required. The following nodes have been tested and are approved to work with BlackTrax:

Luminex 
Luminex Luminode 1
Luminex Luminode 2
Luminex Luminode 4
Luminex Luminode 12
Luminex Ethernet-DMX2/Truss MkII
Luminex Ethernet-DMX4 MkII
Luminex Ethernet-DMX4/ Truss MkII
Luminex Ethernet-DMX8 MkII
Luminex Ethernet-DMX8/ Truss MkII

Note: Luminex Ethernet-DMX models have been discontinued and replaced with the Luminode range.

Sundrax 
Sundrax ArtGate Pro 
Sundrax ArtGate DIN
Sundrax ArtGate Board
Sundrax ArtGate Compact
Sundrax ArtGate Solid
Sundrax ArtGate Arma
Sundrax ArtJet Pro

ELC 
ELC DLN8GBX
ELC DLN8GBXSL

Note: Both models must be running a minimum firmware version of 1.28.
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Luminex Ethernet - DMX Node Settings
The Luminex Ethernet DMX nodes must be configured to work with your BlackTrax system.

Attention: The following guide outlines how each variable should be set for use with BlackTrax. Each
BlackTrax event is unique. There are circumstances where these settings need to be modified based on
factors such as the rig, cabling, and patching. 

Setup the node through the web interface. Please ensure your IP settings match that of the node(s) you
wish to configure. There are 2 ways to configure your node to work with BlackTrax: 

To merge RTTrPL with an Art-Net or sACN universe via the 5-pin DMX ports.1.
To have the merged data be rerouted to another universe over the network (for example, when2.
other nodes are being used downstream of your Luminex nodes).

To configure a node to merge and send data via the DMX ports

To navigate to the web interface, enter the IP address of the node in your browser window.1.
Under Setup, click on the desired node you wish to configure.2.

Note: The 8 port nodes will appear as multiple 4 port nodes in the interface.
For the desired ports, choose Output as the Direction, and Custom for IP Merging.3.

 

Result: A blue box appears beside the number for the output after IP Merging is set to
Custom.

Click on this blue box beside the number for the output.4.
Result: The Config Outlet window for that output appears.                                         

 

Set the universes you wish to merge. Source one chooses the DMX protocol, with a universe, and5.
source two chooses the RTTrPL universe.

Notes:
RTTrPL universes start from universe 0 instead of 1.
RTTrPL must be source 2.

Change the Mode to be X-Fade, set the trigger channel to be the same as your merging channel,6.
and then click Set default mode.
Click Submit Changes.7.

Result: That output will be configured as expected. If you select Show table, you should see
the channels have all changed to X-Fade, with a trigger of the specified channel.

Repeat the above for all outputs you wish to configure on the node.8.
Click Submit Changes.9.
Navigate to the Global tab under Setup. Set Enable Trigger to DMX, and the universe to whichever10.
universe your Merging Channel is patched to, with the desired DMX protocol.
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To configure a node to reroute merged data to send to other DMX nodes 

Note: It is recommended that the reroute is done to a universe which is different than the universes from
the console and BlackTrax. For example, if you are merging sACN universe 1, with RTTrPL universe 1, you
might re route the merged data to sACN universe 101.

To navigate to the web interface, enter the IP address of the node in your browser window.1.
Under Setup, click on the desired node you wish to configure.2.

Note: The 8 port nodes will appear as multiple 4 port nodes in the interface.
For the desired ports, choose Output as the Reroute, and Custom for IP Merging.3.

Result: A blue box appears beside the number for the output after IP Merging is set
to Custom.
Result: The port will now have an arrow leading to a box to specify the new universe to
reroute the merged data on.

Click on this blue box beside the number for the output.4.
Result: The Config Outlet window for that output appears.                                         

Set the universes you wish to merge. Source one chooses the DMX protocol, with a universe, and5.
source two chooses the RTTrPL universe.

Notes:
RTTrPL universes start from universe 0 instead of 1.
RTTrPL must be source 2.

Change the Mode to be X-Fade, set the trigger channel to be the same as your merging channel,6.
and then click Set default mode.
Click Submit Changes.7.

Result: That output will be configured as expected. If you select Show table, you should see
the channels have all changed to X-Fade, with a trigger of the specified channel.

Repeat the above for all outputs you wish to configure on the node.8.
Click Submit Changes.9.
Navigate to the Global tab under Setup. Set Enable Trigger to DMX, and the universe to whichever10.
universe your Merging Channel is patched to, with the desired DMX protocol.
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Luminex Luminode Settings
The Luminex Luminiode must be configured to work with your BlackTrax system.

Attention: The following guide outlines how each variable should be set for use with BlackTrax. Each
BlackTrax event is unique. There are circumstances where these settings need to be modified based on
factors such as the rig, cabling, and patching. 

Setup the node through the web interface. Please ensure your IP settings match that of the node(s) you
wish to configure. There are 2 ways to configure your node to work with BlackTrax: 

To merge RTTrPL with an Art-Net or sACN universe via the 5-pin DMX ports.1.
To reroute the merged data to another universe over the network (for example, when other nodes2.
are being used downstream of your Luminex nodes).

To configure a node to merge and send data via the DMX ports

Navigate to the web interface, enter the IP address of the node in your browser window.1.
Under Node, click on the desired node you wish to configure. 2.
Set up both the inputs on the center column, select X-FADE.3.

Result: The second input is created.
Choose your universes and label accordingly.4.
Set up your merge channel in the middle section, choose the channel, and you can use the gear to5.
change the source.
Select the DMX output to use the DMX port on the node. If you need to re-route, choose Artnet, or6.
sACN,and specify the output universe.

Standard merge settings:
Outputs universe 1 to the DMX port on the node, with a crossfade.

 

Custom Settings (Node menu)
Note: This is for multiple merge channels.

To apply custom settings for multiple merge channels

Select Custom in the center column.1.
Result: This setting creates 4 inputs and shows a Patch button in the center area.

Make input 1 Artnet, or sACN Universe 2 RTTrPL.2.
Set universes accordingly.3.
Click the Patch button in the middle section.4.

Result: This brings up the following:                                                                   

 

In the middle, you can control which channels you want to affect, the mode (X-FADE), and the5.
control channel. Press Apply to the right of these input boxes, and you should see it affect all the
channels in the table below these settings. You can do this multiple times to control which channels
are listening to which control channels. You can then press Apply on the top-right corner to save.  It
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will also close this screen.
Select the DMX output to use the DMX port on the node. If you need to re-route, choose Artnet, and6.
specify the universe you want to output to.

To configure a node to reroute merged data to send to other DMX nodes 

Standard re-route settings:
This is done by selecting an Artnet or sACN output, and designating the universe you wish to use. You
can also designate which IP re routes the merged data to (default will be broadcast on 2.x.x.x).

Re-routes universe 101 to 1, with a crossfade.

 

Global Settings
Global settings is used to specify the merge channel universe:

 

Other
Remember to press the Save button whenever you make changes, and that you enable the outputs you
want to use.

The standard view of Node page with one output enabled and the other disabled (checkboxes in the
upper left):
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ArtGate Node Settings
DMX nodes of the ArtGate family of models must be configured to work with your BlackTrax system.

Attention: The following guide outlines how each variable should be set for use with BlackTrax. Each
BlackTrax event is unique. There are circumstances where these settings need to be modified based on
factors such as the rig, cabling and patching.

Setup the node through a web interface, or setup the node through a BlackTrax server. Please ensure
your IP settings match that of the node(s) you wish to configure.

To configure a node

To navigate to the ArtGate model's web interface, enter the IP address of the node in your browser1.
window.

Result: The Main Settings window of the ArtGate model appears.                                            

   

On the Main tab, scroll down to the Ports section.2.
For each DMX port that you want to use:3.

Set Mode/merging column to Out/ComXFade.1.
Set Pri.unv.protocol column to the desired protocol (Art-Net or sACN).2.
Set the Pri.unv.number column to the desired universe.3.
Set the Sec.unv.protocol to RTTrPL.4.
Set the Sec.unv.number to the corresponding RTTrPL universe.5.

Click Save Settings at the bottom of the page.4.
Click the Advanced tab on the main toolbar at the top of the page.5.

Result: The Advanced port settings window appears.                                     

 

Scroll down to the Advanced Port Settings section.6.
For each DMX port that you set on the Main tab:7.

Set the Trigger/XFade unv.protocol column to the desired protocol for the merge channel1.
(Art-Net or sACN).
Set the Trigger/XFade unv.number column to the universe which contains the merge2.
channel.
Set the Common Trigger/XFade control channel to the chosen DMX merge channel in the3.
above universe.

Click Save Settings at the bottom of the page.8.

Notes:

RTTrPL universes start from universe 0 instead of 1.
Information updated as per ArtGate Pro firmware version 4.06.
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ELC Node Settings
ELC DLN8GBX and DLN8GBXSL Nodes from ELC Lighting must be configured to work with your BlackTrax
system.

DLN8GBX and DLN8GBXSL Nodes must be run a minimum firmware version of 1.28.

Attention: The following chart is a guide that outlines how each variable should be set. Each BlackTrax
event is unique. There are circumstances where these settings would need to be modified based on
factors such as rig, cabling, and patching.

MENU VARIABLE SET TO... NOTE

DMX Port (#) Port Mode Output The DMX Port settings need to be configured for each port in use,
e.g. if Port 1 is in use, DMX Port 1 must be configured.

 Mode Single  

 Primary Art-Net or sACN (#) The Art-Net number needs to correspond to the DMX universe as
assigned by the console.
ELC DLN8GBX and DLNGBXSL Nodes start numbering universes at
"0.0", e.g. 0.0 = Universe 0, 0. = Universe 1.
sACN does not follow the same logic as Art-Net. In sACN 1 =
Universe 1.

 Resend N/A Leave this setting blank.

 Hold Always  

 Rate Sync  

BlackTrax Mode Controlled  

 Universe (*) The universe number must be the same as assigned by the lighting
console.

 Channel (*) Free DMX channel not used by another DMX device. This channel will
be used to control the merging value between BlackTrax and the
lighitng console.

Network settings Dynamic OFF  

 IP Address (*) Free IP address not used by another device.
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Known Issues in BlackTrax
Known issues with reference to BlackTrax 2.5.0 BETA :

BTWYG may hang/crash if trying to fullscreen Shaded view on a second monitor.1.
When removing Sensors from the Sensor List, a blank row may be left over until the Sensor Group2.
selection is toggled.

Note: If a Sensor Group is attempted to be made based on one of these empty rows,
BlackTrax will crash.

If Sensors are renumbered when a Sensor is missing, the Main GUI might crash.3.
If a Sensor with a lower serial number is added to a project after a higher serial number is4.
connected, the Main GUI will crash.

The workaroud is to either connect Sensors in sequential order or to connect all Sensors first
before connectingto BTNet.

Cue may crash if old recordings are played back.5.
When starting Sensor Calibration from BlackTrax, Stage may not shut down fast enough for Motive6.
to start up.

If this happens, Motive will tell you another instance is already running; please wait a few
seconds and manually launch Motive to continue.

After making a Trackable change and Applying Changes, tracking will momentarily stop for a few7.
seconds and then resume.
Changing the universe of a Fixture while it is actively tracking will not update its patch until a8.
Chapter change.
When using the new Set Home centroid feature, if the LEDs move since the first Set Home, it is9.
required that Set Home is clicked twice for any additional centroid updates.

Known issues with reference to Motive 2.0.1 (applies to BlackTrax versions 2.4.3
and earlier):

Visible Bounds will disappear from the 3D view if Windows is Locked.1.
The feature will still work. If you need to see the bounds, restart Motive to fix the issue.
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System Procedures
Table of contents:

Licensing
Charging BTBeacons
Replacing a BTBeacon's Lithium-Ion Battery
Installing Third Party Software
Server Failover
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Licensing
Licensing Overview
BlackTrax includes a licensing security system to authorize hardware devices on the BlackTrax Network.
Unrecognized devices on the BlackTrax Network are not compatible with the software. An unrecognized
device is any device on the BlackTrax Network that was not sold directly to you by CAST Software.

A BlackTrax License will authorize the use of the BlackTrax system for a restricted number of output
connections based on the type of License that was purchased. The number of output connections allowed
for each type of License varies from a minimum of 1 output connection and up to a maximum of 12
output connections, or the non-restricted Unlimited License.

The number of output connections that is authorized with the BlackTrax License is indicated in the About
BlackTrax dialog box.

 

Notes:

The default License Folder location is: C:\bt_run_time\license. Licenses can be downloaded from the
BlackTrax Members Only Downloader which can be found at this link. 

You need to update your license if you have added new hardware devices to the network and
received an error message in BlackTrax.
You need to upgrade your license if you want to add output connections for additional unicast
outputs.

Attention: BlackTrax Licenses purchased before BlackTrax Release Version 2.2.3 will automatically
convert to the Unlimited License.
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Charging BTBeacons
Charging Overview
BTBeacons are charged using the BTSmart Charger. BTBeacons can be connected to the BTSmart
Charger using the Mini USB port found on the side of the BTBeacon.

Attention: 

The Mini USB port of the BTBeacon is not designed to be a peripheral device to a Class B personal
computer. As such, a user shall not connect the USB port to a Class B personal computer during
normal operation.
The sole power source of the BTBeacon is the internal 3.7V rechargeable Lithium-ion battery. The
BTBeacon does not require a connection at the Mini USB port to operate.

To charge a BTBeacon using the BTSmart Charger

Connect the BTBeacon to the charge station via the Mini USB port found on the side of the BTBeacon.

Result: The BTBeacon is charging. To determine when the BTBeacon is fully charged, see BTBeacon
status LEDs (During operation).
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Replacing a BTBeacon's Lithium-Ion
Battery
BTBeacon Lithium-ion Battery Overview
After extensive use the lithium-ion battery in a BTBeacon may no longer operate and be unable to power
the BTBeacon. The lithium-ion battery’s life cycle is at its end if the lithium-ion battery will not hold a
charge and the BTBeacon will not power on. When this occurs, it is recommended that the lithium-ion
battery inside the BTBeacon be carefully replaced with a new lithium-ion battery.

Attention: 

Only use lithium-ion batteries supplied by CAST. It is recommended that batteries be changed once
a year to ensure optimal performance.
The following are required when replacing a BTBeacon’s battery:

Replacement battery
3/8” Hex key
Adhesive tape

To replace a BTBeacon’s battery

On the BTBeacon, hold down the red Power button for 2 seconds.1.
Result: The BTBeacon will power off. No lights on the unit will be on.

Turn the BTBeacon over. Using a hex key, remove the 3/8” screws holding the case together.2.
Carefully separate the two halves of the BTBeacon case. There is a ribbon cable connecting the3.
motherboard in one half of the case, to the lithium-ion battery in the other half of the case.
Disconnect the ribbon cable from the motherboard.4.
The lithium-ion battery is attached to the case with adhesive tape. Gently remove the battery free5.
from the case.

Attention: When removing the battery, use soft tools and take care to not puncture or
damage the battery casing.

Properly dispose of the old battery.6.
Take a new battery and adhere it to the inside of the case.7.

Note: The adhesive tape must be heat resistant to function properly.
Connect the ribbon of the new battery to the motherboard.8.
Join the halves of the BTBeacon case and close the unit.9.
Fasten screws to the back of the BTBeacon case, sealing it.10.
Press the Power button down.11.

Result: The lights of the BTBeacon will flash and the unit will turn on. The BTBeacon’s
battery has successfully been replaced.

 Opening the case to remove the battery
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 Disconnecting the ribbon cable

 Adding new double sided tape, and insert new battery

Reconnecting the ribbon cable

 Closing the case
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Installing Third Party Software
The BTServer is a closed system. Circumventing the security measures in place on the BTSystem for any
reason, including the installation of third party software on the BTServer, is explicitly not permitted.
Circumventing the security of the BTSystem will immediately void the warranty.

This policy is in effect to protect the performance and stability of the BTSystem. Having third party
software installed might adversely affect the BTSystem.

Note: If third party software must absolutely be installed on the BTSystem, please contact CAST or your
local BTE for a possible solution. If a BTE or CAST deems the software acceptable, they may arrange to
install it for you.
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Server Failover
In the event a user needs to switch from their main BT Server, to a backup BT Server, the following
procedure should be followed.

Note: Users should keep a backup of their related show files in the event they need to switch servers
during operation. Users can easily do this using BTBackup on their servers, or by manually copying the
files to a USB stick. 

Only 1 instance of Motive, as well as BTEngine should be present on the network at any given time.1.
Therefore, the backup server should not have these modules open, or be disconnected from all
networks until needed.

The BlackTrax GUI, and BTWYG can be opened, with their files loaded on both servers at the
same time.

In the event of needing to switch servers, ensure the main BTServer has been disconnected from2.
it's associated networks.
On the Backup server, Launch Motive, with the correct file.3.
In the BTGUI launch BTEngine and Apply Changes.4.

From this point the show should be running as expected from the Backup Machine. Optionally, users
could have all modules and files running on the Backup Machine, with it completely disconnected from all
networks until the time of failover.
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BTWYSIWYG For BlackTrax
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Preparing the BTWYG file
Table of contents:

Introduction
Creating a BTWYSIWYG Project
Saving the BTWYSIWYG Project
Requirements for Creating the Space in BTWYSIWYG
Defining a Common Origin in BTWYSIWYG
Creating the Venue in BTWYSIWYG
Creating Trackables in BTWYSIWYG
Patching Trackables in BTWYSIWYG
Hanging Moving Fixtures in BTWYSIWYG
Best Practices for Moving Fixture Placement
Patching and Assigning an ID to Fixtures in BTWYSIWYG
Patching DMX Universes to a Console
Patching Universes to BlackTrax
Applying BTX information to BlackTrax from BTWYSIWYG
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BTWYG Introduction
BTWYSIWYG is an award-winning program that offers lighting designers a customized 3D CAD, reporting
and pre-visualization application which is included in the BlackTrax software suite. Using BTWYSIWYG will
let you create a virtual representation of the Space.

BTWYSIWYG exports this information as a ".btx" file, which is then used by BlackTrax as a blueprint for
tracking in the Space. If you are tracking with moving fixtures, fixture position and patching must also be
included in the ".btx" file.

When connected to BlackTrax, BTWYSIWYG can act as a visualizer for what is happening in the Space.
Trackable and fixture movement can be fully simulated, using information from BlackTrax or other data
sources.

The following section on BTWYSIWYG covers only the features directly related to BlackTrax. For an in-
depth understanding of BTWYSIWYG and its full capabilities, please refer to the current WYSIWYG
Reference Guide.

Tip: A registered BlackTrax Expert can be consulted to assist with any portion of a BlackTrax project,
including transferring information from BTWYSIWYG to BlackTrax.
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Creating a BTWYSIWYG Project
Creating a BTWYSIWYG Project from BlackTrax
When a new BlackTrax project is launched from the Portfolio Manager for the first time, a new
BTWYSIWYG project associated with the launched BlackTrax project is automatically created and opens
by default.

When a new BTWYSIWYG project is created from BlackTrax, all necessary settings and configurations are
automatically applied to that new BTWYSIWYG project. These template projects simplify the setup
process for BTWYSIWYG on new installations.

Creating and launching the new BTWYSIWYG project from the BlackTrax Portfolio Manager will
automatically start BTWYSIWYG in a state that is ready for BlackTrax use.

In the Editing section of the System Configuration widget in BlackTrax, you can set the BTWYSIWYG file
to automatically open after the associated BlackTrax file launches from the Portfolio Manager. For more
information about editing, see Editing section.

Notes: 

We recommend to create and launch the new BTWYSIWYG project from the BlackTrax Portfolio
Manager, which is more convenient than to create the new project and settings manually in
BTWYSIWYG.
You can also launch the BTWYSIWYG file associated with a BlackTrax project via the BTWYG option
under the Modules menu.

 

Creating a New BTWYSIWYG Project
in BTWYSIWYG
The New command creates a new show document and will be saved as a ".wyg" file. 

To create a new BTWYSIWYG project

In BTWYSIWYG, on the Welcome Screen, click File to choose New.1.
Result: The BTWYSIWYG opens a new show file in CAD.

 BTWYG Welcome Screen
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Saving the BTWYSIWYG Project
Once you have all the information on the Space that was created in BTWYSIWYG, the information must
be saved as a BTWYSIWYG project file (.wyg).  Save will save the open BTWYSIWYG project to the same
file name and location under which it was previously saved. If you are saving the project for the first
time, this command will perform Save As..., which will save the current project with a new file name
and/or a new destination.

To save the BTWYSIWYG project using Save

In BTWYSIWYG, from the File menu, choose Save.1.
Result: The Save as window appears.

In the Save as window, navigate to where you want to save the project file.2.
In the File name field, type in the name of the project.3.
Click Save.4.

To save the BTWYSIWYG project using Save As...

In BTWYSIWYG, from the File menu, choose Save As.1.
Result: The Save as window appears.

In the Save as window, navigate to where you want to save the project file.2.
In the File name field type in the name of the project.3.
Click Save.4.
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Requirements for Creating the Space in
BTWYSIWYG
To use BlackTrax, you are required to create a virtual representation of the Space in BTWYSIWYG. This
virtual Space will possess vital information that BlackTrax requires as follows: what the dimensions and
tracking area of the Space are, what objects or people you want BlackTrax to follow (Trackables), and
information on devices in use (e.g., fixtures). This section will guide you when creating the Space and
aspects that must be included in BTWYSIWYG.

To create the BTWYSIWYG file for tracking with moving fixtures in BlackTrax, follow these
mandatory steps

Define a common origin position in the Space. (Default set in template file.)1.
Create and patch Trackables to a motion universe and assign avatars. (Default set in2.
template file.)
Hang moving fixtures approximately where they will be in the venue with the correct orientation.3.
Patch fixtures to DMX universe and assign Spot IDs.4.
Patch DMX universes to console. (Default set in template file.)5.
Patch all created universes to BlackTrax. (Default set in template file.)6.
Save the BTWYSIWYG project. 7.
Export the BTWYSIWYG project for use with BlackTrax. (Default set in template file.)8.

Tip: Some of the required steps are set by default when the BlackTrax Template file is used in
creating a BlackTrax Portfolio, or from the Templates section in BTWYSIWYG.

To create the BTWYSIWYG file NOT for tracking with moving fixtures, follow these mandatory
steps

Define a common origin position in the Space. (Default set in template file.)1.
Create and patch Trackables to a motion universe and assign avatars. (Default set in2.
template file.)
Patch all created universes to BlackTrax. (Default set in template file.)3.
Save the BTWYSIWYG project.4.
Export the BTWYSIWYG project for use with BlackTrax. (Default set in template file.)5.

Tip: Some of the required steps are set by default when the BlackTrax Template file is used in
creating a BlackTrax Portfolio, or from the Templates section in BTWYSIWYG.

 BTWYG file with patched fixtures and a trackable
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Defining a Common Origin in
BTWYSIWYG
Origin Introduction
Most objects in BTWYSIWYG are drawn as 3D objects, with width, depth, and height values using the
Cartesian coordinate system of 3 working axes, X, Y, and Z. The point where the 3 axes meet is called
the origin and the value of X, Y, and Z is 0 respectively (0,0,0).

By default, the origin will be in the center of the WYSIWYG project. This default origin is called the
Document Origin. It is possible to move the origin from its default location to a new position. This origin is
called the User Origin.

 CAD mode with a frame representing the default origin 

 

Origin Requirements
The location of the origin is recommended to be inside the Space.
The origin should be easy to see and determine in the Physical Space.
The origin in the Physical Space needs to be visible to at least 2 BTSensors for BTSensor calibration
to function.
The location of the origin needs to be consistent. The origin needs to be the same in the
BTWYSIWYG virtual Space, in Motive, in the Physical Space and any Third Party Programs
connected to BlackTrax. Inconsistencies will cause errors in the BTSystem and any connected
downstream technologies.
The alignment of the ground plane in relation to the axes needs to be the same in the BTWYSIWYG
virtual Space, in Motive, and in the Physical Space. It is recommended that the following
conventions are followed when aligning the origin:

The +Y axis directed Upstage.
The +X axis is directed Stage Left.
The +Z axis is directed vertically towards the ceiling.

 

Ruler Tool
The Ruler Tool helps you design your show file in the Wireframe views of the CAD mode, providing a
visual aid for coordinate reference and measurement. By default, the ruler is aligned with the document
origin and displays coordinate information along the top and left side of the view. Its scale matches the
default grid scale. The ruler has different colors to represent different axes (X=Red, Y=Green, Z=Blue).

 X Axis Ruler
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 Y Axis Ruler

 Z Axis Ruler

 

Ruler Icons
Document Origin: The document origin icon appears when the Ruler’s zero position (origin) is aligned
with the Document Origin, which is set by default to be the center point of the BTWYSIWYG venue
defined for the event.

 Document Origin Icon

User Origin: The user origin icon appears when you have set a new User Origin for the file.

 User Origin Icon
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Creating the Venue in BTWYSIWYG
Using the tools in BTWYSIWYG’s CAD mode, create an accurate scale representation the venue where
Space is in. We suggest a minimum level of detail that includes floor, walls, and pipes, trusses, or
structural frames in which BTSensors or moving fixtures will be attached. A more detailed venue will look
better, and visualization will be more accurate.

Attention:

Fixtures need to be attached to pipes or trusses to insert in BTWYSIWYG.
You may insert fixtures on the floor, but the inserted fixtures will not spin using Fixture Properties.

Note: Due to the complexity of recreating an accurate representation of a venue, refer to the WYSIWYG
Reference Guide’s chapter on The CAD environment for a thorough understanding.
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Creating Trackables in BTWYSIWYG
Trackables are objects or people to track. A Trackable can be represented by a library object from the
Library Browser, or on a drawn object like a sphere or riser. Trackables are created on the
Trackables/Motion layer by default.

Important Notes:

Trackables are automatically named and patched when created.
By default, when a New Portfolio is launched from BlackTrax, BTWYSIWYG opens with 12
Trackables.

To create a trackable in BTWYSIWYG

In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BT Trackable.1.
Result: The Enter new Axis name window appears.                                           

 

In the Enter new Axis name window, click the layer for the Trackable from the Layer drop-down list.2.
You can also select the checkboxes to enable the other options for the layer display.3.
Click OK.4.
On your drawing, click where you wish to place your Trackable.5.

Result: A Trackable object appears where the mouse was clicked. The Trackable object is
represented as a Cartesian axis.

To add a library object to your trackable

In BTWYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.1.
From the LIBRARY menu, choose Browse Library.2.

Result: The Library Browser window appears.
At the bottom of the Library Browser window, click the Library items tab to display the contents.3.
Navigate to the desired object you wish to represent a Trackable.4.

Note: The actual look of the Trackable is purely cosmetic and will only represent the
Trackable's position in the visualization.

At the top of the Library Browser, click the Insert tool.5.
Tip: You can also double-click the object name.

To insert the object, click on your drawing to place the object where you want in relation to the6.
Trackable.

Tip: You should place the object relative to the drawn Trackable where the stringers will be
on your physical tracked object. The object will then move and rotate around the centroid of
the Trackable.

To stop inserting the object, right-click on the drawing and select Finish Library Item from the7.
menu that appears.
Right-click on the Trackable object you inserted on the drawing.8.
From the menu that appears, select Properties.9.
On the General tab, from the Attach to Axis drop-down list, select the Trackable object you wish to10.
assign the Library object to.
Click OK.11.

Result: The Trackable is represented as the inserted object and its motion is associated with the
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BTTrackable.

 Trackable object with a person attached 

Note: The BlackTrax Template file has one Trackable and avatar created and patched by default. It is
possible to create multiple Trackables at once using the array tool in BTWYSIWYG, and this created
Trackable. For more information about multiple objects, see the Array section in the WYSIWYG Reference
Guide.
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Patching Trackables in BTWYSIWYG
Patching Trackables Introduction
Important Note: As of BlackTrax v2.2, the Quick Motion Patch Tool is no longer required to patch
Trackables because Trackables are automatically named and patched when inserted.

Trackables that are created need to be patched to a Motion Universe. The patch allows the visualization
of Trackable movement in BlackTrax. This section shows how to easily patch Trackables using the Quick
Motion Patch Tool, as well as the manual way to patch each Trackable.

Note: Read the WYSIWYG Reference Guide’s chapter on Data mode for a complete understanding of
patching manually assigned Trackables.

 Quick Motion Patch Tool

 

Patching Trackables Using Quick Motion Patch Tool
To patch all trackables using the quick motion patch tool

From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.1.
Under the Auto-Patch Motion section, ensure that All Trackable/Axes is selected.2.
Click Patch.3.

Note: If the motion universe BT-Trackables does not yet exist in the file, BTWYSIWYG will
ask in a dialog box if you wish to create it. In the dialog box, click Yes to create the motion
universe.
Result: The Trackables are patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.

Click Close.4.

 To patch only selected trackables using the quick motion patch tool

Select all Trackables you wish to patch in one of the wireframe views.1.
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not
the Trackable object itself.

From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.2.
Under the Auto-Patch Motion section, ensure that Only Selected Trackable/Axes is selected.3.
Click Patch.4.

Note: If the motion universe BT-Trackables does not yet exist in the file, BTWYSIWYG will
ask in a dialog box if you wish to create it. In the dialog box, click Yes to create the motion
universe.
Result: The Trackables are patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.

Click Close.5.

 To clear all trackables' patch using the quick motion patch tool

BlackTrax Wiki 101 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=184&display


From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.1.
Under the Clear Motion Patch section, ensure that All Trackable/Axes is selected.2.
Click Clear.3.

Result: All Trackables are unpatched from the motion universe. The total number of patched
Trackables removed will be reported at the bottom of the window.

Click Close.4.

 To clear only selected trackables' patch using the quick motion patch tool

Select all trackables you wish to clear patch info for in one of the Wireframe views.1.
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not
the Trackable object itself.

From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.2.
Under the Clear Motion Patch section, ensure that Only Selected Trackable/Axes is selected.3.
Click Clear.4.

Result: All selected Trackables are unpatched from the motion universe. The total number of
patched Trackables cleared will be reported at the bottom of the window.

Click Close.5.
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Hanging Moving Fixtures in BTWYSIWYG
If you want moving fixtures to follow a Trackable, you must place and hang the moving fixtures in
BTWYSIWYG. When a moving fixture is placed in BTWYSIWYG, BlackTrax collects valuable fixture
information such as the properties, range of capabilities, orientation and position in the venue.

Moving fixtures must be placed on the floor or hung onto pipes or trusses. The position and orientation of
the fixtures in BTWYSIWYG must be close to their location in the actual Space for tracking to work
correctly.

Attention:

Calibration can resolve the fixtures' incorrect locations or backward orientation, but the calibration
process is tedious. The fixtures in the actual Space should match their virtual fixture orientation
and location to make calibration easier.
Library objects that are classified as moving lights are capable of following Trackables.

Tip: To keep fixture orientation consistent, make a note on the orientation of the fixture’s tail. This
provides an accurate indication of the fixture's orientation.

Note: Read the WYSIWYG Reference Guide’s chapter on Hanging and focusing fixtures for a complete
understanding on how to hang fixtures.

To insert fixtures in BTWYSIWYG

In BTWYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.1.
From the Library menu, choose Browse Library.2.

Result: The Library Browser window appears.
At the bottom of the Library Browser click Fixture Tool.3.
On the menu that is now visible, double-click Manufacturer to select fixtures by manufacturer4.
name, Type to select by fixture type, or All to see all the fixtures in alphabetical order.

Note: Alternately, you can use the Library Browser's search function to locate the fixture that
you want to insert. Simply type the name of the fixture (or a partial name) in the search box
at the top of the Library Browser, and then click the Search icon.

Double-click the fixture name.5.
Result: A fixture with default settings for this type attaches to the cursor.

To change the properties of the fixture before inserting, in the Library Browser right-click on the6.
fixture name. On the menu that appears, click Properties.

Result: A dialog box opens with a shaded view of the fixture on the left and an image of its
symbol on the right. Change the properties as needed.

To place the fixture, click over a hang structure.7.
Result: Copies of the fixture attaches to hang structures when clicked. Continue placing this
type of fixture by clicking on the other hang structures as desired.

Right-click to finish placing this fixture type. On the menu that appears select Finish placing8.
fixtures.

Note: Alternately, clicking ESC will finish placing fixtures.
To place other fixture types, repeat the above steps for each type.9.

Attention: Fixtures intended for tracking must not hang directly over the Space.
When placing moving fixtures that are to follow Trackables, it is recommended that fixtures
are not hung directly above the Space. Fixtures hung above the Space may run into pan and
tilt range limitations when attempting to follow a Trackable.

 Fixtures placed on a pipe

BlackTrax Wiki 103 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=302&display


Best Practices for Moving Fixture
Placement
To obtain precise tracking in BlackTrax, the limitations of moving fixtures must be taken into account.
The following section will guide you through known limitations of moving fixtures in BlackTrax and
provide smart practices used to overcome these limits.

Attention: Do not place fixtures that will track directly above the Space.

A number of issues can occur if fixtures are directly above the Space. If fixtures are placed above the
Space and are following a Trackable which moves in a circular path underneath, this can cause fixtures
to spiral and reach a pan stop.

Note: BlackTrax has a feature where if a fixture pan-flips, the fixture will dim while performing the flip.
This is in place to reduce the disruption caused by the pan-flip during operation.

Tips:

Prediction algorithms can be selected when tracking to try and achieve specific tracking needs. For
more information, see Fixture Sensitivity.
To avoid these problems, it is recommended that moving fixtures are instead placed in front,
behind, or on the sides of the Space. This will limit the range of both pan and tilt movement needed
by fixtures to follow a Trackable and avoid these potential problems.
If tracking must occur below a fixture, a possible solution is to hang the fixture sideways.
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Patching and Assigning an ID to Fixtures
in BTWYSIWYG
Patching Fixtures to BTWYSIWYG Introduction
When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched 1:1 by default.

When tracking occurs, BlackTrax uses the DMX values generated by the console, but overrides the pan
and tilt channels with new values. These new values direct the fixture to aim and follow a Trackable. If a
fixture was edited to have a constant beam size, the zoom and iris values will also change. The patching
must be the same so that BlackTrax can override the correct DMX universe and channels.

In BTWYSIWYG, you can create and patch a DMX universe using the spreadsheet in DATA mode or Quick
Tools.

To create a DMX universe

In BTWYSIWYG DATA mode, click the Patch layout tab at the bottom of the screen.1.
Right-click on the patch shortcut area on the right of the screen.2.
On the menu that appears click New Patch.3.

Result: The Enter new Patch Universe name dialog box appears, prompting for the type of
universe that you want to create and the name of the new universe.

Type the name of the patch universe.4.
Under Patch Universe Type, select DMX.5.
Click OK.6.

Result: The patch shortcut appears in the Patch tab.

 DATA Mode with one DMX universe created

Assigning Spot ID Numbers to Fixtures
An individual Spot ID number must be assigned to every single fixture in the project in BTWYSIWYG. This
Spot ID number will map to a fixture ID on a connected lighting console. The Spot ID is used by the
BTSystem to differentiate between fixtures in the project.

Fixture Patching Methods
There are multiple ways to patch fixtures in BTWYSIWYG. The following section will guide you through
some of the simplest methods. For more information about patching, see the WYSIWYG Reference
Guide’s chapter on Data mode.

To patch fixtures and assign spot IDs using quick tools

Use Quick Tools and click on the fixtures in Wireframe view to patch and assign spot IDs. The first fixture
clicked will be assigned the patch and ID as configured in Quick Tools. The next fixture clicked will be
assigned the next available channel in the patch and the next fixture ID in the sequence until you are
finished using Quick Tools.
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In BTWYSIWYG CAD mode Wireframe view, from the Tools menu, choose Quick Tools and then1.
choose Quick Tools. Alternately click the Quick Tools icon in the Tools toolbar.

Result: The Quick Fixture Tool window appears.
In the Quick Fixture Tool window, in the Fixture Attributes section, select the Spot checkbox.2.
In the Spot field, enter a number which will be the first fixture ID used in the sequence.3.
In the Fixture Data section, select the Patch checkbox.4.
In the Patch field, enter the universe and channel the first fixture will patch to, separated by a5.
period.
Example: “A.1” would patch to universe A, address 1.
Click Ok.6.

Result: When a fixture is selected, it will be assigned a Universe and channel to operate on.
The first fixture selected will be assigned the to the channel number entered in Quick Tools.
Subsequent fixtures selected will be assigned the next sequential channel and Spot ID
number.

Click on a fixture to patch it to a universe and channel. Click on each fixture that you want to be7.
patched and assigned a spot ID.
To stop patching fixtures, right-click.8.
On the menu that appears, click Finish Quick Tools.9.

 Quick Tools

To patch fixtures and assign spot IDs using the data spreadsheet

The Spreadsheet view In DATA mode displays information on all fixtures created in the BTWYSIWYG
project. You can edit the patch information and Spot ID directly in the spreadsheet table.

In BTWYSIWYG DATA mode, click on the Spreadsheet tab.1.
In the Columns section on the left side of the window, click All Data (Sortable).2.

Result: All fixture data are displayed in the spreadsheet.
In the Patch column, enter the appropriate patch information for each fixture.3.
In the Spot column, enter a unique Spot ID for each fixture.4.

Tip: It is possible to assign sequential values to fixtures quickly by selected all fields for the
fixtures you wish to edit (for example all spot ID fields for all fixtures) and type the spot ID of
the starting fixture and a '+' and hitting enter.  For example, 101+ will set the first fixture to
spot 101, and every fixture after that will increase by 1. If this method is used to assign
values, it is recommended that fixtures are first sorted so fixtures are organized. Fixtures can
be sorted in order of position, or Unit # along a pipe/truss. This can also be used for patching
fixtures as well.

 DATA>Spreadsheet with fixtures patched for BlackTrax 
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Patching DMX Universes to a Console
BlackTrax requires that the patching information of the connected console be recorded in BTWYSIWYG.
This will inform BlackTrax which console is in use and which ports will transmit information.

When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched 1:1 by default.

You can also patch the DMX universes to a DMX console in the Device Manager window in BTWYSIWYG.

Note: The DMX console used in BlackTrax and displayed in the Device Manager window in BTWYSIWYG is
an sACN device. This device will also work with Art-Net without any changes.

To patch the DMX universe to a console

In BTWYSIWYG LIVE mode, from the Managers menu, choose Device Manager.1.
Result: The Device Manager window appears.

In the Device Manager window, click New.2.
Result: The Library Selection window appears.

Navigate through the console library until you find the console or device that you are connecting3.
to. Click the console name to highlight it.
Click Insert.4.

Result: The console appears in the Device Manager window.
With the console name still selected, click Properties.5.

Result: The Properties window appears.
From the Protocol drop-down list, select the protocol used by the console.6.

Result: The console model is displayed in the Model field. The name of the console is
displayed in the Name field.

In the Address field, type the designated address of the console, if applicable.7.
You must bind output ports from the console to BTWYSIWYG patch universes. Bind a Port output to8.
the appropriate universe by clicking the Universe field next to the output.

Result: A drop-down list of available Universes is displayed.
Select the appropriate Universe from the list.9.
Repeat the above steps to bind all ports to their appropriate patch universes.10.
Click Close to close the Properties window.11.
Click Close to exit the Device Manager window.12.

Result: BlackTrax will know which console will be connected and which ports will transmit
information

 Device Manager with an Art-Net device and a BlackTrax console

 Art-Net Device Properties with patched universes
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Patching Universes to BlackTrax
When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched to BlackTrax 1:1 by default.

You can also patch the DMX universes to the BlackTrax Network in the Device Manager window in
BTWYSIWYG.

After universes are created, be it motion or DMX, this information will need to be patched to BlackTrax.
This will inform BlackTrax which of its ports are in use and which ports will transmit information.

To patch universes to BlackTrax

In BTWYSIWYG LIVE mode, from the Managers menu, choose Device Manager.1.
Result: The Device Manager window appears.

In the Device Manager window, click New.2.
Result: The Library Selection window appears.

In the Library Selection window, in the Search field, type BlackTrax Network and then click the3.
Search icon.

Result: The device BlackTrax Network will be displayed in the search results.
Click on BlackTrax Network from the list to highlight it, then click Insert.4.

Result: The BlackTrax Network appears in the Device Manager.
With the BlackTrax Network name still selected, click Properties.5.

Result: The Properties window appears.
You must bind output ports from the BlackTrax Network to BTWYSIWYG patch universes. Bind a6.
Port output to the appropriate universe by clicking the Universe field next to the output.

Result: A drop-down list of available Universes is displayed.
Select the appropriate Universe from the list.7.
Repeat the above steps to bind all ports to their appropriate patch universes.8.
Click Close to close the Properties window.9.
Click Close to exit the Device Manager.10.

Result: BlackTrax will know what ports are in use.

 Device Manager with an Art-Net device and a BlackTrax console

 The BlackTrax Console with Motion and DMX universes patches
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Applying BTX information to BlackTrax
from BTWYSIWYG
After a project is created, modified and saved in BTWYSIWYG, the new information must be sent and
applied to the BlackTrax Project. 

There are three methods for sending BTX information to BlackTrax from BTWYSIWYG:

BTX Apply in LIVE mode
BTX Export in CAD mode
BTX Apply in CAD mode

To send BTX information with BTX Apply in BTWYSIWYG LIVE mode

In BTWYSIWYG LIVE mode, from the Live menu, choose BlackTrax Panel.1.
Result: The BlackTrax window appears.

Ensure that the BlackTrax Portfolio is open, and BTWYSIWYG is connected to it.2.
In the BlackTrax window of BTWYSIWYG , click BTX Apply.3.

Result: BTWYSIWYG sends the BTX information to the BlackTrax Project.

To send BTX information with BTX Export in BTWYSIWYG CAD mode

In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BTX Export.1.
Result: A Save as window appears.

In the window, navigate to where you want to save the project file.2.
In the File name field type in the name of the project.3.
Click Save.4.

Result: The BTX information from BTWYSIWYG is exported and saved as a separate file
which can be used to manually update your BlackTrax Project.
Note: If there are errors in the export, BTWYSIWYG will display the errors after the export is
completed.

 BlackTrax Menu found in CAD mode

To send BTX information with BTX Apply in BTWYSIWYG CAD mode

Ensure that the BlackTrax Portfolio is open, and BTWYSIWYG is connected to it.1.
In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BTX Apply.  2.

Result: BTWYSIWYG sends the BTX information to the BlackTrax Project.            

 LIVE mode showing the BlackTrax panel with BTX Apply
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Optional .BTX Information
Table of contents:

BlackTrax Zones
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BlackTrax Zones
Three-dimensional areas called Zones, can be drawn inside the virtual representation of the Space
in BTWYSIWYG. Zones are an incorporeal volume and can only be viewed in BTWYSIWYG, but if created,
exists simultaneously in the virtual and physical Space. Zones are available in rectangular, cylindrical
and spherical shapes of any size.

BlackTrax has a number of preset interaction between Zones and fixtures, which can be accessed in the
Chapter section in BlackTrax. For information about BlackTrax Zones, see To enable a Zone for a Fixture.

To draw a rectangular zone

In BTWYSIWYG CAD mode, click the Wireframe view tab.1.
From the BlackTrax menu, choose BT Zone and then choose Rectangular Zone.2.

Result: The New Rectangular Zone window appears.
In the New Rectangular Zone window, in the Width field, enter in the width of the Zone.3.
In the Depth field, enter in the depth of the Zone.4.
In the Height field, enter in the depth of the Zone.5.

Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.

In the Zone Name field, enter a unique name for the Zone.6.
Click OK.7.

Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

 BTWYG drawing with a Rectangular Zone selected

To draw a cylindrical zone

In BTWYSIWYG CAD mode, click the Wireframe view tab.1.
From the BlackTrax menu, choose BT Zone and then choose Cylindrical Zone.2.

Result: The New Cylindrical Zone window appears.
In the New Cylindrical Zone window, in the Height field, enter the height of the Zone.3.
In the Horizontal Radius field, enter in the horizontal radius of the Zone.4.
In the Vertical Radius field, enter in the vertical radius of the Zone.5.

Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.

Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,6.
clear the Lock Ratio checkbox.
Number of Segments controls how many segments make up the radius of the cylindrical Zone. The7.
default is set to 16. To change the number of segments, clear the Use Document Defaults
checkbox. Enter the new segment number in the field.

Note: The maximum number of segments allowed is 40.
In the Zone Name field, enter a unique name for the Zone.8.
Click OK.9.

Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
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dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

 BTWYG drawing with a Cylindrical Zone selected

To draw a spherical zone

In BTWYSIWYG CAD mode, click the Wireframe view tab.1.
From the BlackTrax menu, choose BT Zone and then choose Spherical Zone.2.

Result: The New Spherical Zone window appears.
In the New Spherical Zone window, in the Horizontal Radius field, enter in the horizontal radius of3.
the Zone.
In the Vertical Radius field, enter in the vertical radius of the Zone.4.

Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.

Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,5.
clear the Lock Ratio checkbox.
Number of Segments controls how many segments make up the radius of the spherical Zone. The6.
default is set to 12. To change the number of segments, clear the Use Document Defaults
checkbox. Enter the new segment number in the field.

Note: The maximum number of segments allowed is 40.
In the Zone Name field, enter a unique name for the Zone.7.
Click OK.8.

Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

 BTWYG drawing with a Spherical Zone selected
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Planning BTSensor Placement
Table of contents:

Introduction
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BTSensor Introduction
Tracking only occurs in BlackTrax if two or more BTSensors can see a BTBeacon at the same time.
Therefore, when placing BTSensors, there must be some overlap between what each BTSensor sees.

Place and aim BTSensors in BTWYSIWYG first before setup in the physical Space. This step is optional and
will not affect your BlackTrax project. Planning BTSensor placement in BTWYSIWYG helps you test the
BTSensor’s coverage of the venue and determine how best to position them. BTSensors must not be 
placed any closer than 1m apart to help ensure optimal sensor calibration.
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BTSensor Placement
To place a BTSensor in BTWYSIWYG

In BTWYSIWYG CAD mode, click the Wireframe view tab.1.
From the Library menu, choose Browse Library.2.

Result: The Library Browser window appears.
At the bottom of the Library Browser window, click the Fixture tool.3.
In the search box, type BlackTrax.4.
Double-click on the name of the BTSensor that you want to insert.5.

Result: A fixture with default settings for this type attaches to the cursor.
To change the properties of the fixture before inserting, such as the lens size, right-click on the6.
fixture name, and then click Properties.

Result: A dialog box opens with a shaded view of the BTSensor on the left and an image of
its symbol on the right. Use the Appearance tab to change the lens settings for the BTSensor.
Options are 5.5 mm, 8.0 mm, 3.5 mm for Slim 13E.  For s250e BTSensor options are 5.5 mm,
8.0 mm.

To place the BTSensor, move the mouse over a hang structure, and then click. Continue placing7.
this type of fixture by clicking on the other hang structures as desired.

Note: BTSensors can be hung in Space without a hang structure.
Right-click and select Finish placing fixtures from the menu to finish placing the fixture.8.

Result: BTSensors will be hung in virtual space. BTSensors will emit a red beam to represent
their field of vision.

To aim a BTSensor in BTWYSIWYG

In BTWYSIWYG CAD mode, click the Wireframe view tab.1.
In the Wireframe view, select a BTSensor.2.

Tip: You can also use the Fixture Selection Tool to select a single sensor or multiple sensors.
Use the Fanning Tool to aim the BTSensor(s) to the desired location.3.

Tip: You can also use the Cuts and Adjustments tool or the Focus menu to aim BTSensors in
BTWYSIWYG.
Result: The BTSensor will orientate itself based on the new Pan and Tilt values. The
BTSensor’s new field of view will be shown. For information about focussing, see the section
on Quick focus in the WYSIWYG Reference Guide.

Example of BTSensor Placement
In CAD mode, BTSensors can be hung in the venue exactly the same as fixtures, from any pipe or truss.
In this example BTSensors are hung around the perimeter on pipes represented in yellow, a mannequin
in orange is at the origin of the room.

When BTSensors are hung, the BTSensor’s field of view will correctly project in the visualization. A
BTSensor field of view of in BTWYSIWYG is depicted as a red beam Everything in the red beam is what
the BTSensor can see.

Tracking can only occur when two or more BTSensors see the same area at the same time. By selecting
multiple BTSensors, we can see their field of view and where their vision overlaps. Overlapping views are
depicted in BTWYSIWYG as a deeper red then an individual view.

Two BTSensors whose field of view are overlapping. The deeper red in the center is the overlapping area
where tracking can occur.
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By placing BTSensors in BTWYSIWYG and viewing their projected field of view, it is easy to determine
where BTSensors should go and how they should be aimed to maximize the tracking area in the venue.
Any gaps in coverage where tracking cannot occur will also be shown. Once the position and orientation
of BTSensor have been determined, you can record the data to reproduce the BTSensor placement in the
actual venue.
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BlackTrax Visualization
Table of contents:

Introduction
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Vis Introduction
BlackTrax projects can be visualized within BTWYSIWYG where fixture and Trackable interactions are
simulated in the BTWYSIWYG virtual Space. Fixtures or Trackables that are selected in BlackTrax will be
selected in BTWYSIWYG depending on the settings defined in the BlackTrax System Configuration
widget. BTWYSIWYG, Motive, and BlackTrax must be open and running the project file for visualization to
work correctly.

To visualize BlackTrax activity in BTWYSIWYG

In BlackTrax, open the BlackTrax project file.1.
In BTWYSIWYG LIVE mode, go to the BlackTrax panel.2.

Note: To open the BlackTrax panel if closed, choose BlackTrax from the Live menu.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.

In the BlackTrax panel, select the BTX Mode checkbox.3.
In the BlackTrax panel and with BlackTrax running, click Connect.4.

Result: Activity in BlackTrax will now be visualized in BTWYSIWYG.
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Using BTWYSIWYG as a Tracking
Visualizer
Tracking data can be visualized in BTWYSIWYG. Viewing tracking data is useful for troubleshooting.
Seeing fixtures and Trackables move in BTWYSIWYG based on the data helps determine if data is actually
being transmitted. There could be problems in the BTSystem connections if there is no activity
in BTWYSIWYG.

To visualize tracking data in BTWYSIWYG

In BTWYSIWYG LIVE mode, from the Live menu, choose BlackTrax Panel to open the BlackTrax1.
panel.

Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.                

   

In the BlackTrax panel, select the BTX Mode checkbox to enable the option to connect with2.
BlackTrax.
Click Connect to activate the connection with BlackTrax, or click Disconnect to deactivate the3.
connection to BlackTrax.

Note: The BlackTrax template file connects automatically to BlackTrax when opened.
To customize how you interact with Trackables within Shaded view, select from the following4.
options:

Display Mode: On this drop-down menu, select Beacon Focused or Trackable Focused.
Beacon Focused: Displays all LEDs and Centroids regardless of the Trackable patch in
BlackTrax. This mode hides all objects attached to Trackables in BTWYSIWYG.
Trackable Focused: Displays only LEDs and Centroids that are actively patched to a
Trackable in BlackTrax. This mode also displays objects attached to the Trackable in
BTWYSIWYG.

Select Trackable Objects Only: Select this checkbox to choose only Trackable objects in the
Shaded view of BTWYSIWYG.
Prefer Frame LEDS: Select this checkbox to display only Rigid or Soft Frame's LEDs and
Centroids. When enabled, Classic and Mini Beacons will not be displayed in the Shaded view
if they are currently assigned to a Rigid or Soft Frame.

To set how the fixtures and their beams are displayed and selected in Shaded view, select from the5.
following options:

Show Lighting For: On this drop-down menu, select which beams of the fixtures will be
displayed.

All Fixtures: Displays all the beams of the fixtures in the BlackTrax project.
Tracking Only: Displays only the beams of the fixtures that are currently following
Trackables.
No Fixtures: No beams of the fixtures will be displayed.

Calibrated Fixture Position: Select this checkbox to show the position of the fixture as
calibrated by BlackTrax instead of using the BTWYSIWYG drawn position.
Show Beams With Stick: Select this checkbox to display the beams of light produced by the
fixtures as stick beams with the corresponding colors indicating their tracking status.
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Currently Tracking (Green): Select this checkbox to display only the stick beams of the
fixtures connected and actively following a Trackable in a BlackTrax chapter. This stick
beam appears in green color.
Currently Standby (Blue): Select this checkbox to display only the stick beams of the
fixtures that are connected to the system and are set to follow a Trackable in a
BlackTrax chapter. This stick beam appears in blue color.
Unassigned (Yellow): Select this checkbox to display only the stick beams of the
fixtures that are connected to the system but not set to follow a Trackable in any
BlackTrax chapter. This stick beam appears in yellow color. 

Select the Enable Message Log checkbox to activate the message logging options.6.
Log To File: Select this checkbox to record the log information and automatically store into a
file in the "bt_run_time" folder of your local drive.
Log Data: Select this checkbox to record the motion tracking information as it is displayed in
the message box.
Clear Log: Click this button to clear the message box.

 

Viewing LEDs and Centroids in Shaded View
of BTWYSIWYG

How LEDs of a Beacon are displayed in Shaded view:
An LED appears as a solid circle when in front of everything in Shaded view.
An LED appears as a circle outline when behind an object in Shaded view.
An LED appears in the color that is identical to the Beacon color in BlackTrax.
When an LED is selected, its color turns to white and the text label identification appears. For
example, the screenshot (above) shows "L:101.4" which indicates LED of Beacon 101 and LED no.
4.

How Centroids are displayed in Shaded view:
A Centroid appears as a solid square object when in front of everything in Shaded view.
A Centroid appears as a square outline when behind an object in Shaded view.
A Centroid appears in the color that is identical to the Beacon color in BlackTrax.
When a Centroid is selected, its color turns to white and the text label identification appears. For
example, the screenshot (above) shows "C:Whiteboard(101)" which indicates the Centroid
associated with Beacon 101 is patched to the Whiteboard trackable.
When a Centroid is selected, the LEDs associated with the Centroid are automatically selected.
The Centroid appears with only a number if it is not patched to a Trackable.

 

Using the Trackables and Beacons Widget
The Trackables and Beacons widget is an easier, convenient and faster way to find and select LEDs and
Centroids in the Shaded view of BTWYSIWYG.

BlackTrax Wiki 120 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=365&display


 

To use the trackables and beacons widget

In BTWYSIWYG LIVE mode, from the Live menu, choose Trackables and Beacons to open the1.
Trackables and Beacons panel.

Result: The Trackables and Beacons panel appears and displays the list of Trackables,
Beacons, and Frames associated with the connected BlackTrax project.

In the Trackables and Beacons panel, click on the arrow at the far left of the list of Trackables,2.
Beacons or Frame to expand or collapse the corresponding list below them.
On the Trackables and Beacons panel, click on a single or multiple Trackables, Beacons or Frame to3.
select in the Shaded view.

Result: In the Shaded view, the selected Trackable(s) or Beacon(s) or Frames will turn to
white with the corresponding text label identification.

Note: You can activate Shaded View Selection by pressing TAB while in CAD, Design or Live mode >
Shaded View. Once you press TAB, a purple message at the top right-hand corner of the Shaded view
window appears: "Shaded View Select ON", and you may click on the objects in Shaded view to select.
Please refer to the "Using Shaded View Selection" section in the current WYSIWYG Reference Guide.
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Using Calibration Data to Adjust
Visualization in BTWYSIWYG
Once fixtures have their position calibrated in BlackTrax, this information can be used to improve
visualization in BTWYSIWYG. The position of fixtures in BTWYSIWYG will change to the calibration
locations, creating a more accurate visualization.

To use calibrated fixture positions in BTWYSIWYG

In BlackTrax, open the BlackTrax project file.1.
In BTWYSIWYG LIVE mode, go to the BlackTrax panel.2.

Note: To open the BlackTrax panel if closed, from the Live menu, choose BlackTrax Panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.

Select the BTX Mode checkbox.3.
Click Connect.4.
Select the Calibrated Fixture Position checkbox.5.

Result: The position of fixtures in BTWYSIWYG changes to reflect the calibration data created
in BlackTrax.

Note: For information about calibrating fixtures, see Fixture Calibration.
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Using Stick Beams for Fixtures in
BTWYSIWYG
When you visualize in BTWYSIWYG, stick beams can represent the beams of light produced by fixtures.
This reduces clutter and confusion in the visualization and helps determine where fixtures are aiming and
which fixtures are selected.

To use fixture stick beams in BTWYSIWYG

In BlackTrax, open the BlackTrax project file.1.
In BTWYSIWYG LIVE mode, go to the BlackTrax panel.2.

Note: To open the BlackTrax panel if closed, from the Live menu, choose BlackTrax Panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.

Select the BTX Mode checkbox.3.
Click Connect.4.
Select the Show Beams With Stick checkbox.5.

Result: Fixture beams will be represented as sticks in BTWYSIWYG.
To toggle specific stick beams on or off, clear the checkbox next to the desired stick beam status6.
(Currently Tracking (Green), Currently Standby (Blue), or Unassigned (Yellow)).

  

Understanding Stick Beam Colors
The color of a stick beam communicates information about the parent fixture at a glance.

A Green stick beam means a fixture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable and it is currently following a Trackable - Currently Tracking
(Green).
A Blue stick beam means a fixture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable, but it currently is not set to follow a Trackable - Currently
Standby (Blue).
A Yellow stick beam means that a fixture is connected to the system, but there is no chapter in
BlackTrax where that fixture is told to follow Trackables - Unassigned (Yellow).
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Shaded View Camera Control
The default camera control in the Shaded view of BTWYSIWYG is set to Other 3D Applications where
commands and behavior are identical to other 3D applications instead of the traditional WYSIWYG
standard.

Mouse Actions

 

*Affected by View Option, "Pan tool moves objects".

Keyboard Actions

 

Note: In the Application Options window, you can choose Traditional WYSIWYG on the Shaded View
Camera Control list if you want to use the standard WYSIWYG camera control in Shaded view.
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Motive Introduction
The Motive module is used to manage and control BTSensors. Motive is part of the BlackTrax software
suite that is already installed on the BTServer and is ready for you to use. The following section will guide
you through specific steps on how to use Motive to configure BTSensors to work in the Space and
function with the BTSystem.

Note: If you are using BlackTrax 2.5 in non-Legacy Mode, see the section Coming from Motive -
Controlling Sensors in BlackTrax to manage and control BTSensors from within BlackTrax.

Attention: Users should only install versions of Motive included in BlackTrax System Update packages.
Failure to do so could result in your BlackTrax system not functioning correctly.

The Motive splash screen appears upon launch and it will display a notification if the Motive license is
about to expire or if the Motive license has expired or if the Motive license is not found. Motive will still
run with an expired license if the version was released at any time before the license expired. 

If your license is expired, please contact BlackTrax Support .

Motive opens and ready for use.
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Layout Presets in Motive
Custom preset layouts in Motive were created for BlackTrax and set as preset layouts which can be
restored quickly from the Layout menu or from the Main Toolbar drop-down menu. The custom preset
layouts for BlackTrax are:

Layout Preset Description Keyboard Shortcut

Running Opens the windows that will be used when a BlackTrax project is running. CTRL+1

Aiming Opens the windows that will be used for the aiming of BTSensors. CTRL+2

Calibration Opens the windows that will be used for the configuration of BTSensors. CTRL+3

Configuration Opens the windows that will be used for the configuration of a BlackTrax project. CTRL+4

Recording Opens the windows that will be used for the recording of motion data in a BlackTrax
project.

CTRL+5

The GUI layout in Motive can be customized. All windows can be docked and undocked from the GUI.
Each window can be positioned and organized by drag-and-drop using the on-screen docking indicators.
Windows may float, dock, or stack. Windows form a tabbed window when stacked together. The custom
layouts in Motive can be saved and loaded, allowing for the quick switching between default and custom
configurations suitable for different needs.

Notes:

All Layout Presets will load in Motive if BlackTrax is in Legacy Mode.
The Calibration Layout Preset will be the only Layout Preset available in Motive if BlackTrax is not in
Legacy Mode. For more information on Legacy Mode, see Sensors Section of System Configuration
in BlackTrax GUI.
Layout configurations from older versions will not load in Motive 2.

To restore a preset layout

In Motive, click the drop-down box at the right-hand side of the main toolbar and click the layout1.
preset from the drop-down menu of layout presets.

Result: Motive opens the preset windows in the selected layout.
Tip: You can also restore a particular layout from the Layout menu.
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BTSensor Differences in Motive
Depending on your tracking needs, the type of BTSensors used in your BTSystem will vary. Each model of
BTSensor has slightly different settings in Motive. Due to these different settings, steps outlined in this
manual may be slightly different depending on what BTSensor is in use.

Differences include specific properties of the BTSensor found in Motive in the Devices window, and the
BTSensor’s view found in the Camera Preview window.

Note: All BTSensors purchased from CAST are capable of tracking.
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BTSensor Presets
BTSensor Introduction
BTSensors are camera devices that need to be configured in certain ways to complete specific tasks:
tracking objects, referencing the BTSensor’s real-time location or aiming BTSensors. These settings can
be entered manually, or automatically configured in Motive by selecting a preset for a BTSensor or
BTSensors in a group. As of Motive 2.2, the following tables define the BTSensor settings that are
automatically configured when you select a preset. 

Note: The Rate Multiplier applies only when using Motive 2.2. The Rate Multiplier must be "-/x1 for the
BTSensors to be syncing at the correct Frame Rate. You must enter the Tracking Preset and/or be in
Object Video Mode before attempting to track to ensure the correct Rate Multiplier.

Tip: Rate Multiplier is the rate multiplier or divider applied to the master frame rate of the sync source.

SLIMX 13 Presets
 

SLIM 13E Presets
 

S250e SLIM Presets

 

Prime 41 Presets

 

Note:

Prime 41 BTSensor does not have a Filter Switch.
Prime 41 BTSensor has an IR LED Ring that you must switch off when tracking.

To select a preset setting for a BTSensor in Motive 2.2

In Motive, go to the Devices window.                                                                                                   1.
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Tip: To open the window, from the View menu, choose Devices Pane.
On the Devices window, select a single camera device or devices (BTSensors) in a group.2.
Right-click on the selected list of devices to access and choose the preset for the selected devices3.
(Aiming, Tracking, or Reference) from the Presets menu that appears.                                  

 

Result: The settings of the selected BTSensors will be replaced with the settings of the
selected preset.

To select a preset setting for a BTSensor in Motive 2.0

In Motive, go to the Devices window.                                                                                                  1.

     

Tip: To open the window, from the View menu, choose Devices Pane.
In the Devices window, select a single BTSensor, or select all BTSensors in the group by clicking the2.
group name.
At the top of the Devices window, click the Preset drop-down menu and select the desired preset.3.

Result: The selected BTSensors will have their settings changed to that of the selected
preset.

Note: BTSensors have been custom designed for BlackTrax, which removes the illumination ring.
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Checking the Connectivity of BTSensors
BTSensors must be connected to the BTSystem for tracking to occur. The connection status of BTSensors
can be determined in the Devices window in Motive.

To determine if BTSensors are connected

In Motive, click the drop-down box at the right-hand side of the main toolbar and click Running from1.
the drop-down menu of layout presets.

 

Result:
Motive opens the preset windows in the Running layout.
In the Devices window, all connected BTSensors will be displayed under the Cameras group.

Devices pane in Motive 2.2

Devices pane in Motive 2.0                                                                                                     

Note: If a BTSensor is not visible in the Devices window, check the physical connections to see if
any BTSensors are disconnected.
Tip: To help identify BTSensors, click the Aim Assist button on a BTSensor to cause the
corresponding BTSensor flash yellow in the Camera Preview window and appear selected in the
Devices window.
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Using Motive to Aim BTSensors
For tracking to occur, BTSensors must be positioned around the perimeter of the tracking area and aimed
towards the area. Tracking occurs in an area when two or more BTSensors view the same area at the
same time. A video feed of what BTSensors see is shown in Motive. By viewing the BTSensor’s video feed
in the visible spectrum, BTSensor positioning can be evaluated.

Attention: The Space origin must be visible to at least two BTSensors for sensor calibration to function
correctly.

Note: To quickly see a BTSensor’s video feed in the visible spectrum, change the preset setting of the
BTSensor to Reference. See To select a preset setting for a BTSensor for more information.

Motive 2.2
To view a BTSensor’s video feed in the visible spectrum

In Motive, click the drop-down box at the right-hand side of the main toolbar and click Aiming from1.
the drop-down menu of layout presets.

Result: Motive opens the preset windows for the aiming of BTSensors.
In the Devices window, select a single Camera from a group or select all Cameras in a group.2.
With the Camera(s) selected, set Video Mode and IR Filter in the Properties window.3.
Click the Video Mode drop-down list and select MJPEG High Quality.4.
Turn the IR Filter toggle to OFF.5.

 

Result: The video displayed from the BTSensors will appear as a grayscale image in the visible
spectrum.

Motive 2
To view a BTSensor’s video feed in the visible spectrum

In Motive, click the drop-down box at the right-hand side of the main toolbar and click Aiming from1.
the drop-down menu of layout presets.

Result: Motive opens the preset windows for the aiming of BTSensors.
In the Devices window, click the group name to select a single Camera, or select all Cameras in the2.
group.
With the Camera(s) selected, look below to the Properties section of the Devices window.3.
On the Camera Settings section, set the Filter Switch field to Visible Spectrum.4.
On the Camera Settings section, set the Video Type field to MJPEG Mode and select the range of5.
MJPEG Quality from the drop-down menu. The range of MJPEG Quality is between 1 (minimum) and
up to 4 (maximum).
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Result: The video displayed from the BTSensors will appear as a grayscale image in the visible
spectrum.
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BTSensor Aim Assist Feature
BTSensors have an Aim Assist button to help with aiming BTSensors. When you press the Aim Assist
button, the BTSensor video feed is selected and prominently displayed in Motive. The BTSensor video
feed changes to show the Space in the visible spectrum, and the exposure increases to brighten the
image. This helps aiming the BTSensors correctly. Pressing the Aim Assist button a second time will
return the BTSensor’s video feed to its previous settings.

To toggle aim assist on BTSensor

With the BTSensor connected to the BTSystem, and with Motive operating, press the Aim Assist button on
the BTSensor.

Result: In Motive, the BTSensor will be selected and its live video feed prominently displayed. The
BTSensor’s video feed will be toggled between its current settings and Aim Assist mode.

Aim Assist location
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Motive Project File
A BlackTrax project requires specific information (BTSensor, calibration and configuration) from Motive,
that is unique to every BlackTrax project. This information is required every time BlackTrax operates.

Motive 2.2
In Motive, recorded motion capture data is stored as a Take (.tak) file format, all application-related
configurations are saved onto Motive Profile (.motive) files, and calibration data for each BTSensor
position, orientation and lens parameters are saved as standalone calibration CAL (.cal) file format.

Profile and calibration data are automatically saved into a persistent settings folder and automatically
reloaded when Motive is opened again.

Profile data is automatically saved every ten minutes and calibration data is automatically saved
whenever calibration is updated (such as in Continuous Calibration).

Multiple Take (.tak) files are automatically saved in a Session Folder which can be accessed from the
Data window.

To load a Profile

In Motive, from the File menu, choose Open.1.
Result: The Open dialog box appears.

In the Open dialog box, navigate to where the desired (.motive) file was saved and click on the file2.
to select it.
Click Open.3.

Result: The (.motive) file will load all application-related configuration settings into Motive.

To save an existing Take file using the same location and file name

In Motive, from the File menu, choose Save Current Take.1.
Result: The currently active recording will be saved. A wanding recording will be saved if the
wanding is most recent and currently selected.
Notes:

Calibration will save the Take file of the wanding and a short recording of the ground
plane.
Choose Export Camera Calibration from the File menu to save the calibration data.
See BTSensor Calibration Settings section for more information.

To save a Take to a new location and/or using a new file name

In Motive, from the File menu, choose Save Current Take As.1.
Result: The Save Current Take As dialog box appears.

In the File Name field, type the name of the Take file.2.
Click Save.3.

Result: The renamed Take file (.tak) will be saved in the selected location.

To save an existing Motive Profile using the same location and file name

In Motive, from the File menu, choose Update Default Profile.1.

To save a Profile to a new location and/or using a new file

In Motive, from the File menu, choose Export Profile As.1.
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Result: The Export Profile dialog box appears.
In the File Name field, type the name of the Motive Profile file.2.
Click Save.3.

Result: The renamed Motive Profile file (.motive) will be saved in the selected location.

To save a calibration file

In Motive, from the File menu, choose Export Camera Calibration.1.
Result: The Export Camera Calibration dialog box appears.

Navigate to the location where the calibration file will be saved.2.
In the File Name field, type the name of the calibration (.cal) file.3.
Click the Export button.4.

Result: The calibration results are preserved as a calibration (.cal) file which can be loaded
into Motive.

Motive 2
In Motive, recorded motion capture data is stored as a Take (.tak) file format, all application-related
configurations are saved onto Profile XML (.xml) files, and calibration data for each BTSensor position,
orientation and lens parameters are saved as standalone calibration CAL (.cal) file format.

In Motive, profile and calibration data are automatically saved into the ProgramData folder and
automatically reloaded when Motive is opened again.

In Motive, profile data is automatically saved once every five minutes and calibration data is
automatically saved whenever calibration is updated (such as in Continuous Calibration).

Multiple Take (.tak) files are automatically saved in a Session Folder which can be accessed from the
Data window.

To save a Take to a new location and/or using a new file name

In Motive, from the File menu, choose Save Current Take As.1.
Result: The Save Current Take As dialog box appears.

In the File Name field, type the name of the Take file.2.
Click Save.3.

Result: The renamed Take file will be saved in the selected location.

To save an existing Take file using the same location and file name

In Motive, from the File menu, choose Save Current Take.1.
Result: Only the recording of the wanding is saved after calibration.
Notes:

Save current take is automatically applied after ground plane calibration.
Use Export Camera Calibration from the File menu to save the calibration data.
See BTSensor Calibration Settings.

To save a Profile to a new location and/or using a new file name

In Motive, from the File menu, choose Save Profile As.1.
Result: The Save Profile dialog box appears.

In the File Name field, type the name of the Profile XML file.2.
Click Save.3.

Result: The renamed Profile XML file will be saved in the selected location.
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To save an existing Profile using the same location and file name

In Motive, from the File menu, choose Save Profile.

To load a Profile

In Motive, from the File menu, choose Load Profile.1.
Result: The Load Profile dialog box appears.

In the Load Profile dialog box, navigate to where the desired .xml file was saved and click on the2.
file to select it.
Click Open.3.

Result: The .xml file will load all application-related configuration settings into Motive.
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BTSensor Calibration
Table of contents:

BTSensor Calibration Settings
Masking Infrared Interference for Calibration
Calibrating a BTSensor
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BTSensor Calibration Settings
After BTSensors are placed and orientated with overlapping views around the Space, BlackTrax requires
that all BTSensors be calibrated. Calibration enables BlackTrax to know BTSensor positions relative to
each other and the floor. This spatial awareness of the Space is required for tracking to be accurate.
Before BTSensor calibration can occur, certain settings in Motive must be configured.

In Motive, calibration data for each BTSensor position, orientation, and lens parameters are saved as
standalone calibration CAL (.cal) file format which can be exported to a desired location for later use. See
the corresponding To export a calibration CAL file section below.

Motive can be set for Continuous Calibration where the system continuously monitors BTSensor
movements and readjusts the BTSensor calibration accordingly. See the corresponding To configure
Motive for continuous calibration section below.

Motive 2.2
To configure BTSensors for calibration

In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Calibration from the drop-down menu of layout presets.

Go to the Devices window.2.
Note: To quickly configure a BTSensor for calibration, change the preset setting of the
BTSensor to Tracking then proceed to Step 7 in this section.

On the Devices window, click the group name to select the camera group.                                        3.

                                      

With the camera group selected in the Devices window, go to the Properties window.                     4.

 

In the General Settings section of the Properties window, set Video Mode to Object for tracking and5.
calibration.
Turn the IR Filter toggle On.6.
Go to the Application Settings window and click the Live Reconstruction tab.7.
On the Live Reconstruction tab, click the Marker Labeling Mode drop-down box and select Active8.
and Passive Markers or Passive Markers Only to set for calibration.                                               
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Note: Select Active Markers Only or Active and Passive Markers to set for tracking.

To configure Motive for continuous calibration

BTSensors must have already been calibrated if Continuous Calibration will be used.

In Calibration preset layout, go to the Application Settings window.1.
On the Application Settings window, click the Live Reconstruction tab.2.
On the Live Reconstruction tab, click the Continuous Calibration drop-down box and select3.
Continuous.

Result: Motive monitors and updates the BTSensor calibration continuously. The system
uses the motion of Beacons onstage to update any slight changes needed for the BTSensor
calibration without the need for manual refinements.
Notes:

If you use this feature, select the Continuous option. The Continuous+Bumped Camera
option can be used in controlled situations. As this option is more aggressive, it should
not be used during show conditions, and only when you have the time to perform a
manual calibration if needed.
You can use the Status Log window to see if the system has updated the BTSensor
calibration. Click View > Staus Log Pane to open.

To export a calibration CAL file

In the Calibration preset layout, click the File menu and choose Export Camera Calibration.1.
Result: The Export Camera Calibration window appears.

Navigate to the location where the calibration file will be saved.2.
In the File name field, type the name of the calibration (.cal) file.3.
Click the Export button.4.

Result: The calibration results are preserved as a ".cal" file which can be loaded into Motive.

To open and restore a calibration CAL file

In Motive, from the File menu, choose Open.1.
Result: The Open window appears.

Navigate and select the calibration (.cal) file you wish to open and restore.2.
Click Open.3.

Result: The saved calibration data will be restored in Motive.

Motive 2
In Motive, calibration data for each BTSensor position, orientation and lens parameters are saved as
standalone calibration CAL (.cal) file format which can be exported to a desired location for later use.
See To export a calibration CAL file below.

Motive can be set for Continuous Calibration where the system continuously monitors BTSensor
movements and readjusts the BTSensor calibration accordingly. See  To configure Motive for continuous
calibration below.

To configure BTSensors for calibration

In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Calibration from the drop-down menu of layout presets.

Go to the Devices window.2.
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Note: To quickly configure a BTSensor for calibration, change the preset setting of the
BTSensor to Tracking then proceed to Step 7 in this section.

In the Devices window, select the camera group by clicking on the group name.                              3.

    

While the sensor group is still selected, click the Properties section for the sensor group.4.
Click the Camera Settings section and set the Video Type field to Object Mode for tracking and5.
calibration.
Set the Filter Switch field to  Infrared Spectrum.6.
Go to the Application Settings window and click the Live Reconstruction tab.7.
On the Live Reconstruction tab, click the Marker Labelling Mode drop-down box and select Active8.
and Passive Markers or Passive Markers Only to set for calibration.                                          

 

Note: Select Active Markers Only or Active and Passive Markers to set for tracking.    

To configure Motive for continuous calibration

BTSensors must have already been calibrated if Continuous Calibration will be used.

In the Calibration preset layout, go to the Application Settings window.1.
On the Application Settings window, click the Live Reconstruction tab.2.
On the Live Reconstruction tab, click Continuous Calibration.3.
On the Continuous Calibration drop-down menu, select Continuous.4.

Result: Motive monitors and updates the BTSensor calibration continuously. The system
uses the motion of Beacons on stage to update any slight changes needed for the BTSensor
calibration without the need for manual refine. 

Notes:

If you use this feature, select the Continuous option. The Continuous+Bumped option can be used
in controlled situations. As this option is more agressive, it should not be used during show
conditions, and only when the user would have time to perform a manual calibration if needed.
You can use the Status Log window to see if the system has updated the BTSensor calibration. Click
View > Status Log Pane to open.
If the calibration has been updated, you can use Export Camera Calibration to export the current
BTSensor calibration. (see the following section below)

To export a calibration CAL file

In the Calibration preset layout, click the File menu.1.
From the File menu, choose Export Camera Calibration.2.

Result: The Export Camera Calibration window appears.
Navigate to the location where the calibration file will be saved.3.
In the File name field, type the name of the calibration .cal file.4.
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Click the Export button.5.
Result: The calibration results are preserved as a .cal file which can be loaded into Motive.

To open and restore a calibration CAL file

In Motive, from the File menu, choose Open.1.
Result: The Open window appears.

Navigate and select the .cal file you wish to open and restore.2.
Click Open.3.

Result: The saved calibration data will be restored in Motive.
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Masking Infrared Interference for
Calibration
Masking is a function in Motive where an area of the BTSensor’s vision is masked (blocked from view).
This tells the system to ignore the masked section when looking for infrared sources. This is used
primarily to mask outside infrared interference that can confuse the system during BTSensor calibration.

Excessive masking may limit a BTSensor field of view, as a masked area makes a BTSensor blind to
tracking in that area. You can reposition BTSensors to improve fields of view, rather than masking in
extreme cases of infrared interference.

Attention: Calibration will be successful if you mask infrared interference before calibration. Masking
differs if Motive is configured for active or passive markers.

To automatically mask all visible infrared sources from all BTSensors

Attention: Automatic masking will remove all previous masks from the BTSensor.

In Motive, go to the Camera Preview window.1.
On the Camera Preview toolbar, click the Mask Visible Markers button.2.

 The Mask Visible Markers button.
Result: All currently visible infrared sources are masked. Any previously created masks are
removed. If additional sections need to be masked, use manual masking techniques.

To clear all masks from all BTSensors

In Motive, go to the Camera Preview window.1.
On the Camera Preview toolbar, click the Clear Masking button.2.

  The Clear Masking button.
Result: All masking are cleared from all BTSensors.

To manually mask a BTSensor view

In Motive, go to the Camera Preview window.1.
Result: What each connected BTSensor sees is displayed as a 2D image in the Camera View
window. If BTSensors are configured to see infrared sources, they appear as white objects. 

   Camera View window with infrared interference.

On the Camera Preview toolbar, select the shape of the mask, either Draw Rectangular Mask or2.
Draw Circular Mask from the toolbar.

 The Draw Rectangular Mask button.
Result: You will create masks in the selected shape.

   Camera View window with rectangular mask.

To mask the infrared interference areas inside the Camera View window of a BTSensor, click on one3.
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corner of the interference while holding the left mouse button down and drag the mask to cover
the infrared interference.

Result: The infrared object (white object) is covered by a mask (red object). The infrared
source will not interfere with tracking when masked.

    Camera View window with partial IR masking.

Repeat the above steps for each instance of infrared interference.4.

   Camera View window with full IR masking.

To toggle additive or subtractive masking

The Toggle Additive/Subtractive Masking button makes all the draw masking buttons remove the
masking instead. For example, if you click the Toggle Additive/Subtractive Masking button to subtractive
and then draw a rectangle, the individual masking where the rectangle was drawn will be removed.

In Motive, go to the Camera Preview window.1.
On the Camera Preview toolbar, click the Toggle Additive/Subtractive Masking button.2.

 The Toggle Additive/Subtractive Masking button.
Result: Toggle subtractive makes all draw masking buttons remove the masking when
applied. Toggle additive makes all draw masking buttons add the masking when applied.

Draw the mask.3.
Result: The mask is removed if toggle subtractive is selected. The mask is added if toggle
additive is selected.
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Calibrating a BTSensor
BTSensor Calibration Introduction
If BTSensors that were initially placed in the Space were moved after setup or bumped accidentally, the
BTSensors must be calibrated. BTSensor calibration enables the system to determine where the
BTSensors are in relation to each other using the calibration wand, and where they are in relation to the
origin using the ground plane.

Proper calibration is very important because incorrect calibrations will send incorrect position data and
erroneously affect the BTSystem's accuracy.

Attention: Anytime a BTSensor is moved or bumped, BTSensor calibration must be performed and
saved to the Motive project file. See Working with Recordings for details saving and playing back Motive
recordings.

Differences Between Full Calibration and
Refine Calibration
There are three ways to calibrate BTSensors: a Full calibration, a Refine calibration, and a Partial Refine
calibration.

Full: This method calibrate BTSensors using no previous information. This calibration is always
used when using BlackTrax in a new Space.
Refine: This calibration method uses existing information from a previously saved calibration as a
starting point of the calibration. This calibration method is primarily used when BTSensors are
moved slightly after an initial calibration and needs calibration again.
Partial: This calibration method uses existing information from a previously saved calibration as a
foundation. The user selects either a Full or a Refine calibration type as above, and is able to
select a number of BTSensors to perform the partial calibration upon. BTSensor calibration builds
upon the previous calibration and corrects any errors. This calibration method is primarily used
when some BTSensors are moved slightly after an initial calibration and need correction, but not
the entire BTSensor rig.

Wand Calibration
Wand calibration enables BlackTrax to determine the relative position of BTSensors to each other in
the Space. This is followed by ground plane calibration, which enables BlackTrax to determine the
BTSensor’s relative position to the ground. See Ground Plane calibration below for more information.

Note: When wanding starts, Motive records the wanding and autosaves it to the session folder.

To calibrate BTSensors with the calibration wand

In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.1.
Go to the Camera Calibration window.1.
Choose either a Full or Refine calibration based on the guidelines above.2.
In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading to3.
Custom.
Set the Wand Length (mm) field to 1000.4.
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Set the Center Distance (mm) field to 350.5.
Click Start Wanding.2.

Result: BTSensors record calibration wand data within the Space. The Calibration Engine
section records the samples of each BTSensor and the spread of the samples.

In the Physical Space, plug the power source into the calibration wand, and connect the1.
HPSU.

Result: The calibration wand’s LEDs should be visible in Motive as an infrared
source.

Wand the Physical Space by moving the powered calibration wand across the Space.2.
Move the wand up and down, back and forth, and rotate the head while you move, to
create different data points (think of a figure eight motion). Ensure the calibration wand
LEDs are not covered or being blocked from BTSensor view.

Tip:
When in use, the front facing LED on the Slim 13E BTSensor turns blue to
indicate that the wand is visible.
You must fill as much of a BTSensor's view with as much wanding data as
possible to improve calibration accuracy.

In Motive, look at the Camera Preview and Perspective View window. Perspective View shows all3.
BTSensors on the ground when they do the very first wanding. Examine each BTSensor’s recording
of the calibration wand. Wand samples are represented as colored lines. Each BTSensor is
represented by a unique color. Each BTSensor should have the same number of samples recorded.

Attention:
If a BTSensor will not record samples while wanding, consult the Camera Preview
window. See if other BTSensors are detecting the wand. If the wand does not appear on
any other BTSensors, the area will not calibrate due to lack of coverage. If the wand
shows up on at least two other BTSensors, continue wanding, but adjust the path and
angle of the wand to give the BTSensors different views. If a section of the intended
Space will not record samples after all of the steps above, cancel the calibration.
Reposition the BTSensors to obtain better overlapping field of views of the tracking
area.
If a BTSensor will not record samples while wanding, you may deselect the problem
BTSensor in the Devices window and recalibrate with the remaining BTSensors. The
area of the Space the problem BTSensor was covering may have less accurate tracking
or even no tracking available, but the rest of the Space should be accurate.

Note: The Calibration Engine section gives feedback about the BTSensor calibration,
including the number of times the calibration wand is viewed by each BTSensor. An estimate
on the quality of the calibration is displayed based on the number of samples which were
recorded. Calibration quality can be: Low, Medium, High, or Very High.

Click Calculate.4.
Result: Motive starts to calibrate BTSensors based on the collected data. The current state of
calibration is displayed at the top of the Calibration Engine followed by the calibration result
rating and the overall quality.
Note:

The calibration data captured in Perspective View is colored to indicate data accuracy.
Blue: Less than 6mm accurate in that area.
Red: Greater than 88mm accurate in that area.

The calibration engine displays a quality rating for all BTSensors as well as the global
average and the wand average based on the Desired Quality. The quality ratings are (in
order from worst to best): Poor < Fair < Good < Great < Excellent < Exceptional.
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A full bar in the quality column is the best ranking.
A relatively high Error for a BTSensor indicates that the given BTSensor received poor
samples during calibration. Restart the wand calibration process. At least two
BTSensors must have vision of the calibration wand for data to be captured for
calibration. There is a progress bar in the Results column to highlight the quality of
each BTSensor.
While calibrating, BTSensors initially attempt to calibrate for the lowest level of quality.
Once BTSensors have met the criteria of that quality level, the system will advance to
the next level quality and attempt to calibrate. This process repeats until the highest
quality calibration based off the data has been achieved. Once exceptional quality had
been achieved, the system will apply the calibration automatically. 
In the Perspective View window you can see a visualization of the wand sample
collected for calibration. The position of BTSensors will move to match their position in
the physical Space as the system determines their location.

Once the rating for each BTSensor reaches “Excellent” or greater, and the Overall Results quality5.
rating reaches “Excellent” or greater, the calibration results will automatically be applied to the
system.
To apply the calibration manually

In the Calibration Engine section click Apply Results.1.
Result: The Calibration Results Reports window will open. Calibration results are
available

In the Calibration Results Reports window click Apply.2.
Result: The calibration data will be applied to the BTSensors and they will know their
position in the Space in relation to each other. BTSensors positions can be viewed in
the Perspective View window in Motive. Ground plane calibration is required next to
determine the BTSensor’s position relative to the origin (if using a Refine calibration,
you may skip ground plane calibration).

In Motive 2, click the File menu and select Save Current Take or click File menu and select Save6.
Profile. In Motive 1.10 or lower , to save the changes to the project file, click the File menu and
select Save Project.

 

Partial BTSensor Calibrations
As mentioned above, it is possible for the user to calibrate sections of their BTSensor setup after the
initial calibration, as opposed to having to recalibrate the entire BTSensor setup (as of Motive 1.10).

The partial BTSensor calibrations are based off either a Full or Refine calibration as you would do above.
To be able to complete a partial calibration, Motive needs the calibrated BTSensors as reference. These
are known as Anchor Cameras. You need at least 2 of these anchor BTSensors, in addition to the
BTSensors you wish to calibrate in order to complete the calibration successfully. 

To complete a partial BTSensor calibration

In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.1.
Go to the Camera Calibration window.1.
Choose either a Full or Refine calibration based on the guidelines above.2.
In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading3.
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to Custom.
Set the Wand Length (mm) field to 1000.4.
Set the Center Distance (mm) field to 350.5.

Select the BTSensors you would like to calibrate from the list in the Devices window.2.
Calibrate the system as you would above, confirming you would like to only calibrate the selected3.
BTSensors.
Once complete, you do not need to set the ground plane.4.

Note: You will see all BTSensors collecting data. Only the selected BTSensors will use this data to
calibrate, and all other BTSensors will ignore this data. When calculating, Motive may return a poor result
overall, but this is not indicative of the actual result of just the updated BTSensors, it is reporting as if
you wanded the entire Space. It is important to verify the tracking data with a Beacon after a partial
calibration has been completed to verify the calibration results. 

Known Wand Calibration Issues
Issue: When Calibration Engine is calculating, calibration might return a very high error (100+), a
very poor rating for the BTSensors, and you may see the distortion map in the Camera View warp
outside the camera square.
Solution: Either the wand data you provided Motive does not match the real world wand (check
the wand length and center distance from above) or Motive displays unsuccessful results. Reboot
Motive and run the calibration recording again through the solver and if the wanding data itself is
good, this normally fixes the issue.
Issue: After calibrating multiple times the Calibration Engine will not give a Global “Excellent”
rating.
Solution: The data samples taken from wanding may be of poor quality and could be an issue.
Ensure the Space is properly masked from infrared interference, and BTSensors are aimed
correctly. Start calibration again and rewand the Space.

Note: Not all the BTSensors will always receive an 'Excellent' or greater rating. Acceptable tracking can
still be achieved with what appears to be poor results. The calibration report will let you know how
accurate each BTSensor is relative to each other. If one BTSensor is poor, it might be okay if there are
several other BTSensors seeing that same area.

Tip: The best way to verify calibration is to lay out the ground plane and ensure that each point is only
shown as 1 marker (not two or more points or the points are moving when the ground plane is sitting on
the ground and not moving).

Ground Plane Calibration
After the BTSensors are calibrated with the calibration wand, you must set the ground plane. This step
will inform the BTSystem where they are in relation to the origin. It will also inform the BTSystem the
direction of the axis.

Attention: The origin of the Space must be visible to a minimum of 2 correctly calibrated BTSensors for
ground plane calibration to be accurate. 

Note: As of Motive 1.10, when performing Refine, Full Refine, or Partial Refine calibration types, the
user does not have to reset the ground plane. 

To calibrate BTSensors with the ground plane

In the Physical Space, unfold and lock the ground plane into an L shape, ensuring the arms are at a1.
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90° angle.
Plug in the power source to an outlet and connect the ground plane to a power source or battery2.
pack.
Move the center marker or the ground plane over the Origin of the Space. Adjust the feet of the3.
ground plane to align it with the origin as defined in BTWYSIWYG. You can see if the ground plane is
level with the built-in level on the ground plane arms.

Attention: The origin of the coordinate plane of the tracking area must be the same as the
origin of the virtual representation of the tracking Space as made in BTWYSIWYG. If the
virtual representation and actual tracking area do not share the same origin and axes
orientation, positional data and fixture tracking will be incorrect. The origin also needs to
match any Third Parties origin connected to BlackTrax.
Tip: Mark the origin of the Space and the orientation of the axes be marked for future
reference.

Aim the long arm of the ground plane to the venue +Y axis.4.
Aim the short arm of the ground plane to the venue +X axis.5.
In Motive, in the Camera Calibration window, in the Ground Plane tab, set the Vertical Offset (mm)6.
field to 90mm.

Attention:
If the ground plane is not placed at the height of the Origin, such as on a tripod or
stage, measure the distance between the X-Y plane and the center of the ground plane
markers. Enter in this value in the Vertical Offset (mm) plus 90mm.
You can offset the ground plane position if the ground plane cannot be placed on the
origin due to space restrictions, such as obstructions blocking the Origin from BTSensor
view.
To offset the ground plane

Measure the distance (mm) on each axis from the Origin to the  ground plane's1.
position.
Record the difference in the Capture Volume Translation table.2.
Click Apply Translation.3.

Note: Each time you Apply Translation, the origin will offset by 1 by each
unit you specified. You should clear the offsets back to 0 after making them
in case the button is hit accidentally after you finish setting it.
Attention: It is possible to rotate the ground plane’s position in Motive
without physically moving the ground plane

To rotate the ground plane
Click Apply Rotation.
Enter in the desired rotation values in the Capture Volume Rotation table.

To apply the ground plane calibration, click Set Ground Plane.7.
Result: The BTSensors will know their position in relation to the ground and adjust
accordingly in Camera View window in Motive.
Attention: If Motive is having a hard time determining the ground plane, or the markers are
not stable, you may try to increase the Maximum Residual in Application Settings > Live
Reconstruction. This will help average out BTSensors that may not have a great calibration
and provide stable tracking points for the Ground Plane.

In Motive 2, from the File menu, choose Save Current Take or from the File menu, choose Save8.
Profile. In Motive 1.10 or lower, to save the changes to the project file, from the File menu, choose
Save Project.

Note: The axis in Motive is different than the axis in BlackTrax. Please keep that in mind
when offsetting the ground plane in Motive. For reference:
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BlackTrax +X = Motive -X
BlackTrax +Y = Motive +Z
BlackTrax +Z = Motive +Y
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Tracking Mode
Table of contents:

Tracking Mode Settings
Customizing Tracking Bounds
Optional View Settings
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Tracking Mode Settings
After BTSensors are calibrated, minor adjustments need to be entered in Motive for the system to switch
from BTSensor calibration mode to tracking mode. These settings enable fixture tracking to occur. Once
tracking mode is configured, no changes to the Motive project are needed unless BTSensors were moved
or bumped since BTSensor calibration. 

Motive 2.2
To configure BTSensors for normal tracking

In Motive, change the layout to Configuration preset. From the Layout menu, choose1.
Configuration.

Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Configuration from the drop-down menu of layout presets.

On the Application Settings window, click the Cameras tab.2.
On the Cameras window, select None from the Filter Type drop-down menu.3.
On the Application Settings window, click the Live Reconstruction tab.4.
Under the Reconstruction Settings section, click Marker Labeling Mode > Active and Passive5.
Markers or Active Markers Only to set Motive for tracking.

Result: Active and passive markers or only active markers are displayed on the Perspective
View window.
Note: After the calibration is completed, Motive will set the Maximum Residual as low as
possible which is not forgiving enough in most situations. We recommend you increase the
Maximum Residual to at least 15 mm after calibration. Keep in mind the Active Residual in
the Status Bar and ensure this value is as low as possible. If the value is too high for
acceptable use (greater than 5 mm in most cases and 10 mm in extreme cases), you should
consider re-calibrating your space.

On the Devices window, select eSync.6.
On the Properites window, click the Source drop-down menu and click Reserved.7.
On the Sync Offset field, type 5000.8.

Note: In the Streaming and Properties panes, you can verify the correct settings for normal tracking.

In the Streaming pane, the Broadcast Frame Data toggle is set to On and the Local Interface field is
set to loopback.
In the Properties pane, Input Divider and Input Multiplier are set to 1.

Motive 2
To configure BTSensors for normal tracking

In Motive, change the layout to Configuration preset. From the Layout menu, choose1.
Configuration.

Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Configuration from the drop-down menu of layout presets.

On Devices window, click Filters under the Properties section.2.
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On the Filters section, click the Filters Type drop-down menu and click None.3.
On the Application Settings window, click the Live Reconstruction tab.4.
On the Live Reconstruction tab, select the Enable Point Cloud Reconstruction checkbox.5.
In the Reconstruction Settings section, click Marker Labeling Mode and then click Active and6.
Passive Markers or Active Markers Only to set Motive for tracking.

Result: Active and passive markers or only active markers are displayed on the Perspective
View window.
Note: After Calibration, Motive will set the Maximum Residual as low as possible but in most
situations this is not forgiving enough. We recommend you increase the Maximum
Residual to at least 15 mm after calibration. You may also increase it higher if calibration is
poor or the BTSensors have moved since calibration. Keep in mind the Active Residual in the
Status Bar, and ensure that value is as low as possible. If the value is too high for acceptable
use (greater than 5 mm in most cases and 10 mm in extreme cases), you should consider re-
calibrating your space.

On the Streaming window, under the OptiTrack Streaming Engine heading, select the Broadcast7.
Frame Data checkbox.

Under the Network Interface Selection heading, set the Local Interface field to Local loopback.
Close the Data Streaming window.

On the Synchronization window, click the Synchronization drop-down box and then click Custom8.
Synchronization.
Under the Sync Input heading in the Details section, click the Source drop-down menu and then9.
click Reserved.
Under the Sync Input heading in the Details section, type 5000 on the Sync Offset (us) field.10.
In the Synchronization section, click Apply.11.

Note: The Input Monitor section can be used to immediately check if the TimeKeeper is connected
correctly to the eSync and Motive. In the Reserved field of the Input Monitor section, there should be a
value of around 100 Hz (or close to this number). This means Motive is receiving the TimeKeeper sync
signal. If this number is not in the range of 99.998 - 100.004 Hz (or close) there may be a configuration
issue with the TimeKeeper, and you should report the issue to a BTE to be resolved.

 

Note: If you experience Tracking issues after configuring these settings, reset Motive Settings from the
BlackTrax GUI. If your issue is not resolved, please contact BlackTrax support for further assistance. 
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Customizing Tracking Bounds
Motive can have restrictions placed to customize tracking. Infrared sources, such as a LED Stringer of a
BTBeacon, that are outside these restrictions will not be acknowledged by the system.

Limiting Tracking Within Boundaries in Motive 2.2
In Motive, as an optional step, you can create a boundary around the Space. The boundary commands
the system to ignore infrared sources outside this boundary. BTBeacon positional data found outside the
boundary will not be sent downstream to other applications.

To define boundaries, you need to specify where the bounding box will be centered and measure how far
the origin of the Space is from the intended boundaries in the Space. This is required for each axes (XYZ).
The origin of the Space should be the same origin as the duplicate Space made in BTWYSIWYG.

Attention: In Motive, the Z axis represents length and the Y axis represents height. For the rest of
BlackTrax the Z axis represents height and the Y axis represents length. +X also becomes -X in Motive.

Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking occurs
below the origin, ensure the value can cover the intended tracking area.

To set the tracking boundary of the space

In Motive, change the layout to Running preset. From the Layout menu, choose Running.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Running from the drop-down menu of layout presets.

On the Application Settings window, click the Live Reconstruction tab.2.
On the Live Reconstruction tab, click the Advanced Options heading to open the section.3.
In the Advanced Options section, click the Reconstruction Bounds heading to open the section.4.
Click the Visible Bounds drop-down menu and select True.5.

Result: The set tracking boundary of the Space is displayed in the Perspective View window.
The set tracking boundary of the Space will not be displayed in the Perspective View window
if False is selected.

Click the Bounds Shape drop-down menu and select the shape of the reconstruction bound.6.
Result: The corresponding size and location parameters for the selected shape appear.

Enter the values (meters) in each of the corresponding parameter fields (below) to specify the size7.
and location of the reconstruction bound.

Cuboid (default): X Center, Y Center, Z Center, X Width, Y Width, Z Width
Cylinder: X Center, Y Center, Z Center, Radius Height
Spherical: X Center, Y Center, Z Center, Radius
Ellipsoid: X Center, Y Center, Z Center, Z Width, Y Width, Z Width

Result: The boundary in your Space is defined. Tracking is only possible inside this
boundary.

Click the Bound Reconstruction drop-down menu and select True.8.
Result: The boundary for tracking is enabled.

To set BlackTrax BTSensor beam length

Attention: The maximum distance should be the longest distance between a BTSensor and the furthest
tracking boundary. The minimum distance should be the shortest distance between a BTSensor and the
nearest tracking boundary.

Note: After BTSensor calibration, Motive automatically determines these values with estimates of
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acceptable tracking distances. You may override these values at any time, but if you re-calibrate, these
fields will be re-populated.

In Motive, change the layout to Running preset. From the Layout menu, choose Running.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Running from the drop-down menu of layout presets.

On the Application Settings window, click the Live Reconstruction tab.2.
On the Live Reconstruction tab, click Reconstruction Settings to open the section.3.
On the Maximum Ray Length field, enter the desired maximum length.4.
On the Minimum Ray Length field, enter the desired minimum length.5.

Result: The beam length of BTSensors will be set. BTSensors will only acknowledge
BTBeacons within this range.

Limiting Tracking Within Boundaries in Motive 2
In Motive, as an optional step, you can create a boundary around the Space. The boundary commands
the system to ignore infrared sources outside this boundary. BTBeacon positional data found outside the
boundary will not be sent downstream to other applications.

To define boundaries, you need to measure how far the origin of the Space is from the intended
boundary in the Space. This is required for each axes (XYZ). The origin of the Space should be the same
origin as the duplicate Space made in WYSIWYG.

Attention: In Motive, the Z axis represents length and the Y axis represents height. For the rest of
BlackTrax the Z axis represents height and the Y axis represents length. +X also becomes -X in Motive.

Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking occurs
below the origin, ensure the value can cover the intended tracking area.

To set the tracking boundary of the space

In Motive, change the layout to Running preset.  From the Layout menu, choose Running.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Running from the drop-down menu of layout presets.

On the Application Settings window, click the Live Reconstruction tab.2.
On the Live Reconstruction tab, click the Advanced Options heading to open the Advanced Options3.
section.
In the Advanced Options section, click the Reconstruction Bounds heading to open4.
the Reconstruction Bounds section.
In the Reconstruction Bounds section, click the Visible Bounds drop-down menu and select True. 5.

Result: The set tracking boundary of Space is displayed in the Perspective View window. The
set tracking boundary of the Space will not be displayed in the Perspective View window if
False is selected.

Set the Minimum X (meters) field to the distance from the origin of the Space to the intended6.
boundary on the negative (-) X axis (width).
Set the Maximum X (meters) field to the distance from the origin of the Space to the intended7.
boundary on the positive (+) X axis (width).
Set the Minimum Y (meters) field to the distance from the origin of the Space to the intended8.
boundary on the negative (-) Y axis (height).
Set the Maximum Y (meters) field to the distance from the origin of the Space to the intended9.
boundary on the positive (+) Y axis (height).
Set the Minimum Z (meters) field to the distance from the origin of the Space to the intended10.
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boundary on the negative (-) Z axis (length).
Set the Maximum Z (meters) field to the distance from the origin of the Space to the intended11.
boundary on the positive (+) Z axis (length).
Close the Reconstruction Properties window.12.

Result: The boundary in your Space is defined. Tracking is only possible inside this
boundary.

To save as a profile, select Save Profile or Save Profile As from the File menu.13.
Tip: You can also export the BTSensor calibration data.  See BTSensor Calibration Settings.

To set BlackTrax BTSensor beam length

Attention: The Maximum distance should be the largest distance between a BTSensor and the furthest
tracking boundary. The minimum distance should be the shortest distance between a BTSensor and the
closest tracking boundary.

Note: After BTSensor calibration, Motive automatically determines these values with estimates of
acceptable tracking distances. You may override these values at any time, but if you re-calibrate these
fields will be re-populated.

In Motive, change the layout to Running preset. From the Layout menu, choose Running.1.
Tip: You may click the drop-down box at the right hand side of the main toolbar and click
Running from the drop-down menu of layout presets.

In the Application Settings window, click the Live Reconstruction tab.2.
In the Reconstruction Settings section of the Live Reconstruction tab,  set the Maximum Ray Length3.
field to the desired maximum length.
In the Reconstruction Settings section of the Live Reconstruction tab, set the Minimum Ray Length4.
field to the desired minimum length.
To save as a profile, choose Save Profile or Save Profile As from the File menu.5.

Result: The beam length of BTSensors will be set. BTSensors will only acknowledge
BTBeacons within this range.
Tip: You can also export the BTSensor calibration data.  See BTSensor Calibration Settings.
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Optional View Settings
Because every Space is different, there are certain BTSensor settings that will be unique. This section 
provides guidelines on certain Motive settings which will create an accurate tracking environment.

Adding a Reticle to BTSensor Views in Motive 2
and 2.2
A reticle (cross-hair) can be added to all BTSensor views to aid in aiming and position.

Note: When you use the aim-assist feature on a BTSensor, the reticle is automatically toggled On for
that BTSensor.

To add a reticle to all BTSensor views

In Motive, change the layout to Aiming preset. From the Layout menu, choose Aiming.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Aiming from the drop-down menu of layout presets.

On the Application Settings window, click the Views tab.2.
On the Views tab, click the 2D Display Options heading to open the 2D Display Options section.3.
In the 2D Display Options section, click the Reticles drop-down menu and click True.4.

Result: Reticles are displayed on all connected BTSensor views in Motive.
Tip: When you are on the Multi-Camera 2D View, you may click the Visual Options icon and
select the Reticles menu to enable.
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Recording in Motive
Table of contents:

Introduction
Modes in Motive
Working with Recordings

Calibrating BTSensors from a Recording
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Recording Introduction
In Motive, you can save recordings of tracked objects and you can play back these recordings at another
time. You can record the wanding of the Space while calibrating BTSensors. The recorded wanding can
be played back anytime instead of physically repeating the wanding of the Space.
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Modes in Motive
In Motive, there are three modes of operation: LIVE, REC (Record) and EDIT. Modes act as a reminder of
where information shown in the Perspective View and Camera View window is originating from.

Motive 2.2
The Status Bar is always docked at the bottom of Motive, and it provides both recording and navigation
controls over Motive's primary operating modes.

 LIVE/REC mode

 EDIT mode

LIVE: Information shown in LIVE mode is happening in real-time. Everything shown is what
BTSensors see at the present time. When in LIVE mode, a solid blue icon is displayed in Perspective
View. 

Note: LIVE mode is the default mode of Motive.

 

REC: Information shown in REC mode is happening in real-time and being recorded to file for later
use. Everything shown is what BTSensors see at the present time. When in REC mode, a red icon is
displayed in Perspective View and a red border appears around the Perspective View and Camera
View windows.

 

EDIT: Information previously recorded is being played back. Everything shown is what BTSensors
saw during a recording in REC mode. When in EDIT mode, an outlined blue icon is displayed in
Perspective View.

 

Attention: When Motive is in EDIT mode, any recorded data played back will be passed through the
BTSystem instead of live data.

Motive 2
The Status Bar is always docked at the bottom of Motive, and it provides both recording and navigation
controls over Motive's primary operating modes.

 LIVE/REC mode

 EDIT mode

LIVE: Information shown in LIVE mode is happening in real-time. Everything shown is what
BTSensors see at the present time. When in LIVE mode, a green image is displayed in Perspective
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View.
Note: LIVE mode is the default mode of Motive.

 

REC: Information shown in REC mode is happening in real-time and being recorded to file for later
use. Everything shown is what BTSensors see at the present time. When in REC mode, a red image
is displayed in Perspective View and a red border appears around the Perspective View and Camera
View windows.

 

EDIT: Information previously recorded is being played back. Everything shown is what BTSensors
saw during a recording in REC mode. When in EDIT mode, a blue image is displayed in Perspective
View.

 

Attention: When Motive is in EDIT mode, no live data is sent through the BTSystem. Be sure that no
application downstream of BlackTrax is relying on tracking information while switching between LIVE and
EDIT modes.
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Working with Recordings
Motive 2 and 2.2
To record in Motive

In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.

On the Status Bar, type a name for the recording in the Take field.2.
To start recording, click the Record (red circle) button on the Status Bar.3.

Result: Motive enters REC mode. A red outline appears around the Perspective View and
Camera View windows. Any trackable object in the Space will be recorded to file.

To stop recording, click the Record (red circle) button again. 4.
Result: Motive exits REC mode. The recording will be saved as a ".tak" file.

 Recording in Motive 2.2

 Recording in Motive 2

To play back a recording in Motive

In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.

To open the previous recording that you want to use, double-click the ".tak" file from the list in the2.
Project pane.

Result: Motive enters EDIT mode and the Status Bar changes to the EDIT mode functions. A
timeline of the recording is displayed.
Note: Click any point in the timeline and the recording jumps to the selected point.

On the Status Bar, click the Play button (arrow icon) to play the recording in the Timeline window.3.
Result: The recording of what BTSensors saw is replayed on the system. The BTSystem acts
as if the recording is actually happening in real-time.

 Playing back in Motive 2.2

 Playing back in Motive 2
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Calibrating BTSensors from a Recording
Each time you calibrate the BTSensors in Motive, the software automatically starts the recording of the
wanding. You can use this recording to re-wand the space virtually, without the need of physically
wanding again. This can be used to try different calibration settings or in the event that wanding was
finished but calibration was not completed. 

Calibration from a recording will treat the system as it was during the recording. If BTSensors have
moved since the recording, the results will not be accurate to the real Space (regardless of the
calibration result).

Motive 2 and 2.2
To calibrate from a recording

In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.1.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.

To open the previous recording that you want to use, double-click the ".tak" file from the list in the2.
Data window.

Result: Motive enters EDIT mode, and the Status Bar changes to EDIT mode functions and
the timeline of the recording is displayed.

From the View menu, choose Camera Calibration Pane.3.
In the Camera Calibration window, ensure your wand settings match the previous wanding that was4.
applied. Choose to do a Full or Refine calibration type.

Note: If the source recording was a Full calibration type, you must select Full calibration type
again.

In the Camera Calibration window, click Start Wanding to begin the calibration process.5.
Result: Motive scans the recording for the selected samples. After a few seconds, Motive
returns the same samples, and you can calculate the result as with a normal calibration.

On the Status Bar, click LIVE to return the system to LIVE mode.6.
Set your ground plane as per normal.7.

Note: This step is only required if Full calibration type was selected.
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Using USB Sensors with BlackTrax
When you use USB Sensors in BlackTrax, the Motive settings differ from the PoE BTSensors, which
include settings in the Devices, Camera Calibration, and Synchronization windows.

For use with USB Sensors, the TimeKeeper must be configured to work with a USB System. The USB
Sensors cannot be used with a PoE System TimeKeeper if its settings are not modified. 

The TimeKeeper is connected to the Sync port of an OptiHub via RCA connection. The BTRouter and
Timekeeper must be connected to a gigabit PoE switch when using USB Sensors.

The TimeKeeper must be shipped configured for USB and you must contact Technical Support to swap
the TimeKeeper for USB from PoE Systems.

Supported USB Sensors include Flex 3 and Flex 13 USB Sensors.

Setting up USB sensors in the BlackTrax System
USB Sensors connect to the BlackTrax System using the USB A > USB B cable that is included.

To connect USB sensors to BlackTrax

Connect the USB Sensors to the OptiHub to connect to the BTServer.1.
Attention:

Do not exceed 5 m (16.4 ft) maximum distance between the USB Sensor and the
OptiHub.
Do not use USB extensions, couplers, or adapters between the OptiHub and the USB
Sensors.

Connect the TimeKeeper to the OptiHub to provide sync information to the USB Sensors. Connect2.
the TimeKeeper to the OptiHub through the Sync In port via RCA connection.
Connect the OptiHub to a BTServer.3.

You may use up to 2 x 5 m (16 ft) active USB extenders in addition to the original 5 m (16 ft)
USB cable.
The maximum distance from BTServer to OptiHub can increase to 15 m (49.21 ft) when you
use USB extenders. 
Important Notes:

Multiple OptiHubs can be linked via their RCA Synchronization ports to increase the
sensor count because each OptiHub supports only six (6) BTSensors.
The same USB cable limitations mentioned above apply when using multiple OptiHubs
with the BTSystem.
Every single OptiHub to BTServer connection requires its own dedicated USB cable
connection.

Preparing IR Sensors in Motive
To prepare the IR sensors

Open Motive.1.
Result: Motive recognizes the USB Sensors. Your BTSensors will populate the Devices list as
outlined in the Checking the Connectivity of BTSensors page.

To focus the BTSensors, refer to the Using Motive to Aim BTSensors page for focusing instructions.2.
Tip: During aiming, set the LED setting for the Group of Sensors to 15.
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Calibrating USB Sensors in Motive
To calibrate USB sensors

Follow the calibration steps outlined in the Calibrating a BTSensor page in the Motive for BlackTrax1.
section then apply changes to the following steps for USB settings.
On the Camera Calibration window, click Calibration Options.2.
Click the OptiWand drop-down menu under Calibration Options then click OptiWand-CW-500.3.
On the Properties window in Motive 2.2, set the IR Filter toggle On or on the Devices window in4.
Motive 2, set the LED slider value to where the wand can be clearly visible to the BTSensors.
Follow Steps 2 to 5 under the Wand Calibration section of the Calibrating a BTSensor page.5.
After completing the steps above, follow the steps in the Ground Plane Calibration page.6.

 Camera Calibration window

Result: The system is calibrated. Motive saves the current state and returns to the last calibration
and camera settings when reopened.

Tracking Mode Settings in Motive 2.2
To send information from Motive

In Motive, change the layout to Configuration preset. From the Layout menu, choose1.
Configuration.

Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Configuration from the drop-down menu of layout presets.
Results: Motive displays the Configuration layout preset showing the Devices, Application
Settings, Perspective View, Streaming, and Synchronization windows.

On the Devices window, select the group and set FPS to 100.2.
On the Application Settings window, click the Live Reconstruction tab.3.
Under the Reconstruction Settings section, click Marker Labeling Mode and then click Active and4.
Passive Markers or Active Markers Only to set Motive for tracking.

Result: Active and passive markers or only active markers are displayed on the Perspective
View window.
Note: After calibration, Motive sets the Maximum Residual to the lowest value possible,
which is not forgiving enough in most situations. We recommend you increase Maximum
Residual to at least 15 mm after calibration. You may also increase the value higher if
calibration is poor or the BTSensors have moved since calibration. Keep in mind the Active
Residual in the Status Bar and ensure that value is the lowest possible. If the value is too high
for acceptable use (greater than 5 mm in most cases and 10 mm in extreme cases), you
should consider re-calibrating you space.

On the Devices window, select eSync.5.
On the Properties pane, click the Source drop-down menu in the Sync Input Settings section and6.
then click OptiSync.
On the Sync Offset field, type 5000.7.

Note: In Streaming, Properties, and Application Settings windows, you can verify the correct settings for
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normal tracking.

Filters Type drop-down menu under the Filters section of the Cameras tab in the Application
Settings window is set to None.
Enable Point Cloud Reconstruction checkbox in the Live Reconstruction tab in the Application
Settings window is selected.
In the Streaming pane, the Broadcast Frame Data toggle is set to On and the Local Interface field is
set to loopback.
In the Properties pane, Input Divider and Input Multiplier are set to 1.

Tracking Mode Settings in Motive 2
To send information from Motive

In Motive, change the layout to Configuration preset. From the Layout menu, choose1.
Configuration.

Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Configuration from the drop-down menu of layout presets.
Results: Motive displays the Configuration layout preset showing the Devices, Application
Settings, Perspective View, Streaming, and Synchronization windows.

On the Devices window, click Filters under the Properties section.2.
On the Devices window, select the group and set FPS to 100.3.
On the Application Settings window, click the Live Reconstruction tab.4.
Click Marker Labeling Mode under the Reconstruction Settings section and then click Active and5.
Passive Markers or Active Markers Only to set Motive for tracking.

Result: Active and passive markers or only active markers are displayed on the Perspective
View window.
Note: After calibration, Motive sets the Maximum Residual to the lowest value possible,
which is not forgiving enough in most situations. We recommend you increase the Maximum
Residual to at least 15 mm after calibration. You may also increase it higher if calibration is
poor or the BTSensors have moved since calibration. Keep in mind the Active Residual in the
Status Bar and ensure that value is the lowest possible. If the value is too high for acceptable
use (greater than 5 mm in most cases and 10 mm in extreme cases), you should consider re-
calibrating your space.

On the Synchronization window, click the Synchronization drop-down menu and then click Custom6.
Synchronization.
On the Details section, click Sync Input.7.
Click the Source drop-down menu under Sync Input and then click OptiSync.8.
Click Synchronization Control and then type 5000 on the Sync Offset (us) field.9.
On the Synchronization section, click Apply.10.

Note: In Streaming, Properties, and Application Settings windows, you can verify the correct settings for
normal tracking.

Filters Type drop-down menu under the Filters section of the Cameras tab in the Application
Settings window is set to None.
Enable Point Cloud Reconstruction checkbox in the Live Reconstruction tab in the Application
Settings window is selected.
In the Streaming pane, the Broadcast Frame Data toggle is set to On and the Local Interface field is
set to loopback.
In the Properties pane, Input Divider and Input Multiplier are set to 1.
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BlackTrax
The system is now ready to work with the main BlackTrax software. For more information on outputs
from BlackTrax, please see the Output Configuration page.

Ensure that BTBeacons (and possibly Rigid Frames) have been added to the Beacons widget and all
changes were applied for the system to output data.
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Before Using BlackTrax
BlackTrax 2.5 is a 64-bit software installed by default at C:\Program Files\CAST Software\BlackTrax.
BlackTrax versions below 2.5 are 32-bit software installed by default at C:\Program Files (x86)\CAST
Software\BlackTrax.

BlackTrax WYSIWYG 64-bit is installed by default at C:\Program Files\CAST Software\BlackTrax WYSIWYG
and BlackTrax WYSIWYG 32-bit is installed by default at C:\Program Files (x86)\CAST Software\BlackTrax
WYSIWYG Version 2.

Basic requirements
To ensure that you can track and use the BlackTrax System, the following steps must be set beforehand.

Hang and focus BTSensors in the physical space. The BTSystem needs to be physically installed in1.
the Space. See BTSystem Hardware Configuration for more information.
Configure and calibrate BTSensors to inform the BTSystem on how to track and share positional2.
information with other components. See Calibrating a BTSensor for more information.
For lighting tracking, create a file in BTWYSIWYG with an origin and the corresponding lighting3.
fixtures. A ".wyg" file provides BlackTrax with information on Trackables, Fixtures and Space
dimensions. From a ".wyg" file, you can either generate a ".btx" file or send the necessary
information directly between programs. See Creating a .btx file in BTWYSIWYG for
more information.
A BTWYSIWYG template file comes with 12 Trackables premade. If you are not using a BTWYSIWYG4.
template, you need to create the Trackables. Ensure to patch your Trackables to a motion universe,
and the motion universe is assigned to a BlackTrax Device in BTWYSIWYG's Device Manager in
LIVE mode.
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UI Introduction
When BlackTrax launches for the first time, the BlackTrax Splash Screen appears while BlackTrax is
preparing to load, and then the Portfolio Manager window opens. In the Portfolio Manager window, you
can add a new portfolio which stores the BlackTrax, BTWYSIWYG and Project History backup files.

A project is launched from the Portfolio Manager and opens into Edit view. How the Portfolio Manager is
subsequently displayed at startup depends on the Open most recent Portfolio when BlackTrax starts
setting in the System section of System Configuration (enabled by default).

Before the Edit view and the other views of BlackTrax are explained, we will first define the options in
Portfolio Manager and describe the various parts of the user interface.

The Splash Screen upon launch of BlackTrax

The Portfolio Manager upon opening

The Default state of the BTGUI upon opening 

Attention: If a License issue is detected, the License Folder button appears on the Portfolio Manager.
Click the License Folder button to open the license Folder in the File Explorer window.
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Portfolio Manager
  Portfolio Manager at first launch

All project files are saved via the Portfolio Manager.
Upon installation of BlackTrax, the BlackTrax Portfolios folder is created to your default drive where
saved project files for BlackTrax, BTWYSIWYG, and Motive are automatically saved.
The Portfolio Manager displays the list of saved Portfolios.
The Portfolio Manager displays the name of the currently opened Portfolio.
Project History (.btbak) backup files are automatically generated when a project is saved manually
or in Auto Save. The backup files are saved in the Project History folder that is automatically
created in the BlackTrax Portfolios folder.
In the Portfolio Manager, you can:

Add a new Portfolio.
Duplicate a Portfolio.
Delete a Portfolio.
Sort the displayed list of Portfolios.
Import a file(s) into new Portfolios.
Update a file(s) in Portfolios.
Open a Portfolio folder.
Launch a Portfolio.
Close a Portfolio.

Note: All references to Motive folders, files, and steps will only apply if the Legacy Mode checkbox in the
Sensor section of the System Configuration widget is not selected. The Legacy Mode checkbox is
selected by default when BlackTrax opens for the first time. For more information on Legacy Mode, see
Sensors Section in System Configuration. Legacy Mode is only accessible in BlackTrax 2.5.0 and newer.

To add a portfolio

In Portfolio Manager, click the Add (+) button.1.
Result: The New Portfolio dialog box appears.

Type the name of the new Portfolio in the Portfolio Name box.2.
Result: 

The new Portfolio folder is added to the BlackTrax Portfolios folder and the name is
added to the list of Portfolios in Portfolio Manager.
The new BlackTrax project file (.btprj) and the Project History folder are created in the
BlackTrax folder in the new Portfolio.
A new BTWYG project file (.btwyg) is created in the BTWYG folder in the new Portfolio.
A new Motive profile (.motive), Calibration file (.cal), Recording folder, and Calibration
Archive folder are created in the Motive folder in the new Portfolio.

To duplicate a portfolio

In Portfolio Manager, select the Portfolio that you want to duplicate.1.
Click the Duplicate button.2.

Result: The Duplicate Portfolio dialog box appears.
Type the name of the duplicate Portfolio in the Portfolio Name box.3.

Result: 
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The duplicate Portfolio folder is added to the BlackTrax Portfolios folder and the name is
added to the list of Portfolios in Portfolio Manager.
BlackTrax, BTWYG, and Motive files are renamed and saved into the new Portfolio.

Note: Project History is not duplicated.

To delete a portfolio

Note: A Portfolio that is currently in use cannot be deleted.

Close BTWYSIWYG. Portfolio Manager will not delete the files if BTWYSIWYG is open.1.
From the list of Portfolios displayed in Portfolio Manager, click on the Portfolio that you want to2.
delete.

Result: The selected Portfolio is highlighted.
Click the Delete button.3.

Result: The selected Portfolio folder and all the BlackTrax, BTWYG, and Motive files in the
folder are deleted from the BlackTrax Portfolios folder.

To sort the displayed portfolios by name

In Portfolio Manager, click on the drop-down arrow and choose the Sort: Name drop-down menu.1.
Result: The list of Portfolios will be displayed in alphabetical order.

To sort the displayed portfolios by date

In Portfolio Manager, click on the drop-down arrow and choose the Sort: Date drop-down menu.1.
Result: The list of Portfolios will be displayed with the most recent Portfolio on top and the
oldest Portfolio at the bottom.

To import a file(s) from a portfolio

BlackTrax, BTWYG project files, and Motive calibration files can be imported into new Portfolios. When
importing files, the user does not need to import all file types. If no file is imported for a given section,
the template file will be used for that portion of the Portfolio.

In Portfolio Manager, click the Import File(s) button.1.
Result: The Import File(s) dialog box appears.                                                           

 

Type the new name of the Portfolio in the Portfolio Name box.2.
Select the BlackTrax Project checkbox to include the BlackTrax files that will be imported and3.
added to the new Portfolio.
Click on the ellipsis button to browse and select the BlackTrax file.4.

Result: The link appears in the BlackTrax Project box.
Select the BTWYG Project checkbox to include the BTWYG files that will be imported and added to5.
the new Portfolio.
Click on the ellipsis button to browse and select the BTWYG file.6.

Result: The link appears in the BTWYG Project box.
Note: The unchecked portions of the Portfolio will default to a new, empty file.

Select the Motive Calibration checkbox to include the Motive Calibration file that will be imported7.
and added to the new Portfolio.
Click on the ellipsis button to browse and select the Motive calibration file.8.

Result: The link appears in the Motive Calibration box.
Click Create Portfolio.9.
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Result: 
BlackTrax and BTWYG projects that were imported into the new Portfolio open.
BlackTrax project, BTWYG project, and Motive calibration files are renamed and copied
to the BlackTrax Portfolios folder.

To update a file(s) in a portfolio 

BlackTrax, BTWYG project files, and Motive calibration files of a Portfolio can be updated or replaced with
the Update File(s) button. Updated files will be placed in the appropriate folders under the correct name
for the selected Porfolio. You can browse for new BlackTrax, BTWYG, and Motive files which will replace
the current files in the Portfolio.

Note: BTWYG must be closed to replace a BTWYG file.

In Portfolio Manager, select the Portfolio that you want to update.1.
In Portfolio Manager, click the Update File(s) button.2.

Result: The Update File(s) dialog box appears.                                                                 

 

On the Update File(s) dialog box, select the BlackTrax Project checkbox to enable access and3.
browse the BlackTrax files in Portfolios.
Click on the ellipsis button to browse and select the new BlackTrax file that will replace the current4.
file in the current Portfolio.

Result: The link appears in the BlackTrax Project box.
Select the BTWYG Project checkbox to enable access and browse the BTWYG files in Portfolios.5.
Click on the ellipsis button to browse and select the new BTWYG file that will replace the current6.
file in the current Portfolio.

Result: The link appears in the BTWYG Project box.
Select the Motive Calibration checkbox to access and browse the Motive calibration files in the7.
Portfolios.
Click the ellipsis button to browse and select the new Motive calibration file that will replace the8.
current file in the current Portfolio.

Result: The link appears in the Motive Calibration box.
Click Update Portfolio.9.

Result: BlackTrax project, BTWYG project, and Motive calibration file in the current Portfolio
are updated with the selected new files.

To open a portfolio folder

In Portfolio Manager, select a Portfolio.1.
Click the Open Folder button.2.

Result:
The folder of the selected Portfolio opens in the browse dialog.
The name of the open Portfolio is highlighted in blue in the Portfolio Manager window.

Note: By default, all BlackTrax Portfolios folders are saved in C: > BlackTrax Portfolios >
Portfolio Name > BlackTrax, BTWYG, Motive folders.

To launch a portfolio

In Portfolio Manager, select a Portfolio.1.
Click the Launch Portfolio button.2.

Tip: You may double-click the selected Portfolio.
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Note: If you have Outputs that are assigned to NICs that do not exist on the current machine,
a dialog box will appear asking you to select a new NIC.

 On the NIC dialog box, click on the drop-down menu of the displayed outputs to1.
change the NIC for each output.
On the NIC dialog box, click OK.2.

Result:
The new NIC is assigned to the desired output.
All the BlackTrax and BTWYSIWYG files in the selected Portfolio open.
The Messages window of BlackTrax appears showing the most recent change in the
state of the system.
New Portfolios open with 12 Trackables by default for BlackTrax and BTWYG.

Click Apply Changes.3.
Tip: You can also select the Automatically Apply Changes when BlackTrax Starts checkbox in
the System section of the System Configuration window.

Notes:
How the Portfolio Manager is displayed at startup depends on the Open most recent Portfolio
when BlackTrax starts setting in the System section of System Configuration (on by default).
The Open most recent Portfolio when BlackTrax starts feature is disabled if a license check
fails when opening the Main GUI.
BlackTrax always opens to the Edit View.
How BTWYSIWYG files open from the Portfolio Manager depends on the Launch BTWYG file
with Portfolio setting in the System section of System Configuration (enabled by default).
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Layout of the BlackTrax GUI
The functions of BlackTrax are divided into three simple core views. You may customize how the GUI lays
out the various toolbars and widgets to your liking, and as such, this documentation refers to the default
layout of the GUI. Along the left of the window are the View toolbar and Sub-View toolbar where you may
click and navigate to the different views. The views of BlackTrax are:

Live view
The Live view is where you monitor a BlackTrax project. From this view, you have the ability to manually
switch between Chapters and Books or enable Chapter Control from a console. You can connect or
disconnect BlackTrax modules to the system as well as view the current BTBeacon patch, data and their
Trackables. You may choose which Trackables are displayed based on group, active chapter, or all
available. Only the information that was saved and applied to the project is displayed in Live view.

 Live View 

Edit view
The Edit view is where you assign fixtures to follow Trackables and program your Chapters. An instance
of fixtures and Trackable relationships is called a chapter. Chapters can be edited, saved and managed
on this page. You can also create and manage Books. Books are collections of Chapters. You may control
how a fixture follows a Trackable using Fixture Settings. Various fixture settings and how they connect to
BlackTrax are managed from this view. 

 Edit View

Calibration view
The Calibration view is the parent of Calibration sub-views. Each sub-view offers settings and operations
specific to the type of calibration. The sub-views available are Fixture Calibration view and Frame
Calibration view.

Note: Calibration view in itself is not a view, but automatically defaults to the last active sub-view once
clicked.

Sensor Calibration sub-view
Sensor Calibration view allows you to manage BTSensor settings within BlackTrax. From this view, you
see the output from sensors (greyscale or 2d tracking info), control sensor settings, renumber sensors,
manage sensor list and groupings, enter RAW Mode to focus sensors, and launch Motive sensor
calibration.

Note: Access to the Sensor Calibration view is available only if the Legacy Mode checkbox in the
Sensor section of the System Configuration widget is not selected. The Sensor Calibration view does not
appear if the Legacy Mode checkbox is selected. The Legacy Mode checkbox is selected by default when
BlackTrax opens for the first time. For more information on Legacy Mode, see Sensors Section in
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the System Configuration section.

 Sensor Calibration sub-view

Fixture Calibration sub-view
Fixture Calibration view allows you to correct and adjust approved movable fixtures connected to
BlackTrax, ensuring precision when following Trackables. Features of fixtures that can be calibrated are
the pan and tilt settings and pan and tilt motor mapping (DMX to angle). The calibration profiles can be
created, exported and imported for use as needed.

 Fixture Calibration sub-view

Frame Calibration sub-view
Frame Calibration view allows you to create and edit Rigid Body and Soft Body Frames. A Frame is a
collection of beacons and LEDs that form an object. From this view, you can construct, offset, and move
the centroid and orientation of a Frame as well as rename them.

 Frame Calibration sub-view

BlackTrax Wiki 179 May 2021

http://wiki.blacktrax.ca/tiki-index.php?page=System+Configuration
http://wiki.blacktrax.ca/tiki-download_file.php?fileId=627&display
http://wiki.blacktrax.ca/tiki-download_file.php?fileId=413&display
http://wiki.blacktrax.ca/tiki-download_file.php?fileId=414&display


Full Screen Mode
BlackTrax can display the GUI in a full screen mode. You can hide the Windows interface and focus
directly on your programming/tracking work. 

To switch between full screen or windowed mode

From the View menu, choose Full Screen Mode or Windowed Mode.1.

Tip: You may click the Enter(Exit) Full Screen Mode icon on the Main Toolbar or click F11.
Result: BlackTrax GUI switches to full screen from the default windowed mode, or BlackTrax GUI
switches back to the default windowed mode from full screen.

Note: If you are in full screen mode, and launch one of the BT Modules via the Modules menu,
BlackTrax will switch to windowed mode upon launching the module.
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Menu Bar
 BTGUI Menu Bar

The Menu Bar across the top of the GUI is where you will find access to all functions of the software. The
different menu bars are:

File: Saving of projects, as well as updating BTWYG information. You can also export various
functions such as fixture calibration data and a programming report.
Edit: Undo, Redo and Discard Changes can be found here.

Discard Changes will rollback changes made in the BlackTrax project to the last savepoint
created. If no savepoint was created, the project will revert to as it was when originally
opened.

View: All docking widgets for the current view can be found here as well as options to
manipulate saved views. 
Settings: Modify system and project settings.
Modules: Access to the various modules of the BlackTrax System, including BTEngine and BTWYG
Help: About information for your current release of BlackTrax and quick access to the License
Folder.
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File Menu
 

 BlackTrax File Menu

Introduction
The File menu is where you can save, update, revert BlackTrax Projects and create Motive Projects. You
can update a .btprj file with a .btx file from BTWYG, or via the Apply BTWYG Updates when new
BTWYG information is sent to BlackTrax.

Other features that are available are being able to import and export calibration data, as well as
exporting chapter programming data for reference as an .html file.

You can also exit BlackTrax from this menu.

Reverting to a Project History File
From the File menu, you can choose Revert Project to select and open a Project History file of the
BlackTrax Portfolio that is currently in use.

To revert to a BlackTrax history file

 From the File menu, choose Revert Project.1.
Result: The Revert Project dialog box appears showing the menu list of the dates and times
of the saved Project History files.
Tip: 

You may click on the Revert Project icon on the main toolbar.
You may click on the Backup Date and Time arrow in the Revert Project dialog box to
sort the list in ascending or descending order.

In the Revert Project dialog box, click on a Backup Date and Time.2.
Click Revert.3.

Result: The Project History backup file associated with the date and time displayed opens
and the currently opened project is saved and archived in Project History.

Updating BTX Projects
If a BTWYSIWYG file (.btx) has been edited since it was used to make a BlackTrax project file (.btprj),
Update BTX Projects can be used to update the BlackTrax project file. Any new .btx information will be
carried over to the existing .btprj while maintaining any work you have already done to the project.

To update a BlackTrax project with new information from BTWYSIWYG via a .btx file

From the File menu, choose Update Project.1.
Result: The Browse window appears.

In the Browse window, navigate to the edited .btx file location, and select the file.2.
Click Open.3.
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Result: Information from the .btx file (e.g. fixtures, trackables, Space dimensions) will be
loaded into BlackTrax project file (.btprj).

To update a BlackTrax project with new information from BTWYSIWYG directly

In BTWYG, go to Live Mode1.
From the Live menu, choose BlackTrax Panel (If BlackTrax panel is closed).2.

Result: The BlackTrax panel appears.
Ensure BTWYG is connected to BlackTrax (if it is not, click connect).3.
In the BlackTrax window, click BTX Apply.4.
In BlackTrax, from File menu, choose Apply BTWYG Updates.5.

Saving BlackTrax Projects
BlackTrax projects are saved as a ".btprj file". Save Project will save the open BlackTrax project to the
same file name and location under which it was previously saved.

To save a BlackTrax project using Save Project

To save the current project, from the File menu, click Save.1.
Result: The currently open project is saved in the portfolio and a Project History backup
(.btbak) file is created.

Importing Sensor Calibration
If BlackTrax is not in Legacy Mode, you can import sensor calibration data to configure current
calibration.

The Sensor Calibration menu is only available if the Legacy Mode checkbox in the Sensor section of the
System Configuration widget is not selected. The Legacy Mode checkbox is selected by default when
BlackTrax opens for the first time. For more information on Legacy Mode, see Sensors Section in System
Configuration.

To import sensor calibration data

From the File menu, choose Import and then choose Sensor Calibration View.1.
Result: The Browse window appears.

Browse and open the ".cal" file.2.
Result: The sensor settings stored in the ".cal" file is loaded.

On the Status Bar, click Apply Changes.3.
Result: The calibration settings in the ".cal" file are applied to the current project that is
connected to the sensor network.

Importing and Exporting Fixture Calibration Data
You can import and export fixture calibration data to be used at a later date. This is useful to backup just
calibration data, as well as exporting calibration data to be used in lighting consoles. In both cases for
import and export, if no fixtures are selected in Calibration Views > Fixture View window, then all
fixtures with calibration data will be exported/imported. If fixtures are selected, then only the selected
fixtures will export/import.

To import fixture calibration data
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From the File menu, choose Import and then choose Fixture Calibration.1.
Result: The Browse window appears.  

Browse to the .btcal file and open it.2.
Result: The calibration data stored in the .btcal is applied.

To export fixture calibration data

From the File menu, choose Export then choose Fixture Calibration.1.
Result: The Export Calibration browse window appears.

Under file type, select if you want to export .btcal (for importing back into a .btprj file) or .xml (for2.
importing into lighting consoles or other devices).
Browse to the folder you wish to save the file.3.
Click Save.4.

Result: All calibrated fixture data is exported.

Importing and Exporting Output
Configuration Data
You can import and export output configuration data to configure the current tracking output or store
tracking output data for later use.

To import output configuration data

From the File menu, choose Import and then choose Outputs.1.
Result: The Browse window appears.

Browse to the .btoc file and open it.2.
Result: The Output Import Details window appears. The table in the Output Import Details
window displays the output configuration settings that will be imported into your project.  

       

In the Output Import Details window, select the checkbox of the following options:3.
Create New: This option will create the new outputs as defined in the New Outputs section.
Delete Existing: This option will delete any outputs in the Deleting Outputs section. These
existing outputs are already present in the BlackTrax project.
Overwrite Existing: The current output configuration defined in the Existing Outputs section
will be replaced with the settings of the output configuration being imported.
Note: The checkbox will only appear if an output being imported has that option (i.e. Check
New will only appear if there are new outputs).

If an output data with the same name is already present in your file, the changes will be4.
highlighted, and you are given the option to overwrite the current output with these new settings.
The Output Configuration data stored in the .btoc is applied to the current project in BlackTrax.5.

To export output configuration data

From the File menu, choose Export and then choose Outputs.1.
Result: The Export Calibration window appears.

Under file type, select if you want to export .btoc.2.
Browse to the folder you wish to save the file.3.
Click Save.4.

Result: All Output Configuration data is exported to the selected folder.

Note: The project file must first be saved before you can export output configurations.
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Exporting a Show Report
You can export a show report from the Export menu, which contains all the information regarding the
programming of the show, including chapters, trackables, and Frames.

To export a show report

From the File menu, choose Export and then choose Show Report.1.
The Export Show Report window appears.

Browse to where you would like to save the file and click on Save.2.
Result: The file is saved and contains all project information as of the export in an .html
format.

Closing BlackTrax
You can close BlackTrax from the file menu, at which point it will ask you to save the project, if changes
were detected.

To close BlackTrax

From the File menu, choose Exit BlackTrax.1.
If prompted, save or discard project changes.2.

Result: The GUI is now closed.
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Edit Menu
Introduction
The Edit menu is where you can undo or redo your changes, or discard your changes and revert back to
the last time you hit the Apply Changes button.

 

Undo
If you want to reverse the last action you applied, you can easily reverse the action by using the Undo
tool available on the Edit menu.

Redo
If you did not want to reverse the previous undo action you applied, you can easily reverse the previous
undo action by using the Redo tool available on the Edit menu.

Discard Changes
Each time you click Apply Changes, a snapshot is created of the current editing and live space. As you
make changes, Changes: Blind will highlight in the status bar, alerting you that new changes have not
been made live. Normally, you would click on Apply Changes to apply your new edits live to the stage,
but in the event you wish to discard your changes and revert back to the last time you click Apply
Changes:

To discard your changes

From the Edit menu, choose Discard Changes.1.
Click Yes to confirm you wish to discard all changes.2.

Result: All changes are discarded back to the last time you clicked Apply Changes.
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View Menu

  View Menu

Introduction
The View menu contains all docking widgets, both global and per view, view shortcuts, and common
widget operations. If you are ever curious about what can be done/opened, the View menu should prove
helpful.

Top Section
The top section of the View menu contains you're three core views (Live View, Edit View, Calibration
Views), and Calibration Views' three sub-views (Fixture View, Frame Calibration View, and
Sensor Calibration View). Clicking on one will take you to the selected view. Hovering over
Calibration Views will give you access to the three sub-views.

Note: Access to the Sensor Calibration View menu is available only if the Legacy Mode checkbox in
the Sensor section of the System Configuration widget is not selected. The Sensor Calibration view does
not appear if the Legacy Mode checkbox is selected. The Legacy Mode checkbox is selected by default
when BlackTrax opens for the first time. For more information on Legacy Mode, see Sensors Section
in System Configuration.

Upper Middle Section
This section contains commonly used widget functions.

Switching to Full Screen Mode
The BlackTrax GUI can be displayed in full screen mode. You can hide the Windows interface and work
directly on programming and tracking.

From the View menu, choose Full Screen Mode or Windowed.1.

Tip: You may click the Enter(Exit) Full Screen Mode icon on the main toolbar or click F11.
Result: BlackTrax GUI switches to full screen mode from the default windowed mode, or BlackTrax
GUI switches back to the default windowed mode from full screen.

Resetting All Views to Factory Defaults
If at any point you are not happy with the layout you have created, you may click Reset View to restore
the GUI's views back to factory default.

From the View menu, choose Reset View.1.

Result: Any custom views you have created (moved docking widgets, floated widgets to other
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screens, or changes the sizing of widgets) will be reverted to factory defaults.
Note: This will affect all views and cannot be undone.

Closing All Widgets
If you want to close all open widgets and just focus on the center pane in the GUI, you may use the Close
All Widgets option.

From the View menu, choose Close All Widgets.1.

Result: Any widgets currently open, including docked and floating on other monitors, will be
closed.
Note: This will only affect the current view and cannot be undone.

Lower Middle Section
This section contains all global widgets, meaning anything you can open and access across all views. In
this section you will find:

Beacon Patch
BTWYG Patch
Beacons
Messages
System Log

Note: Each widget remembers its location per view only. Meaning if you take Beacon Patch and move it
to a second monitor in Edit view, then switch to Live view, Beacon Patch will reset to its last saved
position in Live view (if no last saved position is available, it will revert to the factory default position).

Bottom Section
This section contains all per-view widgets, meaning each widget is only found in one view and cannot be
shared between other views. In this section, per view, you will find:

Live View

Running Books (In Multi Book Projects)
Running Chapters
Modules
Trackable Details

Edit View

Edit Books (In Multi Book Projects)
Edit Chapters
Libraries
Fixture Settings
Chapter Settings
Trackable Settings
Undo Stack
Terminal

Sensor Calibration View (Legacy Mode not selected)
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Sensor Groups
Sensor List
Sensor View

Fixture Calibration View

Fixture Calibration Control
Fixture Calibration Properties
Fixture Calibration Points

Frame Calibration View

Frame LEDs
Rigid Frame Construction
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Settings Menu
Settings Menu

Introduction
The Settings menu contains links to all the widgets that contain settings for the software, the current
project or the option to change between Chapter or Book mode.

Menu
Output Configuration: The Output Configuration widget displays the active tracking output data
from the Output Modules and Trackable Settings as a result of the tracking operation in BlackTrax.
Project Properties: In Project Properties, you will find settings and information of the current
project such as the show name, author, and description (all editable), and the settings that will
change the DMX input for Chapter Control Channel, Book Control Channel, and the Merging
Channel.

Chapter
Universe: Specifies the universe used for Book and Chapter Control Channels
Book Control Channel: The Book Control Channel specifies the DMX channel which will
be used to trigger Book changes from a lighting console in a Multi Book Project.
Chapter Control Channel: The Chapter Control Channel specifies the DMX channel
which will be used to trigger Chapter changes from a lighting console.

Merging Channel
Enable Monitoring: When this checkbox is enabled the current DMX value of the
Merging Channel will be displayed in the Status Bar.
Universe: Specifies the universe used for the Merging Channel.
Merging Channel: The Merging Channel is just a monitoring channel and does not
control the merging channel. The Merging Channel must be set in the merge node and
monitored from the GUI.

System Configuration: In System Configuration, you will find settings that will change the
software behaviors (such as Fixture Calibration behavior, warning prompts, and autofocus behavior
going to BTWYG).
Reset Settings: 

In Legacy Mode, the Reset Settings menu allows you to reset BlackTrax, Motive, or BT
Engine settings to their original manufacturer settings. During the reset, all tracking
operations will pause momentarily. 
If not in Legacy Mode, the Reset Settings menu allows you to reset BlackTrax, BTEngine, or
Stage settings to their original manufacturer settings. During the reset, all tracking
operations will pause momentarily. For more information on Stage in Legacy Mode, see
Modules Menu and Sensors Section in the System Configuration section.

Change Book Mode: Click on the Change Book Mode to switch BlackTrax between Standard
Chapters (no Books) mode or Extended Chapters (with Books) mode.
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Modules Menu

  BlackTrax Modules Menu

Introduction
The Modules menu launches these modules that are used with BlackTrax. If you are in full screen mode,
selecting a module will exit full screen mode. 

Modules
Module Status: Displays the list of currently active modules. See Module Status page.
BTEngine: Launches the Tracker, Follower, Monitor, and Stage modules as background tracking
modules with settings that are integrated within the Output Configuration window of the Settings
menu. Tracking Adapter module is launched when an output is present in the project.

Tracker module is a background process that takes the positional data of a BTBeacon from
the Motive module, the corresponding BTBeacon idetification data from the BTRouter, and
combines this data together.
Follower module is a background process that takes positional data from the Tracker,
generates angle and DMX values for moving light fixtures, and forwards the data to other
modules for their own use. BTWYSIWYG uses the data from Follower to virtualize real-time
lighting tracking. Follower also listens to ArtNet/sACN from a console or from other sources.
Monitor module is a background process that maintains communication and command
settings of multiple Tracking Adapters that were set in the Output Configuration window.
Stage module starts with BTEngine if the Legacy Mode option in the Sensors section of
System Configuration is not selected. Stage is the background process that manages and
connects to BTSensors when BTNet is enabled.
Tracking Adapter module is a background process that is an extension of Tracker's RTTrPM
output. It is used by the BTSystem to customize RTTrPM data for Third Party use. The
Tracking Adapter receives data provided by the Tracker module and customizes this data
based on preferences configured in the Tracking Adapter. This customized data is then sent
off to designated Third Party programs for their use.

BTWYG: Launches the BTWYG file associated with the currently open Portfolio.
Simulator: Identification and positional data of BTBeacons can be created, configured and
managed in simulation. See Simulator Module page.
Cue: Realtime or simulated tracking data in BlackTrax can be recorded and saved as Chapters for
playback. See Cue Module page.
Device Manager: Launches the Device Manager as an integrated software application module
where external hardware used in the BlackTrax system can be accessed and managed directly
through a PC. See BlackTrax Device Manager page.
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Module Status
The Module Status widget displays the list of modules that are currently active with the corresponding
link connections. In the widget, you may click the Discover button to display the currently active module
connections.

In the Module Status widget, you may right-click on a module to restart or exit the module (excluding
BTWYG). In the Module Status widget, you may click Shutdown BTEngine to close all BTEngine modules
at once.

In the Module Status widget, the Shutdown BTEngine button will change to Start BTEngine button if no
modules are running.

 Modules Status widget with modules running

 Modules Status widget without modules running
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Help Menu
 

The Help menu is where you will find the shortcut to the License Folder location, and the About
BlackTrax dialog box with information about BlackTrax, product version, build number, BTX Dongle code
and License information.

The default License Folder location is C:\bt_run_time\license. For information on how to download the
license, please refer to the Licensing.

The About BlackTrax dialog box:

  

BlackTrax Wiki 193 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=236&display
http://wiki.blacktrax.ca/tiki-index.php?page=Licensing
http://wiki.blacktrax.ca/tiki-download_file.php?fileId=548&display


Toolbars
Main Toolbar in Live View

 

Main Toolbar in Edit View

  

Main Toolbar in Calibration Views > Sensor Calibration

 

Main Toolbar in Calibration Views > Fixture Calibration

 

Main Toolbar in Calibration Views > Frame Calibration

 

View Toolbar

 

View and Sub-View Toolbar (Legacy Mode is selected in System Configuration > Sensor by default)

 

View and Sub-view Toolbar (Legacy Mode is not selected in System Configuration > Sensor)

 

There are three toolbars in the BlackTrax GUI: Main, Views, and Sub-Views. 

Main: On top of the left side, contains basic operations such as saving , as well as common
functions found throughout the software such as Reset View, Beacon Patch, and a fullscreen option.
On the right side, you have access to the most used docking widgets found in your current view.
The right side of the toolbar will change depending on which view you are currently in.
Views: The ability to change between the three core views: Live, Edit, and Calibration.
Sub-Views: Sub-views are available for the Calibration Views. Each sub-view offers functions
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related to a specific type of calibration.
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Docking Widgets

 Frame Construction Docking Widget

The GUI is comprised of several docking widgets, each covering features and functionally to control,
calibrate, and operate the system. You can find all available docking widgets under the View menu, and
the most common widgets available in the toolbar. 

All docking widgets comprise of a 'float' and 'close' function. Floating a widget will detach it from the GUI,
and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the View menu or toolbar.

Different widgets function in different ways, and their specific function will be covered in other sections of
this documentation.
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Status Bar
  Status Bar with active BTNet connection

Along the bottom of the screen, the status bar displays important system information at a glance. The
following information is available for view:

Attention: The following status icons act as buttons and can be clicked on to toggle following.

Mode Status: Displays if calibration mode is active or normal mode is active.
Normal Mode: Fixtures follow according to chapter programming and current chapter.
BlackTrax controls pan and tilt, and optionally zoom, iris, and dimming of intensity.
Fixture Calibration Mode: Fixtures follow according to the Fixture Calibration View, and
BlackTrax controls intensity, pan, tilt, zoom, iris, colour, and gobo. Chapters are ignored.

BTNet Connection Status: Displays if the BTSensors are connected to the BlackTrax network and
in sync. BTNet Connection Status appears only if the Legacy Mode checkbox in the Sensor section
of the System Configuration widget is not selected.

BTNet Active: Indicates the active connection to BTSensors. (SYNC) and FPS will appear if
the connected BTSensors are being synced.
BTNet Disabled: Indicates no active connection to BTSensors.

Attention: The BTNet status icons act as buttons and can be clicked on to toggle BTNet connection.

Current Chapter: Displays the chapter currently active.
MCV: Stands for Merging Channel Value and displays the current DMX value from the console of
the merging channel. 

Note: The numbers beside "MCV" will flash colors when a new DMX packet is received by
BlackTrax.

DMX Input: Indicates if the system is receiving DMX information either from ArtNet or sACN. An
animated icon indicates the system is receiving information.
Motion Control: Indicates if the system is receiving motion information. An animated icon
indicates the system is receiving information. The Motion Control icon will turn red when BTSensors
are in Focusing mode indicating that the system is not ready to receive real-time motion.
Sensor: Indicates the number of BTSensors actively connected to BTNet.

The Sensor icon will turn red if BTSensors are missing.
The Sensor icon will turn red if BTSensors are dropping frames, the sensors in Sensor View
will display a message, and the corresponding sensor icon will appear in the Sensor List
widget. The Sensor icon will return to normal if sensors are not dropping frames.
If a BTSensor drops out, the Sensor number on the Status Bar will turn red, the missing
sensor will display a "Missing" label in its name on the Sensor View center pane. When the
BTSensor comes back, the Sensor number on the Status Bar will turn white and the "Missing"
label will disappear.

BTWYG Updates: Indicates if the system is receiving an update from BTWYG via the BTX Apply
function.
Messages: A button to access the messages widget.
Changes: Indicates if changes are Live (everything is actively sending to the lighting fixtures and
all constructed Frames are reporting position) or Blind (changes that have been made, but are not
actively sending to the real world system or live space). The Apply Changes button will apply the
changes to the live space.

Any change made to the BlackTrax project will be saved to a temporary savepoint. The
savepoint that was created will last until the BlackTrax project is closed.
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The blue LED next to the Changes: Live indicator will turn to a flashing red LED next to the
Changes: Blind indicator whenever changes are made to the project but are not yet applied
to the live space.

Apply Changes: Click Apply Changes to apply any blind changes to the live space.
Result:

The Apply Changes confirmation and reminder dialog box appears and offers the option
to select the Do not remind me again checkbox to disable this confirmation/reminder
dialog box. The Do not remind me again checkbox is linked with and has identical
functionality as Enable confirmation prompts for system changes checkbox in System

Configuration.                                                                               

The changes made from the selected option/s will be applied to the live space and blue
LED next to Changes: Live will be displayed.

Mode Status
To enable fixture calibration

When in Normal Mode, in the status bar, click the Normal Mode button to switch to Fixture1.
Calibration Mode.

Result: 
The mode switch confirmation and reminder dialog box appears and offers the option to
select the Do not remind me again checkbox to disable this confirmation/reminder
dialog box. The Do not remind me again checkbox is linked with and has identical
functionality as Enable confirmation prompts for system changes checkbox in System
Configuration.                                                                                 
BlackTrax is set to Fixture Calibration Mode and the features of the Fixture Calibration
view is unlocked.

To disable fixture calibration

When in Fixture Calibration Mode, in the status bar, click the Fixture Calibration button to switch to1.
Normal Mode.

Result: BlackTrax is set to Normal Mode and the Fixture Calibration view features is locked.

BTNet Connection Status
To enable or disable BTNet connection

Use the BTNet Active/BTNet Disabled slider button on the left-hand side of the Status Bar to1.
activate and connect to the BTSensors in the BlackTrax Network.

Result:
On the Status Bar, the slider button displays BTNet Active, and FPS status appears to
indicate the active connection. (SYNC) will only appear if the BTSensors are being
synced when connected.
The Sensor icon on the right-hand of the Status Bar displays the number of BTSensors
connected.
The connected BTSensors appear automatically on the Sensor Calibration View.

Note: BTNet will stop tracking if disabled. A message dialog box will appear asking to confirm
if you want to shutdown tracking. This dialog box can be hidden if you have selected the
Enable confirmation prompts for system changes checkbox in the System section of System
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Configuration.
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Live View
Table of Contents:

Running Chapters Widget
Running Books Widget
Trackable Details Widget

 Live View showing all Trackables in the BlackTrax Project

Live Trackables
In the main window at the center area of the Live View, you see live trackable information, the current
BTBeacon patch data, and their Trackables. There are different options for viewing this data.

Icon View
This view displays Trackable Data in the same way it is represented in the Beacon Patch Docking Widget.
Displayed are:

Trackable containers with Trackable Names.
Any assigned beacons with their relevant information appear in the Trackable containers.
Trackable containers appear with colored borders indicating if the Beacon is currently visible (Blue),
or not visible (Red), or inactive (Grey).
An indicator beside the beacon number to indicate if the beacon is currently visible (Blue), or not
visible (Red), or inactive (Grey).

 Live Trackables with Icon View

Table View
This view displays live trackable information with live LED status monitoring in the following columns:

Trackable with name.
Assigned Beacon.
Battery Status.
Radio Status: Fresh data (Blue), Stale data (Red).
Visibility of the trackable: Visible (Blue), Not-visible (Grey).
Status of the individual LED associated with the trackable: Active (Blue), Inactive (Dark Grey).

 Live Trackables with Table View

Small View
This view displays Trackable Data that is represented as small icons with the Trackable Name, beacon
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number with the relevant information and the indicator. Click on the box beside Small View to select this
display option. Displayed are:

Small Trackable container icons with Trackable Names.
Any assigned beacons with their relevant information appear in Small Trackable containers.
Small Trackable containers appear with colored borders indicating if the Beacon is currently visible
(Blue), or not visible (Red), or inactive (Grey).
An indicator beside the beacon number to indicate if the beacon is currently visible (Blue), or not
visible (Red), or inactive (Grey).

 

In addition to the views mentioned above, there are further sorting options available to show the relevant
data as the user prefers. They are:

Show per Chapter
This option will show only trackables currently assigned to the currently running chapter.

 Per Chapter Live Trackables using the Icon View

Show by Group
This option displays any trackables that have been assigned to a group through the Trackables docking
widget. When showing by group, an additional drop-down menu appears to allow the selection of groups.
For information on Trackable group creation, refer to Grouping Trackables in the Libraries widget section
of this manual.

 Displaying Trackables in a selected group

Tab Views
There are also two options for displaying trackable information while using the Icon View.

Centroid Tab displays battery information, as well as the XYZ Calculated centroid of a trackable, as
well as Roll, Pitch, Yaw and BTBeacon information.
LED Tab displays battery information, as well as the XYZ information of individual LED Stringers
connected to the beacon.
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Running Chapters Widget
Overview
The Running Chapters widget contains the list of recalled Chapters, which can be selected to become
active.  The Running Chapters widget displays:

Names and descriptions assigned to the recalled Chapters.
Tracking status of the recalled Chapters.
Programmed fade time of the recalled Chapter.

Active: When Tracking is active, assigned fixtures will follow the Trackables assigned to the selected
active Chapter. Selecting which Chapter to activate can be controlled by using manual control in
BlackTrax, or using DMX via Art-Net or sACN from a connected lighting console.

Fade: Fade column displays the programmed fade time of the fixture's zoom, iris, pan and tilt values
between two different Chapters or to and from the lighting console.

Fade time is set in the  Edit Chapters or Chapter Settings widget in Edit View and applies to change
transitions from Chapter to Chapter, Trackable to Trackable, Console to Chapter, and Chapter to
Console.
The default fade time value is 0 seconds and the maximum value is 60 seconds.
The running Chapter's Fade time is displayed as it counts down in the Fade column and on the
Status Bar.
The running Chapter's cell highlights in yellow as a fade is in progress.

See Edit Chapters Widget for information on Chapter Settings.

 Running Chapters Widget 

Manual Chapter Control
Manual control enables control of chapters from within the BlackTrax GUI.

To enable manual control of chapters

In the center widget of Live View where the Icons are displayed, click on the drop-down menu at1.
the bottom left-hand corner.
On the drop-down menu, click Manual.2.

To select a chapter to be active using manual control

In the Running Chapters widget, from the list of saved Chapters, click on the Chapter.1.
Result: The selected Chapter shows an Active icon in the Active field to indicate it is
currently active. Fixtures assigned to the selected Chapter will follow the assigned Trackables
in the Space.
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DMX Chapter Control
With DMX control enabled, the selection of which chapter is active can be controlled from a lighting
console.

To enable DMX control of chapters

In the center widget of Live View where the Icons are displayed, click on the drop-down menu at1.
the bottom left-hand corner.
On the drop-down menu, click DMX Input.2.

Result: The connected lighting console has control over the selected Chapter. The Universe
and Address used to control the Chapters from the lighting console are displayed in the
bottom left-hand corner of the center widget and on the Status Bar. The Chapter Control DMX
value is also displayed at the bottom left-hand corner of the Running Chapters widget.

To toggle auto scrolling to an active chapter

With DMX Input enabled, Auto Scroll is available for use. Auto Scroll will make the chapter list always
display the active chapter when enabled.

In the Running Chapters widget, click Auto Scroll.1.
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Running Books Widget
Overview
The Running Books widget contains the list of created Books that can be recalled to become active.
When a Book is recalled, the list of Chapters in the Book is displayed in the Running Chapters widget.
Selecting which Book to recall can be controlled by using manual control in BlackTrax, or using DMX via
Art-Net or sACN from a connected lighting console.

Running Books Widget

Manual Book Control
Manual control enables the control of Books from within the BlackTrax GUI.

To enable manual control of books

In the center widget of Live View where the Icons are displayed, click on the drop-down menu at1.
the bottom left-hand corner.
On the drop-down menu, click Manual.2.

To select a book to be active using manual control

In the Running Books widget, from the list of created Books, click the Book.1.
Result: The selected Book will have an Active icon in the Active field to show it is currently
active. The list of Chapters in the selected Book will be displayed in the Running
Chapters widget.

DMX Chapter Control
With DMX control enabled, selecting which Book to recall can be controlled from a lighting console.

To enable DMX control of books

In the center widget of Live View where the Icons are displayed, click on the drop-down menu at1.
the bottom left-hand corner.
On the drop-down menu, click DMX Input. 2.

Result: The connected lighting console has control over the selected Book and all the
Chapters in the Book. The Universe and Address used to control the recalled Book and
Chapters from the lighting console are displayed in the bottom left-hand corner of the center
widget and in the Status Bar. The Book Control DMX value is also displayed at the bottom
left-hand corner of the Running Books widget.

To toggle auto scrolling in the active chapter

With DMX Input enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the
Books list always display the active Book when enabled.

To toggle auto scrolling, in the Running Books widget, click Auto Scroll.1.
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Trackable Details Widget
 Trackable Details Widget

Overview
This widget is used to monitor the details of beacons assigned to any Trackables in the currently selected
Chapter that have a Rigid or Soft frame assigned to them. Selecting a Trackable with a Rigid or Soft
frame assigned to it in the central widget of the Live View will display all the beacons which the Rigid or
Soft frame is assigned. The widget lists the name of all the beacons assigned to the frame, as well as the
battery status, stale radio data, and a visibility icon (Blue for visible, red for not visible, grey for inactive).
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Edit View
Table of Contents:

Chapter Configuration
Edit Chapters Widget
Edit Books Widget
Libraries Widget
Fixture Settings Widget

Basic Tab
Offset Tab
Auto Spot Tab
Zones Tab

Trackable Settings Widget
Programming Chapters
Undo Stack
Terminal Widget
Error Codes for Unsupported Fixtures

Overview
The Edit View is where moving fixtures are assigned to follow the position of Trackables in chapters. A
chapter is saved information on which Trackables are to be tracked, and which fixtures are to follow them
at a specific instance. Specific customization can also be enabled in a chapter such as configuring how a
BTBeacon’s LEDs should be used for Tracking; if a zone is to be used in the chapter; and if a terminal
command is used to alter tracking behavior.

 Edit View Overview
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Chapter Configuration
Single Chapter Configuration
The central widget in Edit View is where you modify Chapters and assign Trackables and Fixtures to the
chapters. If you select a single Chapter in the Edit Chapters widget, Single Chapter tab will automatically
be selected in Edit View. The Single Chapter tab is where you modify settings for the currently selected
chapter in the Edit Chapters widget.

 

If you select a single Chapter in the Edit Chapters widget:

You can drag Trackables from the Trackables in the Libraries widget to the top pane of the central
widget to assign the Trackable to the selected Chapter.
You can copy/paste Trackables using the "Copy/Paste" buttons on the top pane of the central
widget.
You can delete selected Trackables from the selected chapter using the "Delete" button on the top
pane of the central widget.

If you select a Trackable on the top pane of the Single Chapter tab:

You can drag the desired fixtures from the Fixtures tab in the Libraries widget to the bottom pane
of the central widget to assign the Fixture to the selected Trackable.
You can copy/paste Fixtures using the "Copy/Paste" buttons at the bottom pane of the central
widget.
You can delete selected fixtures from the selected Trackable/Chapter using the "Delete" button on
the bottom pane of the central widget.

Tip: You may right-click on the Trackable icons on the top pane or Fixture icons on the bottom pane and
choose the Copy menu or Replace Trackables menu.

Select a fixture in the bottom pane of the central widget and open the Fixture Settings widget to apply
fixture settings.

In the Single Chapter tab, fixtures are displayed in List View or Table View. You can add filters in each
view to display fixtures with specific settings. 

In Icon View, moving fixtures are displayed with a grey border and conventional fixtures are displayed
with a red border. The icons will display a symbol to indicate the specific settings when a filter is
selected:

 

Uses Iris: Will show if a fixture uses iris to change the beam size.
Uses Prediction: Will show if a fixture has prediction settings.
Has Offset: Will show if a fixture has any offset settings applied.
Has Following Setting: Will display if a fixture is assigned to follow specific LEDs of assigned
BTBeacons.

BlackTrax Wiki 208 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=599&display
http://wiki.blacktrax.ca/tiki-download_file.php?fileId=600&display


Uses LED 1:  Will display if a fixture is assigned to follow the LED in BTBeacon port 1.
Uses LED 2: Will display if a fixture is assigned to follow the LED in BTBeacon port 2.
Uses LED 3: Will display if a fixture is assigned to follow the LED in BTBeacon port 3.

Uses Zones: Will show if a fixture uses zoom to change the beam size.
Uses Auto-Spot Mode: Will show if a fixture has Auto-Spot mode settings.
Uses Zoom: Will show if a fixture has any zone settings applied.

Table View displays all fixtures assigned to the currently selected trackable in a table format. You may 
configure the columns to display an icon according to the applied fixture settings. The columns are Spot
ID, Name, and Type, followed by any of the settings enabled in the following list:

LED Following
Zoom
Iris
Smooth Pickups
Auto Douse
Sensitivity
Offset
Auto Spot Mode
Zone

Note: The Name column displays the Name of the fixture that matches the Name column in the
Libraries widget. The Type column displays if the fixture is a Moving Head, Moving Mirror, or
Conventional fixture.

Click the Clear Trackable Selection button at the bottom of the top pane of the central widget to clear the
selected individual trackable or all the selected trackables.

Click the Clear Fixture Selection button at the bottom of the bottom pane of the central widget to clear
the selected individual fixture or all the selected fixtures.

Several Chapter Configuration
 

In the Several Chapters tab in the central widget, settings can be applied to several fixtures at once and
across multiple chapters. 

If you select several Chapters in the Edit Chapters widget:

The Edit Chapters tab will automatically be selected.
All Chapters will automatically be scanned for all Fixtures and Trackables.
All Trackables that are used across the selected Chapters will appear at the top pane of the central
widget in Several Chapters tab.
If no Trackable is selected, all Fixtures that are assigned to all the Trackables used in all the
selected Chapters will appear at the bottom pane of the central widget in Several Chapters tab.
If no Trackable is selected, changes to the Fixture Settings will apply to all selected Fixtures across
the selected Chapters.

If you select a Trackable on the top pane of the central widget in Several Chapters tab:

Only the Fixtures assigned to the selected Trackable across all the selected Chapters will appear at
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the bottom pane of the central widget in Several Chapters tab.
If you select a Fixture assigned to the selected Trackable, changes to the Fixture Settings will
modify the Fixture Settings for Chapters where the Fixture is assigned to the selected Trackable.

Use the Search box to search for fixtures by spot number or fixture type across the selected chapters.

Click the Clear Selection button at the bottom to clear the selected individual fixture or all the selected
fixtures.
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Edit Chapters Widget
Overview
The Edit Chapters widget is where Chapters are created, removed, and re-ordered. The selected chapter
or chapters in this widget define what is displayed in the central pane of the Edit View, in Single Chapter,
or Several Chapters mode.

The Edit Chapters widget displays the name, description and the programmed fade time that were set for
each Chapter in the Chapter Settings widget. You can double-click the fields on the Name, Fade and
Description columns to edit the values or you can open the Chapter Settings widget.

The Chapter Settings widget is accessed from the Edit Chapters widget. The Chapter Settings widget is
where you set or change the name, description, fade time, and calibration preset for each Chapter that is
selected. See the section To edit chapter settings below.

Edit Chapters Widget

Functionality
The following actions can be performed in the Edit Chapters widget:

To create a new chapter

In the Edit Chapters widget, click the Plus button.1.
Result: A blank chapter is created in the chapter list below the currently selected chapter.

For the changes to take effect, click Apply Changes.2.

To create a copy of an existing chapter

Copying a chapter will copy all aspects of the selected chapter, including fixture and Trackable
relationships.

In the Edit Chapters widget, select the chapter you want to copy.1.
Click the Copy selected chapter button.2.

Result: A copy of the chapter is created in the chapter list below the currently selected
chapter.

For the changes to take effect, click Apply Changes.3.

To delete a chapter

In the Edit Chapters widget, select the chapter you want to delete.1.
Click the Delete button.2.

Result: A dialog box appears asking if you really want to delete the chapter.
To confirm deletion, click Yes.3.
For the changes to take effect, click Apply Changes.4.

To move chapters in the chapter list

In the Edit Chapters widget, select the chapter you want to move.1.
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Click the Up Arrow or Down Arrow button to move the selected chapters up or down.2.
For the changes to take effect, click Apply Changes.3.

To edit chapter settings

In the Edit Chapters widget, select the chapter or chapters you want to edit.1.
Tip: You may use the unified selection methods for multiple selection.

Use Ctrl+A to select all chapters.
Use Left-click to isolate the selection and deselect all the other chapters.
Use Right-click to change the active selection while keeping the current selection
group.

Result: The active chapter is highlighted light blue where the active settings are displayed.
Dark blue highlight indicates selection.
Note: When you select multiple chapters, conflicting chapter settings in text boxes will be
highlighted in blue to indicate a difference in settings.

In the Edit Chapters widget, click the Chapter Settings button.2.
Tip: You may click the Chapter Settings icon on the Main Toolbar in Edit View.                

 Chapter Settings icon.

Result: The Chapter Settings widget appears.                                                       

 

Note: When you select multiple chapters, the settings of the active chapter will appear in
blue.

On the Name box, type the new name of the selected Chapter.           3.
Result: The new name appears on the Edit Chapters widget.

On the Description box, type a description of the selected Chapter.4.
Result: The description appears on the Edit Chapters widget.

On the Fade Time scroll box, click the Up or Down arrow or type a value to set the fade time for the5.
selected Chapter.

Result: The Fade Time value appears on the Edit Chapters widget.
Notes:

Fade Time sets the Chapter timings when fixtures' zoom, iris, pan and tilt functions fade
during transition between two different Chapters or to and from the lighting console.
Fade Time applies to transition timings from Chapter to Chapter, Trackable to
Trackable, Console to Chapter, and Chapter to Console. Trackables change, console
release, offset values, LED following and beam sizing features are supported.
Fade Time value will be displayed in the Show Report.
Fade Time default value is 0; maximum value is 60 seconds.
Standby Chapters has no fade time; Standby default value is 0.
Fade Time does not apply to Intensity effects which are controlled via their individual
feature's timing.
Chapters operate in LTP when several Chapters are triggered back to back. The latest
Chapter will take priority and fixtures will snap to the beginning of that Chapter's
starting position.

On the Calibration Preset drop-down box, click and select a calibration preset from the drop-down6.
list.

Result: The fixture calibration data collected under the selected preset is applied to the
selected Chapter.

For changes to take effect, click Apply Changes.7.
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To name a chapter

In the Edit Chapters widget, in the Name field of the chapter, double-click to enable editing.1.
Type the name of the chapter in the Name field.2.
For the changes to take effect, click Apply Changes.3.

To write a description of a chapter

In the Edit Chapters widget, in the Description field of the chapter, double-click to enable editing.1.
Type the chapter description in the Description field.2.
For the changes to take effect, click Apply Changes.3.

To set a fade time for a chapter

In the Edit Chapters widget, in the Fade field of the chapter, double-click to enable editing.1.
Type a value or click the Up or Down arrows in the Fade field.2.
For the changes to take effect, click Apply Changes.3.

Edit Chapters Widget in Multi Book Mode

  Edit Chapters Widget 

In Extended Chapters (with Books) mode, the Edit Chapters Widget displays the name of the selected
Book where the current selected Chapter is accessed. See Edit Books Widget.
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Edit Books Widget
Overview
When BlackTrax is in Multi Book mode, Chapters can be created, edited, saved and managed as part of
a Book or Books. In the Edit Books widget, a Book with Chapters can be created, removed, re-ordered or
selected for editing. The Chapters in the selected Book will be displayed in the Edit Chapters widget for
editing.

Edit Books Widget

Functionality
The following actions can be performed from the Edit Books widget:

To select a chapter from a book

In the Edit Books widget, from the table list of Books, click on the Book that contains the Chapter1.
you want to select.

Result: The list of Chapters available in the selected Book are displayed in the Edit Chapters
widget. You can proceed to select the Chapter from the Edit Chapters widget.

To create a new book

In the Edit Books widget, click the Plus button.1.
Result: A blank Book is created in the Book list below the currently selected Book.

For the changes to take effect, click Apply Changes.2.

To create a copy of an existing book

Copying a Book will copy all the Chapters in the selected Book, including fixture and Trackable
relationships in all the Chapters in the selected Book.

In the Edit Books widget, select the Book you want to copy.1.
Click the Copy selected book button.2.

Result: A copy of the Book is created in the Books list below the currently selected Book.
For the changes to take effect, click Apply Changes.3.

To delete a book

In the Edit Books widget, select the Book you want to delete.1.
Click the Delete button.2.

Result: A dialog box appears asking if you really want to delete the Book.
Click Yes to confirm deletion.3.
For the changes to take effect, click Apply Changes.4.

To move books in the books List

In the Edit Books widget, select the Book you want to move.1.
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Click the Up Arrow or Down Arrow button.2.
For the changes to take effect, click Apply Changes.3.

To name a book

In the Edit Books widget, double-click the Name field of the selected Book.1.
Write the name of the Book in the Name field.2.
For the changes to take effect, click Apply Changes.3.

To write a description of a book

In the Edit Books widget, double-click the Description field of the selected Book.1.
Write the description in the Description field.2.
For the changes to take effect, click Apply Changes.3.
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Libraries Widget
Overview
The Libraries widget contains all Trackables, Fixtures, and Zones that can be applied to Chapters in Edit
View. The widget is separated into three tabs, one each for Trackables, Fixtures, and Zones. Each type of
assignable item can be dragged from the Libraries widget into its respective pane in the Edit view. The
top pane for trackables, bottom pane for fixtures being assigned to trackables, and into the Fixture
Settings widget for Zones.

Trackables Tab
The Trackables tab is organized in a table format with three columns: Name, WYG Trackable, and
Patch status.

Name: The name of the trackable in BlackTrax, which can be changed by double-clicking the name
field on the widget.
WYG Trackable: The name of the trackable when it was exported from BTWYSIWYG.
Patched: The patch status indicates whether or not the trackable has been assigned to a chapter
or chapters. A blue checkmark is displayed to indicate that the Trackable has been assigned to a
chapter or chapters.

Depending on your BlackTrax project, you may have a large amount of Trackables to keep track of. The
Search Trackables function helps you to sort and locate the exact Trackables you need. Based on the
selected chapter, the drop-down filter at the bottom of the widget also helps you choose which
Trackables to display in the table.

 Libraries Widget viewing the Trackables Tab

To search for a trackable

The only way to search for a Trackable is by searching for the Trackable Name assigned in BlackTrax.

In the Search field of the Trackables tab , enter the name of the Trackable(s)  you are looking for.1.
Result: The Trackables List in the Trackables tab will display only Trackables that meet your
search criteria.

To filter the list of trackables

Based on the selected Chapter, you can choose which Trackables to display in the table of the Trackables
tab.

On the Trackables tab of the Libraries widget, click on the filter arrow at the bottom and choose1.
from the drop-down menu options that appear.

Show Unpatched: Only unpatched Trackables appear in the table.
Show Patched: Only patched Trackables appear in the table.
Show All: Trackables that are patched and unpatched appear in the table.
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Grouping Trackables
The Group feature in this widget can be used to group selected trackables and display together in Live
mode.

To group trackables

From the list in the table, select the Trackables you would like to group together.1.
Click the Group drop-down menu and select New Group From Selected.2.

Result: The New Trackable Group dialog box appears.
Enter the group name in the Group Name field on the New Trackable Group dialog box.3.

Result: The group of Trackables is created and appears in the Group drop-down menu.
Note: The Delete Group button deletes the currently selected group (but not the Trackables
themselves).

Note: The current group selection does change the filtering of the Trackable tab. 

Fixtures Tab
The Fixtures tab is organized in a table structure with columns for Spot ID, Fixture Name, Fixture Type,
and Assignment; whether or not it is assigned, and which Trackables it is assigned to in the currently
selected chapter.

Spot ID: An individual Spot ID number that was assigned to every single fixture in a BTWYSIWYG
project. See Patching and Assigning an ID to Fixtures in BTWYSIWYG.
Name: The name of a fixture as listed in the Library Browser in BTWYSIWYG.
Type: The various types of fixtures such as Moving Head, Moving Mirror, or Conventional.
Assignment: Shows whether or not the fixture is assigned, and which Trackables it is assigned to
in the currently selected Chapter.

Like Trackables, there is built-in search functionality to search by By Spot ID, By Fixture Name, or by
Trackable name. There is also a drop-down filter functionality to choose which Fixtures to display in the
table.

 Libraries Widget viewing the Fixtures Tab

To search for a fixture

In the Fixtures section, select from the Search By... drop-down menu how you want to search for1.
Fixtures.

Note: 
By Spot ID searches for Fixtures based on the ID assigned in BTWYSIWYG.
By Fixture Name searches for Fixtures based on how a Fixture is named in BlackTrax.
By Trackable searches for Fixtures currently assigned to a Trackable (in the selected
chapter) based on the BT Trackable name. (For example, if you search for Trackable
name Name X, all fixtures assigned to Name X will be displayed.)

In the Search Fixtures field, enter the name of the Fixture(s) you are looking for.2.
Result:
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The Fixture List displays only Fixtures that meet your search criteria.
If the search finds only a single Fixture, that Fixture is selected automatically.

To filter the list of fixtures

Choose which Fixtures to display in the table of the Fixtures tab.

On the Fixtures tab of the Libraries widget, click on the filter arrow at the bottom and choose from1.
the drop-down menu options that appear.

Show Unassigned: Only fixtures that are not assigned to Trackables appear in the table.
Show Assigned: Only fixtures that are assigned to Trackables appear in the table.
Show Calibrated: Only calibrated fixtures appear in the table. Note: This menu is based on
the selected chapter's preset.
Show All: All fixtures appear in the table.

Grouping Fixtures
The Group feature in this widget can be used to group selected fixtures together for programming.
Creating a fixture group will automatically select all fixtures in that group at the time of creation. 
Selecting a fixture group will automatically select all fixtures in that group.

To group fixtures

From the list in the table, select the fixtures you would like to group together.1.
Click the Group drop-down menu and select New Group From Selected.2.

Result: The New Fixture Group dialog box appears.
Enter the group name in the Group Name field on the New Fixture Group dialog box.3.

Result: The group of Fixtures is created and appears in the Group drop-down menu.
Note: The Delete button deletes the currently selected group (but not the Fixtures
themselves).

Zones Tab
The Zones tab has three columns: Zone Name, Shape Type, and Dynamic.

Name: The name of the BlackTrax Zone that was set in BTWYSIWYG.
Shape Type: The type of BlackTrax Zone that was selected in BTWYSIWYG.
Dynamic: Indicates if the BlackTrax Zone is dynamic/assigned to a Trackable.

On the Search box, you can search by the Zone Names.

 Libraries Widget viewing the Zones Tab
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Fixture Settings Widget
Table of contents:

Basic Tab
Offset Tab
Auto Spot Tab
Zones Tab

 

Overview
The Fixture Settings widget is where you configure how fixtures interact with Trackables in a specific
chapter. Fixture Settings is separated into four tab sections: Basic, Offset, Auto Spot and Zones.  The
tabs will be explained in detail in the following pages.

 Fixture Settings - Basic tab

You can select a single fixture, or multiple fixtures in the center pane of Edit View to have Fixture
Settings display the collective settings. In multi-fixture selection, there is always an 'active' fixture, which
displays its current settings in the Fixture Settings widget. The active fixture is indicated by the name
and spot ID of the fixture at the top of the Fixture Settings widget.

When you select multiple fixtures, any differences between fixtures will be highlighted in blue. For
example: Spot 1 has a zoom setting of 1m and Spot 2 has a zoom setting of 2m. When you select both
fixtures, the text box will highlight blue to indicate a difference between the two selected fixtures.

If you select a conventional fixture and a moving fixture at the same time, the settings of the active
fixture will be displayed. Changes to moving fixture settings that do not apply to conventional fixtures
will be ignored during multi-select for incompatible fixtures.

 Fixture settings - Basic tab (With multiple fixtures selected, differences highlighted and Intensity

Control features marked.)

Moving Fixtures
Moving Head and Moving Mirror are Moving Fixtures. All settings available in the Basic, Offset, Auto Spot
and Zones tabs of the Fixture Settings widget are applicable to Moving Fixtures.
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Conventional Fixtures
Conventional fixtures and non-moving LED fixtures are Conventional Fixtures. BTWYSIWYG sends
conventional fixtures to BlackTrax, which can be assigned to Trackables and Chapters with reduced
functionality settings.

Settings in the Fixture Settings widget that are disabled in conventional fixtures:

Pan-Flip
Following Sensitivity
Offset
Auto Spot

Settings in the Fixture Settings widget that are available in conventional fixtures:

Smooth Pickups
Auto Douse
LED Following Settings (Centroid, LED 1, LED 2, LED 3)
Zones
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Basic Tab
Basic tab is where you configure general settings of a fixture. Set Beam Control, Intensity Control,
and Following Sensitivity for moving fixtures and conventional fixtures.

Configure the beam size of moving fixtures using zoom or iris, control the pan-flips function then set the
sensitivity of the fixture that follows the trackable.

Configure the beam size of conventional fixtures using BTWYSIWYG Profile or custom, then enable
smooth pickups and auto douse.

 Fixture Settings - Basic tab

Beam Control
In BlackTrax you can set beam size of moving fixtures in Automated Mode or set the beam size of
conventional and moving fixtures in Static Mode.

Automated Mode
BlackTrax will use the iris and zoom features of a moving fixture to control its beam size while following a
Trackable. The beam setting of a moving fixture is linked to the chapter it was created in. Fixtures can be
in multiple chapters and have different beam sizes in each chapter. 

If both zoom and iris control are enabled, the BTSystem will tell the fixture to first use zoom control to
shape the beam size. Using both the iris and zoom can increase the range.

Static Mode
BlackTrax will use the fixture's BTWYSIWYG Profile Size or you can set a Custom Beam Degree. 

You can assign a conventional fixture to a Zone and a Trackable, to the same Zone, which will make the
Zone Dynamic. When you assign the conventional fixture to the Trackable in Static Mode, you can trigger
the conventional fixture to switch On or Off when the Trackable enters the Zone.

To control the beam size of a fixture in automated mode

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
On the Beam Control section of the Basic tab, click on the drop-down menu and select Automated5.
Mode.

Result: Enable Iris Control and Enable Zoom Control checkboxes are displayed.
Select Enable Iris Control and/or Enable Zoom Control checkboxes.6.

Result: The Beam Diameter and Distance Range settings are displayed.
On the Beam Diameter scroll box, click on the Up or Down arrows or type the value for the desired7.
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beam diameter (in meters).
Result: The Distance Range displays at what distance from the fixture the beam diameter
can be maintained.

For the changes to take effect, click Apply Changes.8.

To control the beam size of a fixture in static mode

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the moving or conventional fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
On the Beam Control section of the Basic tab, click on the drop-down menu and select Static5.
Mode.

Result: Use Profile Size and Use Custom Size checkboxes are displayed.
Select Use Profile Size checkbox or Use Custom Size checkbox.6.

Result: The non-editable Beam Degrees value is displayed if Use Profile Size is selected. The
editable Beam Degrees value is displayed if Use Custom Size is selected.

If you selected the Use Custom Size checkbox, on the Beam Degrees scroll box, click on the Up or7.
Down arrows or type the value for the desired beam angle.

Note: 
When you select Use Custom Size in Static Mode, BlackTrax attempts to control the
Zoom/Iris feature if available in the fixture.
When you select Use Profile Size in Static Mode, beam control returns to the lighting
console (default).

For the changes to take effect, click Apply Changes.8.

Intensity Control
Pan-Flip
The Fade Time and Additional Doused Time features in the Pan-Flip section manages how a fixture
performs a pan-flip during tracking in the chapter. The time it takes for a fixture to complete a pan-flip is
determined by the speed of the fixture's pan/tilt motors as defined in WYSIWYG.

Fade Time sets the length of time it takes for a fixture to douse and then restore after pan stops. Fade
Time applies to the operation of the fade itself when the fixture freezes in place, douses out, performs
the pan-flip, then fades back up using the specified time. The default Fade Time value is 0 which snaps
the fixture off as in previous versions.

Additional Doused Time adds delay time before the fixture fades back up. (For example, in cases where
the fixture is slower than the WYSIWYG settings on file)

 To set fade time and additional doused time

In the Edit Chapters widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Basic tab in the Fixture Settings widget.4.
On the Fade Time scroll box under the Pan-Flip section, click the Up or Down arrows or type a5.
value to add extra pan-flip douse time.
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On the Additional Doused Time scroll box under the Pan-Flip section, click the Up or Down arrows6.
or type a value to add extra pan-flip douse time.

Note: The range of time is limited to 0-3 seconds.
For the changes to take effect, click Apply Changes.7.

Notes:

If another Pan-Flip occurs before the current fade is complete, the fixture will finish the fade,
perform the new pan-flip, then fade back up.
If the fixture performs two Pan-Flips in the same direction while the light is still fading out, it will
cancel both Pan-Flips and move to the new position while fading back up as it will be back within
the original pan range.

Auto Dimming
Note: For conventional LED fixtures without a built-in intensity or dimmer channel, BlackTrax substitutes
a virtual dimmer for RGB or RGBW to control Intensity. The Virtual Dimmer that was used will be reported
in the BTWYG Patch widget.

Smooth Pickups
This feature turns the fixture On once as a single event per chapter, only when the Beacon is visible.

BlackTrax checks for motion at the beginning of the chapter.
BlackTrax automatically douses the fixture to 0 if motion is not detected. When motion is seen, the
fixture fades in to console control over the fade time specified once the Trackable Visible For: time
has elapsed (motion must be seen continuously during this time for the fade to start).
When completed, the Smooth Pickups feature is disabled for the remainder of the chapter.
Smooth Pickups is disabled by default.

      To enable and set smooth pickups

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
Under the Auto Dimming section of the Basic tab, select the checkbox Smooth Pickups checkbox.5.

Result: Trackable Visible For and Fade-in Time scroll boxes are displayed.
Click on the Trackable Visible For scroll box to set the length of time required for a Trackable to be6.
visible and the light to fade-in.
Click on the Fade-in Time scroll box to set how long the light fades-in.7.
For the changes to take effect, click Apply Changes.8.

Auto Douse
This feature turns the fixture On only when the Beacon is visible and as an ongoing event all throughout
the course of the chapter.

If all LEDs of the patched Beacon becomes hidden, BlackTrax automatically douses the fixture to 0
(from console control) after the reaction time is complete.
BlackTrax automatically fades in the fixture when at least one LED is visible and after the reaction
time is complete.
Reaction time is the length of time required for motion to be visible, or to be hidden before the fade
time starts.
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      To enable and set auto douse

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
Under the Auto Dimming section of the Basic tab, select the Auto Douse checkbox.5.

Result: The Reaction Time, Fade-In Time, and Fade-Out Time, scroll boxes are displayed.
Click on the Reaction Time scroll box to set the length of hidden or visible time for fade time to6.
start.
Click on the Fade-In Time scroll box to set how long the light fades-in.7.
Click on the Fade-Out Time scroll box to set how long the light fades-out. 8.
For the changes to take effect, click Apply Changes.9.

Following Sensitivity
Sensitivity determines exactly how a fixture is supposed to follow a Trackable. The prediction algorithms
takes the current BTBeacon and fixture information and makes an informed prediction on where the
Trackable will be next. The BTSystem will then be able to anticipate where the fixture needs to aim to
keep tracking tight on the Trackable.

The prediction algorithm available are:

None: No prediction is used.
Note: When the Following Sensitivity is set to None or Multiple, the Ahead Time and Delay
Time settings and options are not displayed.

Standard Prediction: Taking the pan and tilt settings of fixtures following the Trackable, a Kalman
filter is used to estimate the velocity and poisition of the fixture. A prediction of the fixture's future
pan/tilt values is then created.
Delay: Fixtures will follow a Trackable’s position after a set amount of time. This causes fixtures to
follow behind moving Trackables. Useful for effects.
Linear Prediction: Taking the current BTBeacon position as input, a Kalman filter is used to estimate
the velocity, and position of the Trackable. A prediction of the Trackable’s future movement is then
created.
Second Order Prediction: Taking the current BTBeacon position as input, a Kalman filter is used to
estimate the acceleration, velocity, and position of the Trackable. A prediction of the Trackable’s
future movement is then created.
Second Order+Prediction: Taking the pan and tilt settings of fixtures following the Trackable, a
Kalman filter is used to estimate the acceleration, velocity, and position of the fixture. A prediction
of the fixture’s future pan/tilt values is then created.

Fixture responsiveness can also be configured with prediction. Fixture responsiveness is measured on a
scale of -4 (Smooth) to 2 (Responsive).

Smooth: A fixture set to smooth will follow Trackables in a fluid manner. This may appear as a
delay in extreme cases.
Responsive: A fixture set to responsive will jump to and track every slight movement of a
Trackable. This may appear very jumpy in extreme cases.

Note: It is recommended that you test a fixture’s prediction prior to use, to determine if the chosen
prediction movement is right for your tracking needs.
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To assign an algorithm to a fixture

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
Under the Following Sensitivity section in the Basic tab, select the desired sensitivity from the5.
Sensitivity drop-down menu.

If you want the fixture to be tracking ahead of where the Trackable will be, enter how far
ahead in time (milliseconds) in the Ahead Time field.

Assign how reactive you want the fixture to follow by adjusting the Turner value slider to between6.
Smooth or Responsive.
For the changes to take effect, click Apply Changes.7.
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Offset Tab
Offset tab is where you configure LED Following Settings for selecting which individual LEDs of a
BTBeacon assigned to follow a Trackable should follow.

 Fixture Settings - Offset tab

LED Following Settings
Each Trackable can have the LEDs of assigned BTBeacons tracked individually by the BTSystem. This can
be used instead of the default setting which is the average position of all visible LEDs. Tracking can also
be altered, to follow a Trackable but on an offset.

LED Following Settings drop-down menu is enabled for both moving and conventional fixtures. Enable
Offset checkbox is enabled for moving fixtures and disabled for conventional fixtures.

To assign a fixture to an individual LED of a trackable

In the Edit Chapters widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture will be displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
On the LED Following Settings section, click on the drop-down menu and choose the LED you5.
want to follow.
For the changes to take effect, click Apply Changes.6.

To offset the tracking of a trackable by a fixture

In the Edit Chapters widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture will be displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
Under the LED Following Settings section, select the Enable Offset checkbox to set the tracking5.
offset from the X, Y, or Z axis.
Under the Offset subsection, enter how far off from the centroid you want to offset tracking in the6.
X, Y or Z axis by entering the values in the X, Y or Z fields.
For the changes to take effect, click Apply Changes.7.
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Auto Spot Tab
Auto Spot tab is where you configure the following properties of a fixture to better mimic a human follow
spot operator.

 Fixture Settings - Auto Spot tab

Auto Spot Mode Settings
Auto Spot Mode is where a fixture simulates the behavior of a manual follow spot. In normal operation,
moving fixtures will lock on to a Trackable and follow all movement, even if the movement is very slight.
This has the possibility of making the fixture’s light look shaky or jittery. In Auto Spot Mode, when a
Trackable is relatively still, the following fixture will freeze in place. When the Trackable starts to make
larger movements, and/or attempt to exit the frozen light beam, the fixture will unfreeze and continue
following tightly.

There are two different follow spot modes to choose from. They can be used independently or together.
The different auto spot modes are:

Local Damping: The system will ignore small movements on all axis. Select the Enable Local
Damping Mode checkbox to display Radius and Enter Time.

Radius: Click on the Radius scroll box to adjust the size of the movement. Refer to the
diagram below.

When a given Trackable is only moving within this value, in relation to the Enter Time,
the fixture will freeze in place. A secondary radius will be built around this radius, which
extends past the bounds of the first radius by half the size of the specified radius
setting.
If the Trackable moves outside of the original first radius but still within the secondary
radius, the fixture slowly readjusts to the new position, and the first radius moves to
the new position.
If the Trackable moves outside of the secondary radius, the fixture resumes tracking as
normal, responding to small movements again.  

Diagram:      

Enter Time: Click on the Enter Time scroll box to adjust the length of time that a Trackable
must be within the Radius for the setting to become engaged. The longer the time that the
Trackable is within the radius, the slower the fixture responds to movements until eventually
all movement is ignored.

Z-Damping: The system will ignore small vertical movements on the Z axis. Select the Enable Z-
Damping Mode checkbox to display Damping Time.

If the Trackable stays within a constant range, over the specified time, Z movements slow
down until eventually Z movements are ignored within the distance traveled.
If the Trackable moves outside of the distance measured over the course of the specified
Dampening Time, a new distance range is set.

Note: Auto Spot Mode is determined per fixture, per Chapter.
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To enable auto spot mode for a fixture

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of the selected fixture will be displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget.4.
Under the Auto Spot Mode section, select the checkbox next to the desired Auto Spot Mode(s).5.
For the changes to take effect, click Apply Changes.6.
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Zones Tab
Zones tab is where you configure the interaction of fixtures with any zones in the chapter.

 Fixture Settings - Zones tab

Zone Settings
Zones in the project can be enabled to interact with fixtures following Trackables. When a Trackable or
the beam of a fixture following the Trackable enters a zone, the fixture can be turned on or doused. How
fixtures interact with zones is user definable.

Zones can have their interaction with Trackables and fixtures customized in the following ways:

Douse Out: A fixture will douse when the Trackable it is following interacts with a zone.
Inside Zone: The fixture will be doused while the Trackable is inside the zone.
Outside Zone: The fixture will be doused while the Trackable is outside the zone.

Collision Type: How the Trackable and fixture relationship interacts with the zone.
Beam collision: When the beam of the fixture following the Trackable is in the zone, the
relationship is considered in the zone.

Note: A reflection of the beam will not count. The size of the beam must be set for
Beam collision to work.

Point collision: When the Trackable is physically in the zone, the relationship is considered in
the zone.

To enable a zone for a fixture

In the Chapter widget, select the chapter the fixture is in.1.
On the center pane, click on the Trackable the fixture is assigned to.2.
On the bottom pane, click on the Fixture Icon to select the fixture.3.

Result: The settings of selected fixture are displayed in the Fixture Settings widget.
With the Fixture Icon selected, go to the Fixture Settings widget and click the Zones tab.4.

Result: The Zone Name of the zone where the selected fixture has been assigned is
displayed in Zone field after a Zone has been dragged and dropped from the Libraries widget.
Note: A warning symbol and text tooltip are displayed if errors are detected in Zone settings.
Beam collision warning will not appear for conventional fixtures assigned to a Trackable with
the same Dynamic Zone (but will appear for Point collision and for moving fixtures). See
Zones Issues section below.                                                                                         

 

Under the Zone Settings section, select the Zone Enabled checkbox.5.
Result: The interaction between Zone and Fixture is active.

Select which zone you want the fixture to interact with, on the Zones tab in the Libraries widget,6.
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select the zone then drag and drop on the Zone field in the Fixture Settings tab.
Choose how the fixture douses when entering a zone, select Inside Zone or Outside Zone from the7.
Douse Out drop-down menu.
On the Fade-In Time field, click the Up or Down arrows or type the amount of time the fixture8.
intensity fades-in rather than instantly switch on.
On the Fade-Out Time field, click the Up or Down arrows or type the amount of time the fixture9.
intensity fades-out rather than instantly switch off.
Choose how the fixture interacts with the zone, select Beam collision or Point collision from10.
the Collision Type drop-down menu.
For the changes to take effect, click Apply Changes. 11.

Note: See “BlackTrax Zones” for more information on creating zones for a BlackTrax project.

Zone Collisions
FIXTURE TYPE ZONE

TYPE
DYNAMIC
ZONE
TRACKABLE
ASSIGNMENT

COLLISION
TYPE

RESULTS NOTES

Moving Static - Point Fixture will react when the Trackable
touches the Static Zone.

 

Moving Static - Beam Fixture will react when its beam
touches the Static Zone.

 

Moving Dynamic Self Point Fixture will react when the Trackable
touches the Zone, which is always
true because the Zone moves
around with the Trackable.

Not
recommended

Moving Dynamic Self Beam Fixture will react when its beam
touches the Zone, which is always
true because the Zone moves
around with the Trackable.

Not
recommended

Moving Dynamic Other Point Fixture will react when the Trackable
touches the Zone. The Zone moves
around with other Trackables.

 

Moving Dynamic Other Beam Fixture will react when its beam
touches the Zone. The Zone moves
around with other Trackables.

 

Conventional Static - Point Fixture will react when the Trackable
touches the Static Zone.

 

Conventional Static - Beam Fixture will react when its beam
touches the Static Zone, which is
always true or never happens.

Not
recommended

Conventional Dynamic Self Point Fixture will react when the Trackable
touches the Zone, which is always
true because the Zone moves
around with the Trackable.

Not
recommended
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Conventional Dynamic Self Beam Fixture will react when its beam
touches the Zone. This is always
true because conventional fixtures
do not move.

Most efficient way
to use Zones with
conventional
fixtures

Conventional Dynamic Other Point Fixture will react when the Trackable
touches the Zone. The Zone moves
around with other Trackables.

 

Conventional Dynamic Other Beam Fixture will react when its beam
touches the Zone. The Zone moves
around with other Trackables.

 

Zone Issues
When setting up your zones, you may encounter errors or warning messages.

The following setting combinations will cause errors and/or warnings:

Enabling Beam collision on any fixture without Beam Control: The fixture is in Automated
Mode with neither zoom or iris control enabled. This only applies to moving fixtures as conventional
fixtures are always in Static Mode (which supports Beam collision).                               

A dynamic zone is patched to the same fixture as Trackable: The fixture and/or Trackable
will always hit the Zone, because the Zone is attached to the Trackable the fixture is following. The
one exception is for conventional fixtures using Beam collision, as conventional fixtures cannot
move to point at the Trackable.                                                                                                         

A static zone is patched to a conventional fixture using Beam collision: Neither a
conventional fixture nor a static zone can move, so this combination will either always hit (for
example, if the conventional fixture is pointing at the zone), or never hit.                                          
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Trackable Settings Widget

 Trackable Settings Widget

Overview
The Trackable Settings widget displays information on the selected Trackable, and where you can assign
a Dynamic Zone to the given Trackable. Any BTBeacon or rigid frame assigned to the Trackable will
inherit the Trackable’s settings, and function as directed.

 Trackable Settings Widget with a Dynamic Zone assigned

Dynamic Zone Properties
From the Zone Assignment drop-down menu, you can choose any of the zones present in their file to
become a Dynamic Zone for the selected Trackable. An icon will also be displayed beside the selected
Zone name, displaying the shape of the currently selected zone (Rectangular Zone, Cylindrical Zone, or
Spherical Zone).

Once a Zone is assigned as Dynamic, the Zone will no longer use the drawn (or Static) position for any
Chapter. This can be confirmed in the Libraries Widget, under the Zones tab; the Dynamic checkbox will
appear. A Dynamic Zone will follow the attached Trackable, and any interactions that are programmed
for that Zone (fixtures dousing in or out for example) will be triggered depending on the Trackable's
motion instead of the drawn WYSIWYG position.

By default, the Zone is centered around the centroid of the Trackable, but you can also offset the position
of the Dynamic Zone on the X, Y and Z Axis relative to the centroid.

When Motion is Lost: The user can choose from 3 options for what the Dynamic Zone should do if the
Trackable loses motion:

Keep Position: When the Trackable loses motion, the Dynamic Zone will remain in the last known
position, and fixtures will interact with it in that position until motion is regained.
Assume Inside: When the Trackable loses motion, the fixtures assigned to the Trackable will
assume they are inside the Dynamic Zone, and react based off the current Chapter programming.
Assume Outside: When the Trackable loses motion, the fixtures assigned to the Trackable will
assume they are outside of the Dynamic Zone, and react based off the current Chapter
programming.
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Programming Chapters
The Relationship section displays which Fixtures are assigned to which Trackables in the chapter. The
Libraries widget displays Trackable and fixtures that are available.

Tip: You may use the unified selection methods for multiple selection.

Use Ctrl+A to select all.
Use Left-click to isolate the selection and deselect all the others.

To add a trackable to a chapter

In the Chapter widget, select a chapter you want to add a Trackable to.1.
In the Libraries widget, click the Trackables tab to view available Trackables.2.
On the Trackables tab, select the Trackable you want to add.3.
Click Add.4.

Result: A Trackable Container of the Trackable appears in the Relationship section for the
chapter.
Note: Trackables can also be added to a chapter by dragging and dropping a Trackable from
the Trackables tab into the top section of the center pane.

For the changes to take effect, click Apply Changes.5.

To delete a trackable from a chapter

In the Chapter widget, select a chapter you want to delete a Trackable from.1.
In the Libraries widget, click the Trackables tab to view available Trackables.2.
On the Trackables tab, select the Trackable you want to delete.3.
Click Delete.4.

Result: The Trackable is removed from the Chapter.
Note: You can also drag and drop the Trackable back into the Library or click the delete
button in the Trackable section.

For the changes to take effect, click Apply Changes.5.

To remove all trackables from a chapter

In the Chapter widget, select a chapter where all Trackables will be removed from.1.
In the center pane, select all Trackables in the Chapter.2.
In the center pane, click Delete.3.
For the changes to take effect, click Apply Changes.4.

To assign a fixture to a trackable

When a Fixture is assigned to a Trackable, the BTSystem will instruct the fixture to follow the Trackable.
Fixtures will only follow an assigned Trackable in the chapter they are assigned, and only when that
chapter is active.

In the Chapter widget, select a chapter that has a Trackable you want to assign a fixture to.1.
In the center pane, select the Trackable bubble of the Trackable.2.
View available fixtures by going to the Libraries widget and clicking the Fixtures tab.3.
On the Fixtures tab, select a fixture you want to assign to the Trackable.4.
Click Assign.5.

Result: A Fixture Box of the fixture appears in the bottom section of the center pane
indicating it is assigned to that Trackable.
Note: Fixtures can also be assigned a Trackable by dragging fixtures from the Fixtures tab
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and dropping them onto a Trackable Container.
For the changes to take effect, click Apply Changes.6.

To unassign a fixture from a trackable

In the Chapter widget, select a chapter that has a Trackable you want to unassign a fixture from.1.
In the Libraries widget, click the Fixtures tab.2.
On the Fixtures tab, select the fixture you want to unassign from the Trackable.3.
Click Unassign.4.

Result: The Fixture is removed from the Trackable.
Note: Fixtures can also be removed from Trackables by dragging fixtures from the Trackable
Box to the Libraries widget.

For the changes to take effect, click Apply Changes.5.

To copy and paste a trackable from a chapter to another chapter

In the Edit Chapters widget, select a Chapter with the Trackable you want to copy.1.
In the Chapter widget, click on the Trackable you want to copy.2.
Click the Copy button.3.
In the Edit Chapters widget, select another Chapter you want to paste the copied Trackable.4.
In the Chapter widget, click the Paste button.5.

Result: The Overwrite dialog box appears.
Click Overwrite to cut and paste the selected Trackable or click Keep to cancel the operation and6.
keep the previous Trackable.

Result: The icon of the copied Trackable appears in the Chapter widget when Overwrite is
selected.

For the changes to take effect, click Apply Changes.7.

To copy and paste the fixtures from a trackable to another trackable

In the Chapter widget, click on the Trackable with the Fixture/s you want to copy.1.
In the bottom section of the Chapter widget, click on the Fixture/s you want to copy.2.
Click the Copy button.3.
In the same Chapter widget, click on another Trackable you want to paste the copied Fixture/s.4.
Click the Paste button.5.

Result: The Overwrite dialog box appears.
Click Overwrite to cut and paste the selected Fixture/s or click Keep to cancel the operation and6.
keep the previous Fixture/s.
For the changes to take effect, click Apply Changes.7.
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Undo Stack
The Undo Stack widget is where you can undo and redo changes applied in Edit View of the BlackTrax,
such as chapter, editing, fixture settings and Trackable renaming. The Undo Stack widget displays all the
editing operations that have been completed in Edit View. Each of the editing operation listed can be
selected to set the Edit View according to the previous state of the selected editing operation history,
however you may only undo a maximum of 10 steps during one undo operation.

Undo Stack widget

 

To go to a point in the editing operations that have been applied

From the View menu, choose Undo Stack.1.
In the Undo Stack widget, from the list on display, click on an editing history that you wish to go to.2.

Result: The Edit View goes to the applied state of BlackTrax in Edit View that is associated
with the selected history in the Undo Stack widget.
Tip: You can also use the keyboard shortcuts Ctrl+Z to undo, or Ctrl+Y to redo.
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Terminal Widget
 Terminal Widget with Syntax for a "Fixture Train"

Overview
The Terminal widget is where you alter fixture following behavior to achieve unique effects.

Attention: Terminal commands affect specified fixtures across all Trackables in the chapter.

To enter a terminal command

In the Edit View, select the chapter you want to affect.1.
Open the Terminal docking widget.2.
Click in the Terminal and enter the command.3.
All commands must end with a semicolon.4.

Fixture Train Command
 Multiple fixtures can follow a Trackable one after the other creating a train or snaking effect. The parts of
the command are as follows:

fixtures= - The fixtures following the Trackable.
Note:

The fixture is identified by the fixture ID used in BlackTrax.
Fixtures will follow in the order stated. Fixtures can be expressed as a range (e.g.
fixtures=1-10), or listed individually (e.g. fixtures=1,7,20).
Fixtures must start and end with a square bracket [ and ] - see the example below

start= - The delay in seconds before the first fixture will start following the Trackable.
step= - The delay in seconds before a fixture will start following the fixture before it.

Example: If step=1s, Fixture 1 will follow the Trackable after 1s, Fixture 2 will follow Fixture
1 1s after that.

span= - The total time in s you want to delay all fixtures by. The delay between each fixture is
determined by the number of fixtures divided by span time.

Example: If you have ten fixtures and the span is 10s, the delay between each fixture will be
1s.

Attention: You can only have a span= for the effect, or start= and step=. You cannot use both at once.

The following is an example of a complete fixture train command to demonstrate how it all comes
together.

Example: delay fixtures=[1-10] start=1 step=1;

In this example fixtures 1 through 10 will follow the Trackable. Fixture 1 will start following 1s after the
Trackable has started moving. Each subsequent fixture will follow the one ahead of it 1s after it moves.
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Error Codes for Unsupported Fixtures
When you add new fixtures in BTWYSIWYG, fixture configuration updates are applied to BlackTrax when
you Apply BTWYG Updates and Apply Changes. 

The Messages dialog box will confirm the project update with the new BTWYG data that has been added
to BlackTrax.

The Messages dialog box will confirm that it has received unsupported fixture configuration displaying
the fixture model profile and the error codes. The descriptions of the error codes are listed below. If you
receive an unsupported fixture error code, please report it to BlackTrax support, with the model, and any
error codes received.

To apply fixture configuration updates from BTWYSIWYG to BlackTrax

In BTWYSIWYG CAD mode, from the BLACKTRAX menu, choose BTX Apply.1.
Results:

The configuration of the fixture(s) that was added in BTWYSIWYG is applied to1.
BlackTrax.
In BlackTrax, the Incoming BTX Update icon in the Status Bar turns to blue.2.

In the Status Bar of BlackTrax, click on the Incoming BTX Update icon and Apply Changes.2.
Note: You can also apply this via the keyboard shortcut CTRL+W or from the File menu.
Result: The configuration of the new fixture(s) is applied to BlackTrax and the Messages
dialog box appears confirming the update. If applicable, the Messages dialog box will display
the fixture model and error codes for unsupported fixtures.

 

Error Codes for Unsupported Fixtures:

NPS No Pan Stepping

NTS No Tilt Stepping

PTOI Pan Tilt Offset Incorrect

ZOI Zoom Offset Incorrect

NZS No Zoom Stepping

IROI Iris Offset Incorrect

NIRS No Iris Stepping

INOI Intensity Offset Incorrect

NINS No Intensity Stepping

NRCS No Red Channel Stepping

NGCS No Green Channel Stepping

NBCS No Blue Channel Stepping
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RGBOI RGB Offset Incorrect

CWOI Color Wheel Offset Incorrect

NCWOI Non Color Wheel Offset Incorrect

GWOI Gobo Wheel Offset Incorrect

AWOI Animation Wheel Offset Incorrect

PWOI Prism Wheel Offset Incorrect

PTCVI Pan and Tilt Channel Values Incorrect

ZCVI Zoom Channel Value Incorrect

IRCVI Iris Channel Value Incorrect

INCVI Intensity Channel Value Incorrect

RGBCVI RGB Channel Values Incorrect

CWCVI Color Wheel Channel Value Incorrect

NCWCVI Non Color Wheel Channel Value Incorrect
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Calibration View
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Sensor Calibration View
 Sensor Calibration View

Note: Access to the Sensor Calibration View menu is available only if the Legacy Mode checkbox in
the Sensor section of the System Configuration widget is not selected. The Sensor Calibration View does
not appear if the Legacy Mode checkbox is selected. The Legacy Mode checkbox is selected by default
when BlackTrax opens for the first time. For more information on Legacy Mode, see Sensors Section in
System Configuration. Legacy Mode is only accessible in BlackTrax 2.5.0 and newer versions.

Overview
The Sensor Calibration View is where you manage Sensor settings from Motive within BlackTrax.

The Sensor Calibration View consists of:

The Sensor View in the center pane, where you can view and monitor the output from BTSensors
(grayscale or 2D tracking data), control sensor settings, enter RAW Mode to focus individual
BTSensors, and launch Motive for BTSensor calibration.
The Sensor Groups widget, where the sensor groupings are displayed, and group settings can be
selected and configured.
The Sensor List widget, where individual Sensors can be selected and renumbered.

Connecting to Sensors in BTNet
After opening a BlackTrax project, you need to activate and connect to the BTSensors in the BlackTrax
network (BTNet).

To connect BTSensors

Use the BTNet Active/BTNet Disabled slider button on the left-hand side of the Status Bar to activate and
connect to the sensors in the BlackTrax Network.

Result:
On the Status Bar, the slider displays BTNet Active, and FPS status appears to indicate the
active connection. (SYNC) will only appear if the BTSensors are being synced when
connected.
The Sensor icon on the right-hand side of the Status Bar displays the number of BTSensors
connected.
The connected BTSensors appear automatically on the Sensor Calibration View.
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Coming from Motive - Controlling
Sensors in BlackTrax
In BlackTrax 2.5, you can access and configure Motive settings directly within the BlackTrax GUI instead
of running Motive separately. This section shows you how to do the following Motive functions in
BlackTrax.

To enable control of sensors in BlackTrax

Go to the Sensor section of the System Configuration widget.1.
On the Sensor section, clear the Legacy Mode checkbox.2.

For more information, see the Sensor Section section in System Configuration.

To connect sensors

On the Status Bar, use the SBTNet Active/BTNet Disabled slider button to connect to the sensors in1.
the BlackTrax Network.

For more information, see the Connecting to Sensors in BTNet section in Sensor Calibration View.

To focus sensors

From the View menu, choose Calibration Views > Sensor Calibration View.1.
Result: BTSensors appear automatically in the Sensor Calibration View. The Sensor Groups,
Sensor List, and Sensor View icons appear on the main toolbar; the Sensor Calibration View
icon appears on the side toolbar.

On the center pane of Sensor Calibration View, click the Focusing button.2.
Result: Sensor Calibration View switches to Focusing mode where sensors are set to Visible
Spectrum; Exposure and Gain settings can be configured.

For more information, see the Sensor View Focusing Mode section in Sensor Calibration View.

To change sensor modes

On the center pane of Sensor Calibration View, click the Focusing button.1.
Result: Sensor Calibration View switches to Focusing mode.

On the center pane of the Sensor Calibration View, click the Tracking button.2.
Result: Sensor Calibration View switches to Tracking mode.

For more information, see the Sensor View Focusing Mode and Sensor View Tracking Mode sections in
Sensor Calibration View.

To configure exposure and gain settings

In Tracking or Focusing mode, select the group of sensors in the Sensor Groups widget.1.
On the Sensor Groups widget or on the center pane of Sensor Calibration View, you can click and2.
enter a new value in the Exposure box and select a new value from the Gain drop-down list.

Result: The new Exposure or Gain settings are applied to the selected group of Sensor(s)
and all BTSensors in that group are updated to the new Exposure or Gain settings.

For more information, see the Sensor Exposure and Gain section in Sensor View.

To rotate sensor view images

On the center pane of Sensor Calibration View, click the Rotate 90º button above the image of a1.
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BTSensor once.
Result: The output image view of the BTSensor rotates clockwise by 90º.

For more information, see the Sensor View Rotation section in Sensor View.

To sync sensors with TimeKeeper

On the Sensor List widget in Sensor Calibration View, click the SYNC button.1.
Result: Custom synchronization with TimeKeeper/eSync is enabled and the Status Bar
displays the active SYNC settings.

For more information, see the Syncing Sensors section in Sensor List Widget.

To calibrate sensors

On the center pane of Sensor Calibration View, click the Sensor Calibration button.1.
Result: The save and launch message dialog box appears.

Click OK.2.
Result: Motive opens in Calibration View with only the 2D viewport and the Sensor
Calibration widget is active. The Devices pane opens with the tabbed Application Settings
pane and configured properly by default.

For more information, see the Calibrating Sensors section in Sensor Calibration View.

To view sensors in 3D

Note: Perspective View in 3D is under development and not yet available in this current version but will
be added in a future version. You can follow these steps if you want to confirm 3D locations, but
BlackTrax will not function in this mode.

On the center pane of Sensor Calibration View, click the Sensor Calibration button.1.
Result: The save and launch message dialog box appears.

Click OK.2.
Result: Motive opens in Calibration View with only the 2D viewport and the Sensor
Calibration widget is active.

On the top toolbar of the Camera Preview pane in Motive, click the Switch To 3D View button.      3.
 Switch To 3D View button

Result: Camera Preview pane switches to Perspective View in 3D.

To view beacons

You can visualize the position of Beacons/LEDs/Trackables in BTWYSIWYG.

From BTWYSIWYG in LIVE mode, open the BlackTrax Panel and connect with BlackTrax.1.
Result: The Shaded view in LIVE mode will display Beacons/LEDs/Trackables in real-time.
Note: On the BlackTrax Panel, you can customize how you interact with Trackables within
the Shaded view and set how fixtures and their beams appear in Shaded view. For more
information, see the Using BTWYSIWYG as a Tracking Visualizer section in BlackTrax
Visualization.

In BlackTrax, you can view Beacons from the 2D viewport of Sensor Calibration View Tracking Mode.

On the center pane of Sensor Calibration View, click the Tracking button.1.
Result: BTWYSIWYG shows the position of Beacons/LEDs/Trackables in real-time. In
BlackTrax, real-time tracking data is being processed and BTSensors are set to Object Mode
and Infrared Spectrum. For more information, see the Sensor View Tracking Mode section in
Sensor View.
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You can view Beacons when RAW Mode is disabled in the Sensor View widget.

Click the Sensor View icon on the main toolbar of the Sensor Calibration View in Tracking Mode or1.
choose Sensor View from the View menu.

Result: The Sensor View widget appears as a floating window showing the output view from
the currently selected BTSensor. For more information, see the Sensor View Widget section in
Sensor Calibration View.

To set maximum residual

Note: 

BlackTrax will always override Maximum Residual to 15 mm by default when coming over from
calibration. Maximum Residual cannot be changed from BlackTrax.
Maximum Residual is set to 15 mm by default and not required to be changed often with Point
Cloud Reconstruction enabled. 

For more information, see the Calibrating Sensors section in Sensor Calibration View.

To determine dropped sensors or missing frames

On the Status Bar, the Sensor number and icon turns red if BTSensors are missing or dropping1.
frames.
On the Sensor View center pane of Sensor Calibration View, a "Missing" label will appear in the2.
name of the BTSensor that drops out or missing frames.
On the Sensor List widget, the corresponding Sensor icon turns red if the BTSensor is dropping3.
frames.

To load a calibration file

From the Portfolio Manager, you can update or replace the calibration file in the current Portfolio.

Open the Portfolio Manager.1.
In the Portfolio Manager, click the Update File(s) button.2.

Result: The Update File(s) dialog box appears.
On the Update File(s) dialog box, select the Motive Calibration checkbox and click the ellipsis3.
button to access, browse, and select the Motive profile or calibration files.

Result: The link appears in the Motive Calibration box.
Click Update Porfolio.4.

Result: The current Portfolio is updated with the selected files. 

For more information, see the Portfolio Manager section.

You can also import a sensor calibration file from the File menu.

From the File menu, choose Import > Sensor Calibration.1.
Result: The Browse window appears.

Select the calibration file and click Open.2.
Result: The current calibration data is replaced.
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Sensor View
 Sensor Output in the center pane

Sensor View Output
Once the connection to BTSensors is activated, BTSensors appear automatically in the Sensor Calibration
View. The list of connected sensors appears on the table in the Sensor List widget and the output image
(2D for Tracking mode or grayscale for Focusing mode) of each BTSensor appear in the center pane.

In the center pane of the Sensor Calibration View:

Each Sensor output image container displays the sensor ID number and the rotation button Rotate
90°.
The Exposure and Gain settings of BTSensors can be configured.
The Sensor Calibration button can be used to launch Motive to calibrate your BTSensors.

When the Sensor Calibration View is in Focusing mode, the image output of the BTSensor(s) appears in
grayscale and the system is not ready to receive real-time motion. For more information, see the
following Sensor View Focusing Mode section.

You can switch the Sensor Calibration View to Tracking mode where real-time tracking data is being
processed and monitored. For more information, see the following Sensor View Tracking Mode section.

In the center pane of the Sensor Calibration View, you can configure the Exposure and Gain of the
selected BTSensor.

The default values for new projects are:

Exposure: 250
Gain: 4
Mode: Focusing

Selecting Sensors
In Tracking or Focusing mode, the BTSensors in the center pane follow the selected group in the Sensor
Groups widget. For example, if All group is selected on the Sensor Groups widget, the output images of
all the Sensors in the group appear in the center pane. If a group with only two BTSensors is selected,
then only the image outputs of the two BTSensors in the selected group appear in the center pane. For
more information on selecting Sensor groups, see Sensor Groups Widget.

In RAW mode, you can select only one BTSensor at a time and only from the Sensor View widget. You
cannot select the BTSensor from the Sensor Groups widget or from the center pane. For more
information, see Sensor View Widget.

Sensor View Rotation
You can rotate the output image view of the selected BTSensor(s) in the center pane. The rotation is
clockwise and in increments of 90 degrees.
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To rotate a BTSensor output image

On the center pane, click the Rotate 90° button of a BTSensor ouput container once.1.
Result:

The output image view of the BTSensor rotates clockwise by 90 degrees.
The completed rotation is saved in the project file and will be the correct rotation when
the file is loaded again.

Note: In portrait mode, the BTSensors will display pillarboxes framing its output image
because the BTSensors are rectangular (not square).

Sensor Exposure and Gain
You can configure the Exposure and Gain settings of the selected BTSensor from the center pane and the
Sensor Groups widget.

To configure the Exposure and Gain settings in the center pane

On the center pane, click on the Exposure box and type a new value.1.
Result: The new Exposure setting is applied to the selected group of Sensor(s) and all
BTSensors in that group are updated to the new Exposure settings.

On the center pane, click on the Gain drop-down box and select a new value.2.
Result: The new Gain setting is applied to the selected group of Sensor(s) and all BTSensors
in that group are updated to the new Gain settings.
Note: The Sensor List widget displays the actual Exposure/Gain settings of the BTSensors. If
any of the Sensors in the group do not match the group settings (i.e. they were changed from
another group) then the settings of the Sensor Group will turn blue to indicate a mismatch.
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Sensor View Focusing Mode
 

When the Sensor Calibration View is in Focusing mode or RAW Mode:

BTSensors are set to minimum quality MJPEG.
BTSensors are set to Visible Spectrum.
BTSensors display a grayscale image output.
Exposure and Gain settings can be configured.
Real-time tracking data is not processed.
Motion Control icon on the Status Bar turns red indicating that the system is not ready to receive
real-time motion.
Motion animation is available.

To switch to Focusing mode

On the center pane of Sensor Calibration View, click the Focusing button.1.
Result: The warning dialog box appears if you entered Focusing mode for the first time. This
message will not appear again until BlackTrax is restarted.                                                    

 
On the warning dialog box, click OK.2.

Result: 
The Sensor Calibration View switches to Focusing mode.
The Motion Control icon on the Status Bar turns red.
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Sensor View Tracking Mode
 

When the Sensor Calibration View is in Tracking mode:

BTSensors are set to Object Mode and Infrared Spectrum.
Real-time tracking data is being processed.
Motion Control on the Status Bar indicates that it is receiving motion information.
Exposure and Gain settings can be configured.

To switch to Tracking mode

On the center pane of Sensor Calibration View, click the Tracking button.1.
Result: 

The center pane displays only the output images from the BTSensors that are included
in the active selected group on the Sensor Groups widget.
Real-time tracking data is being processed.
The Motion Control icon on the Status Bar turns blue indicating that it is receiving
motion information.
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Calibrating Sensors
You can launch Motive in the Calibration configuration from the center pane of the Sensor Calibration
View.

To launch Motive sensor calibration

On the center pane of Sensor Calibration View, click the Sensor Calibration button.1.
Result: The save and launch message dialog box appears.                                                      

      

Note: The step in the dialog box is optional. Motive will ask you to export your calibration file
(.cal) when calibration is complete.

Click OK.2.
Result:

All BTSensors are set to Infrared Spectrum and Object Mode.
All BTSensors' Exposure are automatically set to 2000.
All BTSensors' Gain are automatically set to 4.
All BTSensors are automatically set to 100 FPS.
Active Marker Labeling is set to False.
Reconstruction bounds are disabled.
BlackTrax disconnects from BTNet.
The calibration and profile files in the Portfolio are copied over to Motive and used by
Motive to boot up.
In BlackTrax, a dialog box appears asking to wait for calibration to finish before
proceeding to reconnect to BTNet and the BTSensors.                                                    
    

Motive opens in Calibration preset layout with only the 2D viewport and Sensor Calibration View is3.
active.                                                                                                                                                  

             

Note: For more information on BTSensor calibration, see the BTSensor Calibration section.
When the calibration process is complete and the ground plane is set, close Motive.4.

Result: The calibration file is saved in the system.
On the message dialog box in BlackTrax, click OK.5.

Result:
The saved calibration file is copied to the Project Folder and archived.
The BTNet connection is re-established and set in Tracking mode.
Active Marker Labeling is set to True.
Residual is set to 15 mm.

Note: If you try to close BlackTrax during this process, you will not have the option to cancel
because the process is linear and must complete.
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Sensor Calibration Data
When a new project is created and after BTSensors have been calibrated (see BTSensor Calibration
Settings in Motive for BlackTrax), all sensor serial numbers, exposure, gain, threshold, video type, and
intensity are saved in the BlackTrax project file, loaded every time the project is opened, and the
connection to BTNet is enabled.

When you open a project with a completed calibration file, the saved calibration file is loaded, and Sensor
settings are pushed to the BTSensors.

You can also import and load a calibration file manually via the File > Import > Sensor Calibration
menu. For more information on importing calibration data, see File Menu.
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Sensor Groups Widget

 Sensor Groups widget

The Sensor Groups widget is where you manage the sensor settings of BTSensors in groups. Sensor
Groups are created from the Sensor List widget. The Sensor Groups widget is only accessible in the
Sensor Calibration View.

In the Sensor Groups widget, you can:

Create or delete Sensor Groups.
Configure the Exposure setting for all BTSensors in a group.
Configure the Gain setting for all BTSensors in a group.

The table in the Sensor Groups widget displays the following information:

Name: The name of a Sensor Group that was defined.
Exposure: The Exposure setting of the Sensor Group. If the value is displayed in white, all
BTSensors in the Sensor Group have the same Exposure setting. If the value is displayed in blue,
not all BTSensors in the Sensor Group have the same Exposure setting.
Gain: The Gain setting of the Sensor Group. If the value is displayed in white, all BTSensors in the
Sensor Group have the same Gain setting. If the value is displayed in blue, not all BTSensors in the
Sensor Group have the same Gain setting.

To create a sensor group

On the Sensor List widget or the center pane of Sensor Calibration View, select the BTSensors you1.
want to add to the Sensor Group.
On the Sensor Groups widget, click the Add button at the bottom.2.

Result: The create a Sensor Group dialog box appears.
Type the name of the new Sensor Group in the box.3.
Click OK.4.

Result: The name of the new Sensor Group appears on the Name cell in the table and all the
BTSensors selected are added to the Sensor Group.

To remove a sensor group

On the Sensor Groups widget, select a Sensor Group from the table.1.
At the bottom of the Sensor Groups widget, click the Delete button.2.

Result: The selected Sensor Group is deleted from the table in the Sensor Groups widget and
the deleted Sensor Group Name will disappear from the Sensor List widget.

To change the exposure of a sensor group

On the Sensor Groups widget, double-click on the Exposure cell of the selected Sensor Group row.1.
Type a new value on the highlighted Exposure cell.2.
Press ENTER on your keyboard.3.

Result: The new Exposure setting appears in the table and applies to all the BTSensors of
the Sensor Group.

To change the gain of a sensor group
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On the Sensor Groups widget, double-click on the Gain cell of the selected Sensor Group row.1.
Select a new value from the Gain drop-down list.2.

Result: The new Gain setting appears in the table and applies to all the BTSensors of the
Sensor Group.

LTP for Sensors in multiple Sensor Groups
When you change the Exposure or Gain settings in a Sensor Group, it affects all the sensor settings. If the
same Sensor is assigned to multiple Sensor Groups, the Sensor responds to an LTP (Latest Takes Priority)
rule.

Example: If you have the same Sensor assigned in Sensor Group A and Sensor Group B.

In Sensor Group A, if you change Exposure to 4000 and update the Sensor Group.1.
Result: The Exposure value in Sensor Group B turns blue because the Sensors do not match
its settings anymore.

If you change or update a setting in Sensor Group B.2.
Result: The Sensors receive the update from Sensor Group B then Sensor Group A turns
blue.

The latest changes always take effect for all the Sensors within the Sensor Group regardless of the other
Sensor Groups and their settings.
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Sensor List Widget

 Sensor List Widget

The Sensor List widget displays the table of BTSensors connected to BlackTrax. The Sensor List widget is
only accessible in the Sensor Calibration View.

In the Sensor List widget, you can:

Change the ID number of a BTSensor.
Assign a BTSensor to a Sensor Group.
Remove a BTSensor from a Sensor Group.
Enable synchronization settings.

The table in the Sensor List widget displays the following information:

ID: An ID number is generated automatically when the BTSensors are connected to BlackTrax.
Group(s): The name of the Sensor Group the BTSensor is assigned to.
Settings: Exposure/Gain settings of the BTSensor.

To renumber a BTSensor

On the Sensor List widget, double-click the ID cell of a BTSensor in the table of BTSensors.1.
Type a new ID number in the highlighted cell.2.
Press ENTER on your keyboard.3.

Result: The new ID number appears on the ID cell of the selected BTSensor in the table and
the default Motive ID appears in brackets beside the new ID number.
Note:

If a duplicate ID is detected, a warning dialog box will appear indicating "Sensor ID
already exists, please enter a different ID."
The ID will only update for the BlackTrax Software. The BTSensor display and Motive
will display the Motive ID.

To assign a BTSensor to an existing sensor group

On the Sensor List widget, right-click on a BTSensor and choose Assign To Group from the menu1.
that appears.

Tip: You can also select several BTSensors and right-click to choose the Assign To Group
menu.
Result: The list of available Sensor Groups appears in a dialog box.

On the dialog box, select the Sensor Group and click OK.2.
Result: The name of the selected Sensor Group appears in the Group(s) cell of the selected
BTSensor in the Sensor List widget.

To remove a BTSensor from a sensor group

On the Sensor Groups widget, select to display and be in the Sensor Group where you want to1.
remove the BTSensor from.
On the Sensor List widget, right-click on a BTSensor and choose Remove from Group from the2.
menu that appears.
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Tip: You can also select several BTSensors and right-click to choose the Remove from
Group menu.
Result: The selected BTSensor is removed from the Sensor Group.

Syncing Sensors
The SYNC button at the bottom of the Sensor List widget enables custom synchronization, sets the SYNC
offset to 5000 µs and the TimeKeeper/eSync with the connected BTSensors.

To enable and disable sync with BTSensors

At the bottom of the Sensor List widget, click the SYNC button.1.
Result: Custom synchronization settings are enabled, and the Status Bar displays the active
SYNC settings.
Note: BTSensors will report lost frames while SYNC is enabled.

With SYNC enabled, click the SYNC button again to disable SYNC and set the BTSensors to 30 FPS.2.
Note: 

When you are syncing, the BTSensors can have a maximum exposure of 8000 µs.
When you are not syncing, the BTSensors can have a maximum exposure of 30000 µs.
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Sensor View Widget

 Sensor View widget - RAW Mode disabled

The Sensor View widget is a floating widget that displays the grayscale image output from a selected
BTSensor. The Sensor View widget can be accessed only from the Sensor Calibration View.

In the Sensor View widget, you can:

View the grayscale image output from a selected BTSensor.
Switch the current image output view from one BTSensor to the next or back to the previously
selected BTSensor.
Enable RAW Mode in Sensor View widget. For more information on RAW Mode, see the Sensor View
in RAW Mode section below.

To open the Sensor View widget

From the View menu in Sensor Calibration View, choose Sensor View.1.
Tip: You can also click the Sensor View icon on the main toolbar of the Sensor Calibration
View.
Result: The Sensor View widget appears as a floating window showing the image output
view from the currently selected BTSensor in eithier Tracking or Focusing mode.

To switch views between BTSensors

On top of the Sensor View widget, click the Forward or Back arrows to advance to the next1.
BTSensor output view or to the previous BTSensor output view.

Tip: You can type a number in the text box and press ENTER on your keyboard.
Result: The Sensor View widget displays the corresponding image output view from the
currently selected BTSensor.

Sensor View in RAW Mode

 Sensor View widget - RAW Mode enabled

When the Sensor View widget is in RAW Mode, the RAW image output from the selected BTSensor is
displayed in an uncompressed grayscale image and Visible Spectrum. The Exposure and Gain settings of
the currently selected BTSensor can be configured in RAW Mode.

Only one BTSensor can be set to RAW Mode at a time. When you switch to a different BTSensor, the
previous BTSensor returns to its original settings as defined in the Sensor List widget.

To enable RAW Mode in the Sensor View widget

On top of the Sensor View widget, click the RAW Mode button.1.
Result: 
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The image output view from the selected BTSensor appears in RAW grayscale and
Visible Spectrum.
Exposure text box and Gain drop-down list are enabled.

To configure Exposure and Gain in RAW Mode

In the Exposure text box at the top of the Sensor View widget, type a new Exposure value.1.
Result: The new Exposure value is applied to the BTSensor that is currently selected and
viewed.

Click the Gain drop-down list and select the new Gain value.2.
Result: The new Gain value is applied to the BTSensor that is currently selected and viewed.
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Fixture Calibration View
 Fixture Calibration View 

The Fixture Calibration View is where you calibrate the position of fixtures to ensure fixture tracking is
precise and accurate. In the Fixtures section:

BTBeacons are assigned to fixtures.
Fixtures can be set into groups for convenient selection.
Calibration data collected are saved as presets which can be recalled in the Edit Chapters widget
and displayed in the Running Chapters widget.
A maximum of 24 presets are available for the calibration of fixtures in multiple positions.

To have a fixture follow an assigned Trackable, BlackTrax first determines the position of the Trackable.
This is done using the BTSensors and the BTBeacon assigned to the Trackable. BlackTrax references
where a fixture is based on information collected from the BTWYSIWYG .btx file. Based on the Trackable
and fixture positions, the BTSystem calculates the pan and tilt angles a fixture need to be at for it to be
aiming at a Trackable. This information is then sent to the fixture where it changes its pan and tilt
settings accordingly to aim at the Trackable.

Note: If there are inconsistencies between the location of fixtures in the Space, and the virtual Space in
BTWYSIWYG, tracking information BlackTrax creates for the fixture will be inaccurate.

Fixture calibration allows you to correct these inconsistencies and ensures the location of fixtures is
accurate. It is recommended that all fixtures be calibrated when they are first installed in the Space, and
individually anytime a fixture is moved or bumped.

Attention: 

Discard Changes and Apply Changes are disabled during Calibration Mode.1.
Settings made in the Fixture Calibration page will not be applied until BlackTrax is set to2.
Following and Calibration Mode.

Assigning beacons to fixtures for calibration

From the View menu, choose Calibration Views and then choose Fixture View.1.
Result: BlackTrax GUI opens the calibration mode widgets.

From the Preset: drop-down list, select the preset number.2.
Note: The preset numbers displayed will not change.
Tip: You may click Rename to type a new name for the selected preset.

Highlight a fixture (or fixtures) in the center pane of the BTGUI. 3.
Right-click Not Assigned under the Assigned Beacon heading. Alternately, select the Assign4.
Beacon Button beside Group.
Select a beacon.5.
Repeat steps 1-4 for all beacons you want to use for fixture calibration.6.
Fixtures will cycle through following the assigned beacon(s) as points are collected.7.
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Fixture Calibration Control Widget
Fixture Calibration Controls Widget

To calibrate a fixture, measurement points must be collected. Measurement points are samples of fixture
and BTBeacon data collected by the BTSystem. Typically this involves a fixture attempting to lock onto a
BTBeacon in the Space. Then with the fixture’s beam frozen in place, moving the Stringer LED so that it is
in the center of the beam.

There are two ways to control how fixtures move for fixture calibration: Follow Beacon, and Pan/Tilt
Sliders.

Follow Beacon: Using this control method, a fixture that has been assigned a beacon, and is currently
active, will attempt to follow a BTBeacon. If there are differences between the original project file and the
actual physical space, fixture following will be inaccurate and be off center from the BTBeacon. This is
normal behavior for uncalibrated fixtures, and will be corrected after successful fixture calibration.

Pan/Tilt Sliders: Using this control method, the pan and tilt sliders in the Measurement section are used
to move selected fixtures.

Selecting a Control Mode for Fixture Calibration
To select a control mode for fixture calibration

In the Fixture Calibration Control widget, select the control method from the Control Mode drop-1.
down menu.

Result: Fixtures will move according to the selected control method.

To move a fixture using the pan/tilt sliders

In the Fixture Calibration view, in the central widget, select the fixture you want to move.1.
Select the control method to Pan/Tilt Sliders.2.
The tilt of the fixture can be moved by adjusting the Tilt slider, or entering the exact angle in the3.
Tilt field.
The pan of the fixture can be moved by adjusting the Pan slider, or entering the exact angle in the4.
Pan field.

Tip: 

You may click the Flip Pan button to reverse the pan/tilt movement without the collection of
measurement points.
You must click Apply Changes after changing a Fixture's inverted status.
Click on the Time scroll box to set a longer time to complete the Flip Pan movement during any of
these operations:

During Fixture Calibration when measurement points are being collected.
When Flip Pan button is clicked but measurement points are not being collected.
When the fixture's pan/tilt reaches the end of its range and performs a Pan Flip movement.

Attention: During Fixture Calibration, when any of the 3 scenarios mentioned above occur, the fixture
will perform a full 180 degree pan/tilt movement which could cause the hang structure to shake. Setting
a longer time to complete the Flip Pan will make the movement smoother and avoid any change in
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position or alignment.

Controlling Zoom and Iris
Zoom and Iris can be controlled from the Fixture Calibration Control widget using the Zoom and Iris
sliders similar to pan and tilt of the selected fixture(s). If the checkboxes for Apply Globally are set, then
the control will apply to all currently active or queued fixtures, otherwise, it will only apply to the
currently selected fixture.

In Fixture Calibration mode, Zoom and Iris control applies only to Fixure(s) assigned to a Beacon or in
"Pan/Tilt Sliders" Control Mode; all other fixtures are released to the lighting console.

Note: A momentary loss of control of your fixtures will happen occasionally while changing the
Zoom and Iris in Fixture Calibration mode. This normal behavior happens only when you use the
sliders to actively control the Zoom and Iris in Fixture Calibration mode.

Clearing Colour and Gobos, and
Controlling Intensity
BlackTrax will also attempt to auto clear any colour and gobos that the console is instructing the fixture
to use. While in Fixture Calibration Mode, BlackTrax will also control the intensity of the fixtures, turning
them on or off based on if they are queued or not.

BlackTrax Wiki 259 May 2021



Fixture Calibration Properties Widget
The Fixture Calibration Properties widget displays the fixture positions and attributes that affect tracking.

Fixture Calibration Properties widget

The Fixture Calibration Properties widget displays:

Selected Fixture: Model Name and Spot ID number of the selected fixture.
X: Horizontal measurement of the selected fixture's position.
Y: Depth measurement of the selected fixture's position.
Z: Vertical measurement of the selected fixture's position.
RX: Rotation angle with reference to the X axis.
RY: Rotation angle with reference to the Y axis.
RZ: Rotation angle with reference to the Z axis.

Note: Slope and Offset values are used in determining the intrinsic perimeters of the fixture, to
accurately map and calculate the DMX->Angle conversion of a fixture.

Pan Motor Slope: Deviation value of the fixture's pan movement with reference to the offset.
Pan Motor Offset: Offset value with reference to the fixture's pan movement origin.
Tilt Motor Slope: Deviation value of the fixture's tilt movement with reference to the offset.
Tilt Motor Offset: Offset value with reference to the fixture's tilt movement origin.
Pan Status: Sets the orientation of the pan movement. Click on the drop-down and select Normal
or Inverted. When a fixture is calibrated, this setting will always revert back to what the fixture is
set to in WYSIWYG.
Tilt Status: Sets the orientation of the tilt movement. Click on this drop-down and select Normal
or Inverted. When a fixture is calibrated, this setting will always revert back to what the fixture is
set to in WYSIWYG.
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Fixture Calibration Points Widget
The Fixture Calibration Points widget displays the measurement points collected that specify the location
and beam position of a selected fixture when aimed at a Trackable.

Fixture Calibration Points widget

The Fixture Calibration Points widget displays:

Table (Columns):

Number column: Calibration point number.
Use: Checkbox to select or deselect the row of data points of the selected fixture. By deselecting a
checkbox, that point will no longer be used as part of the calibration next time the solver is run
(manually or automatically).
X: Horizontal measurement of the LED's position at the time of point collection (Reference: Stage
Left)
Y: Depth measurement of the LED's position at the time of point collection. (Reference: Upstage)
Z: Vertical measurement of the LED's position at the time of point collection. (Reference: Towards
the ceiling).
Pan Angle: Collected pan angle of the selected fixture's moving head or mirror.
Tilt Angle: Collected tilt angle of the selected fixture's moving head or mirror.
Residual: Error tolerance value of the measurement points collected.

Buttons:

Delete All Points: Click this button to erase all points collected from all the fixtures in this chapter.
Delete Point(s): Click this button to erase all selected points collected from the selected fixture.
+Collect Data Point: Click this button to collect new measurement points from the selected
fixture(s) using the current LED position as the position. Also the same as pressing B on the
Beacon. The beam must be frozen for a point to be collected (in Control Mode: Manual, a point may
be collected at any time).
Freeze Beam/Unfreeze Beam: Freezes the fixture in place so that you may move the LED into the
center of the beam to collect a data point. The fixture will no longer respond to the updated motion
until the beam is unfrozen or a point is collected. Also the same as pressing A on the Beacon. Not
available in Control Mode: Manual.
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Fixture Calibration
Table of Contents:

Single and Multi-Fixture Calibration
Multi-Person Calibration

To turn on fixture calibration

On the status bar, click Normal Mode.1.
Result: The BTSystem toggles to Calibration Mode. The features of the Fixture Calibration
view are enabled.

To turn off fixture calibration

On the status bar, click Fixture Calibration.1.
Result: The BTSystem exits Calibration Mode and enter Normal Mode. The features of the
Fixture Calibration page are disabled.
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Single and Multi-Fixture Calibration
To calibrate a fixture, measurements points must be collected. Measurement points are samples of
fixture and BTBeacon data collected by the BTSystem.

You can collect measurements points for a single fixture or multiple fixtures. Each fixture requires its own
measurement points to calibrate correctly.

Attention: For accurate fixture calibration to occur, ensure that BTSensors are correctly calibrated and
accurate first.

Collecting Calibration Data for a Single Fixture
To collect measurement points for a single fixture

In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from1.
the Preset: drop-down list. You may click Rename to type a new name for the selected preset.

Note: The preset numbers displayed will not change.
Result: The measurement points for the single fixture will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.

In BlackTrax, in the Fixture Calibration view, in the Fixtures section, select the fixture that needs to2.
be calibrated.
A BTBeacon will be used to calibrate the fixture. Click Assign Beacon to view a drop-down list of all3.
available BTBeacons.
Select the desired BTBeacon from the drop-down list.4.

Result: The selected fixture will follow the selected BTBeacon in the Space.
In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to5.
port 1 of the BTBeacon.
Move the BTBeacon to a point within the Space.6.

Result: The selected fixture should be following the BTBeacon in the Space.
Attention: The LED of the Stringer must be visible to 2 or more BTSensors simultaneously
for tracking to occur.

At a point in the Space with the fixture following the BTBeacon, in BlackTrax click Freeze Beam.7.
Tip: Pressing the A button on the BTBeacon being tracked activates Freeze Beam remotely.
Result: The fixture will stop in place.

In the Physical Space, put the Stringer LED as close to the center of the fixture beam as possible.8.
With the LED still in the center of the beam, in BlackTrax click Collect Data Point.9.

Tip: Pressing the B button on the BTBeacon being tracked activates Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and fixture as a measurement point
when Collect Data Point is selected. It will add the data to the Fixture Calibration Points
section. The fixture will unfreeze and continue following the BTBeacon. The fixture will also
pan-flip after collecting a point to ensure you are collecting points on both sides of the tilt
range.

At a different location in the Space, repeat steps 5 to 8 until you create a total of 5 measurement10.
points.

Attention: The minimum number of measurement points needed for calibration is 5.
Note:

For best results the measurement points samples should be at different points in the
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Space, creating different pan and tilt angles. It is recommended to take measurement
points in different areas of the Space and at different heights, creating the most
variation.
Points should be collected until the fixture is calibrated (typically 5-8 but sometimes
more). The fixture will auto-calibrate after each point once 5 points have been
achieved. Auto-calibration feature can be turned off in settings.

Collecting Calibration Data for Multiple Fixtures
Multiple fixtures can be calibrated at the same time to speed up the fixture calibration process. It may be
easier to first assign the desired fixtures into a single fixture group. The fixtures are calibrated as normal
by capturing measurement points for each fixture, but with the additional ability to cycle through the
fixtures in the fixture group.

To create a fixture group

In the Fixture section, select the fixtures that need to be calibrated.1.
In the Group drop-down list, select New Group From Selected....2.

Result: The New Fixture Group window appears.
In the New Fixture Group window, enter a name for the fixture group in the Group Name field.3.
Click OK.4.

Result: The selected fixtures are joined in a fixture group.

To collect measurement points for multiple fixtures

In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from1.
the Preset: drop-down list. You may click Rename to type a new name for the selected preset.

Note: The preset numbers displayed will not change.
Result: The measurement points for the multiple fixtures will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.

In BlackTrax, in the Fixture Calibration view, in the Fixtures section, use CTRL to select all fixtures2.
you want to calibrate.
A BTBeacon will need to be used to calibrate the fixtures. Click Assign Beacon to view a drop-down3.
list of all available BTBeacons.
Select the desired BTBeacon from the drop-down list.4.

Result: The selected fixture will follow the selected BTBeacon in the Space.
In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to5.
port 1 of the BTBeacon.
Move the BTBeacon to a point within the Space.6.

Result: The first fixture of the selected fixture group should be following the BTBeacon in the
Space. All fixtures will follow the BTBeacon in the Space. Only the active fixture will turn on,
the rest are doused.
Attention: The LED of the Stringer must be visible to 2 or more BTSensors simultaneously
for tracking to occur.

At a point in the Space with the fixture following the BTBeacon, in BlackTrax click Freeze Beam.7.
Tip: Pressing the A button on the BTBeacon being tracked will activate Freeze Beam
remotely.
Result: The fixture will stop in place.
Attention: You will not be able to use Freeze Beam if the BTBeacon is not tracked within the
Space.
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In the Physical Space put the Stringer LED as close to the center of the fixture beam as possible.8.
With the LED still in the center of the beam, in BlackTrax click Collect Data Point.9.

Tip: Pressing the B button on the BTBeacon being tracked activates Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and fixture as a measurement point
when Collect Data Point is clicked. It will add the data to the Fixture Calibration Points
section. The fixture will douse, flip, then the next fixture in sequence will turn on.

Collect a measurement point for the currently selected fixture.10.
Continue cycling through fixtures and collecting measurement points at the current location until11.
every fixture has one measurement point at that location.
At a different location in the Space, repeat steps 5 to 10 until you create a total of 5 measurement12.
points for each fixture.

Attention: The minimum number of measurement points needed for calibration is 5.
Note: For best results the measurement points samples should be at different points in the
Space, creating different pan and tilt angles. It is recommended to take measurement points
in different areas of the Space and at different heights, creating the most variation.

To calibrate a fixture using collected measurement points

Once measurement points are created for a fixture, they can be used to create calibration data for the
fixture and determine the fixtures calibrated position.

In the Fixtures section, select the fixture that needs to be calibrated.1.
Note: In the Fixture Calibration Points section, have a minimum of 5 measurement points
created.

Click Calibrate Selection.2.
Result: Calibration data is created from the measurement points and displayed in the
Calibration Results section under the Calibration Status column. The Calibration Status is
automatically applied to fixtures. In the Fixtures section, the Calibrated field for the fixture
will change to (green) to indicate that calibration data was created and that it is applied to
the fixture. In the Fixture Calibration Points section, in the Calibration Error (Residual)
column, residual values are created for each measurement point.

Copying Calibration Data Presets
Fixture calibration data can be copied between Presets in the Copy to Preset window.

To copy a calibration preset

In the Fixtures section of the Fixture Calibration View, right-click on a Fixture (or Fixtures) with1.
calibration data that you want to copy.

Tip: Use the keyboard Ctrl or Shift to select and right-click multiple fixtures. 
Select Copy to Preset from the menu options that appear.2.

Result: The Copy to Preset window appears and displays: the list of Presets (ID and Name)
where you can paste the copied calibration data, the name of the Preset that will be copied,

and the number of selected Presets.                                                           Copy

to Preset window
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On the Copy to Preset window, click on a Preset (or Presets) where the calibration data will be3.
copied to.

Result: The selected Preset (or Presets) is highlighted.
Notes: 

Use the keyboard Ctrl or Shift to select and highlight multiple Presets.
Clear Selection: You may click the Clear Selection button to clear your selected Presets
and remove the highlight.
Select All: You may click the Select All button to select and highlight all the Presets
displayed in the Copy to Preset window.

Click the Copy button.4.
Result: The fixture calibration data is copied to the selected Preset and the Copy to Preset
window will close.
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Multi-Person Calibration
Multi-Person Fixture Calibration is a feature of BlackTrax, which allows any number of people to
simultaneously calibrate a group of fixtures.

 Fixtures table

Assigning Beacons
When calibrating fixtures, you can assign individual beacons either by group, or on an individual basis. In
the Fixture Table, you can right-click a fixture's Assign Beacon column and select Assign Beacon, or
select multiple fixtures and select the Assign Beacon button at the top of the table. In this window, you
can assign a beacon to your selection of fixtures. Repeat this process as many times as you have
individual beacons you wish to use to calibrate all of your fixtures. 

Active Status
In the Fixture Table, each Fixture has one of the following options as an associated calibration status,
represented in the Active Status column. 

Inactive: Fixtures display this status if not assigned a beacon, and not calibrating, or waiting to
calibrate.
Queued: Fixtures display this status if assigned a beacon for calibration, but currently not being
calibrated. These Fixtures follow the beacon without intensity.
Calibrating: Fixtures display this status if assigned a beacon for calibration, with intensity at full,
and currently being calibrated.
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Refining Calibration Data
After calibrating a fixture, Residuals for each measurement point will be calculated and displayed in the
Fixture Calibration Points widget.

Calibration errors are differences between the calculated pan/tilt values of a fixture and the estimated
pan/tilt values of the fixture, based on all measurement points used in the calibration. A calibration
residual range between 0-0.08 indicates that a given measurement point is accurate relative to the
overall fixture calibration. A collection of high quality samples is necessary for accurate fixture
calibration. In this case, the smaller the number, the better.

A measurement point with a large residual value indicates that it was collected poorly relative to the
other points. Poor quality measurement points should not be used in calibration; they should be removed
and the fixture re-calibrated.

 Fixture Calibration Points widget

To disregard measurement points for a fixture

In the Fixtures widget, select the fixture that has measurement points you want to stop using for1.
calibration.
In the Fixture Calibration Points widget, clear the Use checkbox for any measurement points you2.
will not use.

Result: The selected measurement points will not be used for the fixture’s calibrated
position next time you hit calibrate selection.

Note: If after removing measurement points from a fixture you have less than 5 remaining, you need to
collect more sample measurement points before you recalculate fixture calibration.

To delete measurement points from a fixture

In the Fixtures widget, select the fixture you want to delete measurement points from.1.
In the Fixture Calibration Points widget, select any measurement points you want to delete.2.
Click Delete Point(s).3.

Result: The selected measurement points are deleted from the fixture.

 

BlackTrax Wiki 268 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=201&display


Managing Calibration Data
Fixture calibration data can be saved as a calibration file separate from the BlackTrax project. Calibration
can be saved as a BlackTrax Calibration file (.btcal) which can be read by BlackTrax, or as an XML file for
third-party use. Calibration profiles saved as .btcal files can be loaded and edited as needed in a project.

Fixture calibration data from any preset can be exported or imported into any preset you are
currently in.
The calibration data that was imported becomes part of the preset you are currently in.
The calibration data that was imported remains part of any other presets where data has been
exported from or into already.

Attention: BlackTrax cannot use XML calibration files to further calibrate fixtures. Fixture calibration
saved to this format is only for third party use.

To export calibration data

Created calibration data can be saved separately from the BlackTrax project as a BlackTrax calibration
file (.btcal).

In Fixture Calibration View, ensure that you are currently in the preset that you want to export1.
from.
From the File menu, choose Export and then choose Fixture Calibration. 2.

   Export Calibration Menu

Result: The Export Calibration browse window appears.
In the Export Calibration window, select which calibration file type will be used from the drop-down3.
menu.

Note: To export specific fixtures from a preset, select the desired fixtures before exporting
your calibration data.

Navigate to the location where you want to save the calibration file.4.
In the File Name field, type the name of the calibration session.5.
Click Save.6.

Result: Information on all fixtures (calibrated or not) are saved to the calibration file. The
information will be accurate so long as the calibrated fixtures are not moved or bumped. This
is provided the Motive calibration is the same (relative to the origin).

  Export Calibration Data

To import calibration data

In Fixture Calibration View, ensure that you are currently in the preset that you want to import to.1.
In the Fixtures widget, select the fixtures which have calibration data you want to import.2.
From the File menu, choose Import and then choose Fixture Calibration. 3.

 Import Calibration Menu

Result: The Browse window appears.
In the Browse window, browse to the location where the calibration file (.btcal) is located.4.
Select the .btcal file.5.
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Click Open.6.
Result: The calibration file loads and a report is displayed showing which fixtures have data
imported.
Note: If no fixtures are selected, all fixture data is imported.

  Import Calibration Data

To uncalibrate a fixture

In the Fixtures widget, select the fixtures you want to remove all calibration data from.1.
Click the Clear Selected Data button.2.

Result: All calibration data and measurement points are deleted from the selected fixtures.

To uncalibrate all fixtures in the project

In the Fixtures widget, click Clear All Data.1.
Result: A dialog box appears asking if you really want to clear all calibration data from the
project.

Click Yes.2.
Result: All calibration data are removed from all fixtures in the project.
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Frame Calibration View
Table of Contents:

Body Frames
Frame LEDs Widget
Rigid Frame Construction Widget
Creating Frames

Rigid Frames
Soft Frames

Frame Calibration View

Overview
The Frame Calibration View allows the user to construct Frames from existing beacons and their LEDs.
Frames can be either Rigid of Soft. Rigid Frames are objects that are solid, or objects that will not change
shape such as a table or box. Soft Frames are objects that can change shape, or flexible objects that
move such as a person or inflatable object. Both Rigid and Soft Frames can be created from the Frame
Calibration view, however, each has different requirements.

Rigid Frames
Rigid Frames require a minimum of 3 visible LEDs to be created and tracked. If less than 3 LEDs are
visible at any point, the Rigid Frame will stop being tracked. A Rigid Frame can be composed of several
beacons/LEDs. If a Rigid Frame is composed of more than 3 LEDs and one LED is hidden or removed, the
centroid will remain static relative to the visible LEDs. The centroid can be rotated and moved around
using offsets. That information is saved in the project file.

Soft Frames
Soft Frames are similar to Rigid Frames and only require a single LED to be created and tracked. You can
also create Soft Frames with multiple LEDs. If a Soft Frame is composed of a single LED and the LED is
hidden or removed, then the Frame will no longer be tracked. If a Soft Frame has multiple LEDs and a
single LED becomes hidden or is removed, tracking will continue but shift to follow the centroid of the
remaining LEDs. You can not offset the centroid of a Soft Frame, and no orientation data is calculated.
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Body Frames

Body Frames Widget

Overview
The Body Frames widget (or central widget) in the Frame Calibration View lists the Frames that have
been created. The widget presents a table view listing the Name, Frame ID, the type of Frame (Soft or
Rigid) and the Status of the Frame (LEDs not ready, Ready to Construct and Constructed). In the Body
Frames widget, you can create, clone and remove Rigid and Soft Frames as well as assign a numerical
name to a Frame, similar to a Beacon ID.

Usage
The Body Frames widget is a table of all Frames in the project. The Table is composed of four columns:
Name, Frame ID, Type, and Status; and at the bottom: the Frame ID box, Frame type drop-down, +/-
buttons, clone frame and reset buttons.

Name
The assigned name of the Frame, RF or SF (depending on the type of Frame), followed by the
ID assigned to the Frame when it was created

Frame ID
The ID assigned to the Frame when it was created

Type
The type of Frame (Rigid or Soft)

Status
Red: LEDs not ready.
Yellow: Ready to Construct.
Green: Constructed.

Note: Once the Frame has been constructed but the LEDs assigned to the Frame are not yet seen by the
system, the Frame's status will list out the LEDs that must be seen before it changes to the "Constructed"
status.

Frame ID:
At the bottom of the widget, a text entry field exists to enter the Frame ID, which can be any
number so long as it is not already taken by an existing beacon or Frame in the system.

Type:
The Type drop-down list specifies what type of Frame is being created (Rigid or Soft).

+ button:
The + button adds (create) a Frame to the list after the Frame ID and Type have been
specified.

Delete button:
The Delete button removes a Frame from the list.
Note: Click Yes or Cancel in the delete confirmation dialog that appears.
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Clone the selected frame:
Click this button to copy and paste a selected frame, then type the new frame ID in the Clone
Frame dialog that will appear.

Reset All Frames:
Click this button to reset the frames listed in the table.
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Frame LEDs Widget

 Frame LEDs widget

Overview
The Frame LEDs widget displays all the LEDs assigned to the currently selected Rigid or Soft Frame in the
Frame Calibration View . The widget lists the LEDs assigned in a table format. The columns listed are:
Beacon ID-LED ID, LED Index, Information on the LED placement order, and the Visibility status.

Usage
The Frame LEDs widget is used to assign Beacon LEDs to the currently selected frame in the Body
Frames widget. The widget lists all the LEDs currently assigned to the selected frame in a column format,
with the following columns:

Beacon ID-LED ID
Lists the Beacon ID and the LED ID (example 3-1 is Beacon 3, LED 1).

LED Index
The ID of the LED sorted in order of insertion (before re-ordering).

Info
Lists the information on the LED placement order: Origin, X-Axis, Cross-Product, Additional.
Please refer to Assigning LEDs to a Rigid Frame in Rigid Frames.

Visible
Shows the visibility status icon (Blue for visible, red for not visible, grey for inactive).

You can drag beacons from the global Beacons widget to add to the currently selected frame into this
widget to assign them to the frame.

There are also three buttons at the bottom of the widget:

Remove Selected LEDs
Removes the select LED from the frame.

Re-Order LED: Switch with Previous
Moves the currently selected LED and swaps it with the previous LED, if it is the first in the
list, it will not move.

Re-Order LED: Switch with Next
Moves the currently selected LED and swaps it with the next LED in the list, if it is the last in
the list, it will not move.

You can replace each of the beacons in the Frame LEDs widget.

To replace a beacon

In the Frame LEDs widget, right-click on a selected beacon in the table.1.
Result: The Replace Beacon tooltip is displayed.

Click on the Replace Beacon tooltip.2.
Result: The Replace Beacon dialog box appears.
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From the drop-down list, select the Beacon ID which will replace the selected Beacon.3.
Click OK.4.

Result: The new Beacon ID number is displayed in the table with the corresponding LED ID.

Note: Re-construct the Rigid Frame in the Rigid Frame Construction widget, then click Apply Changes.

 

BlackTrax Wiki 275 May 2021



Rigid Frame Construction Widget
Frame Construction Widget

Overview
The Rigid Frame Construction widget is where you configure and monitor the currently selected frame in
the Body Frames widget. In the Rigid Frame Construction widget, Centroid Offset and the Orientation
Offset can be set and applied separately. All the changes can be applied to the existing frames in the
project. Frames must first be constructed in the Rigid Frame Construction widget before they are ready
for use.

Usage
The Rigid Frame Construction widget displays the currently selected frame, and has several buttons used
to perform various actions on the selected frame, or all frames in the project:

Construct Frame
Creates the solution for the currently selected Rigid Frame.

Set Home
Matches the orientation of the Rigid Frame to align with the world coordinate's orientation.

Reset Frame
Clears the solution for the selected Rigid Frame.

The Current Position and Current Orientation of the selected Rigid Frame list the current position of
the centroid of all LEDs and the current orientation of the selected Rigid Frame. Use the Centroid Offset
and Orientation Offset scroll boxes to change the calculated centroid and offset of the constructed
Rigid Frame.

Soft Frames do not have the capability of offsetting the centroid because the centroid of the frame is
calculated based on the current position of the LEDs in the frame at any given time, and the centroid
may change depending on how many LEDs are visible.

Centroid Offset applies any offsets to the Centroid of the currently selected Rigid Frame after the Rigid
Frame is constructed.

To set the centroid offset values

On the X, Y, and Z, scroll boxes on the Centroid Offset section, click on the Up or Down arrows to1.
adjust the measurement values.

Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 0.01m.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 0.10m.

Orientation Offset applies any offsets to the Orientation of the currently selected Rigid Frame after the
Rigid Frame is constructed.

To set the orientation offset values
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On the Roll, Pitch and Yaw scroll boxes on the Orientation Offset section, click on the Up or Down1.
arrows to adjust the values in the cells.

Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 1 degree.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 10
degrees.
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Creating Frames
Table of Contents:

Rigid Frames
Soft Frames

Overview
Create Frames by creating and assigning a Frame ID in the Body Frames widget, and then assign LEDs to
a selected Frame. Once the LEDs are assigned, you may configure settings for Rigid Frames in the Rigid
Frame Construction widget. In the Rigid Frame Construction widget, you can also monitor the Centroid for
both Rigid and Soft frames, as well as the orientation for Rigid Frames. This section describes the process
of creating both Rigid and Soft frames.
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Rigid Frames
Overview
Rigid Frames are designed to be objects whose shape does not change, and as the name suggests
"rigid", such as a set piece like a table or box. Rigid Frames must have at least 3 LEDs assigned in order
for a solution to be created for the frame. There is no limit to the number of LEDs that can be assigned to
a rigid frame. If at any point less than 3 LEDs are visible for the specific rigid frame, tracking will stop.
This section outlines the creation of a rigid frame.

Creating a Rigid Frame
Create a rigid frame in the Body Frames widget. First, assign an ID to the frame.

To assign an ID to a frame.

Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body1.
Frames widget.
On the drop-down list, click Rigid Body.2.
Click the green + button.3.

Result: The Rigid Frame is created and added to the list in the widget.

Once the frame is created, you may double-click and type a new name on the default name cell, and
press ENTER. By default, a Rigid Frame is given a name of 'RF(ID)'. 

Assigning LEDs to a Rigid Frame
Assign LEDs to a rigid frame by dragging individual beacons from the global Beacons widget to the Frame
LEDs widget with a rigid frame selected in the Body Frames widget.

You must place the LEDs in the correct order on the object as well as in the Frame LEDs widget because
the first three LEDs assigned to a rigid frame defines the orientation of the frame.

The first LED corresponds to the origin of the local coordinate system of the object.
The second LED corresponds to the positive x-axis.
The third LED is special because it can be placed anywhere, but it defines the location of the
positive y-axis in the following way:

Placing the third LED somewhere in the same plane as LED 1 and LED 2, and taking the
cross product of the vectors from the origin to LED 2, and the origin to LED 3 will define
the positive z-direction of the local coordinate system of the rigid body. Use the right-hand
rule to determine the cross-product.
To perform the right-hand rule:

Place the side of the right hand, and place it along the line from the origin (LED 1) to1.
the positive x-axis (LED 2).
Curl the fingers of the right hand towards the line from the origin (LED 1) to LED 3.2.
The direction where the thumb points is the positive z-axis.3.

Once the first three LEDs are placed, any further LEDs added to the rigid body can be placed anywhere
and will be used as additional tracking points for the object, but are not required.
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Constructing the Frame
Once the LEDs have been assigned, the frame can be initialized and the solution can be calculated. Click
Construct Frame in the Rigid Frame Construction widget to initialize and calculate the solution. If the
original solution of the rigid frame changes, BlackTrax will attempt to adjust the existing solution
accordingly. This will change the status of all current frames with LEDs assigned to them from "Done" to
a list of the LEDs that have not yet appeared (visible to the tracking system). Click the Apply
Changes button to send all ready frames to the global Beacons widget(s), and allow them to be assigned
to a trackable. Click the Reset All Frames button to remove the solution from all Frames, but not delete
them. You must click Apply Changes.

 

Set Home
In most situations, it is necessary to align the Rigid Frame's orientation to an acceptable 'home' position.
A home position is where the object will be 0,0,0 for the Roll, Pitch, and Yaw respectively. You can
manually perform this action, but it is much easier to let BlackTrax determine this for you.

To use the set home function

Align the real world object along the same plain as the world coordinate system (ensure your X, Y,1.
and Z directions match where you set the ground plane. An example is to set the front face of the
object facing -Y).
Select your desired Frame.2.
Click Set Home.3.

Result: Your object will now be orientated with Roll at 0, Pitch at 0, and Yaw at 0. The object will rotate
in the same way that the real world coordinate system would rotate. 

Once the object is 'homed', it is easier to offset the centroid and orientation of the Rigid Frame (although
you may do this before you home the object, if desired). Enter the required values into the X, Y, and Z
fields for the centroid (in meters), and Roll, Pitch, and Yaw fields for Orientation (in degrees). These
settings will be applied automatically, based off the time set under System Configuration>Frame
Calibration>Updating offsets interval (seconds). By default, this is set to update 0.5 seconds after the
values are updated.

Note: You do not need to click Apply Changes when doing centroid and orientation offsets or setting the
home orientation.
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Soft Frames
Overview
Soft frames are designed to be objects whose shape can be flexible, such as a person or inflatable object.
Soft frames need a single LED assigned in order for a solution to be created for the frame. There is no
limit to the number of LEDs that can be assigned to a soft frame. If at any point less than 1 LED is visible
for the specific frame, then tracking will stop. This section outlines the creation of a soft frame.

Creating a Soft Frame
Create a soft frame in the Body Frames widget. First, assign an ID to the frame. 

To assign an ID to a frame

Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body1.
Frames widget.
On the drop-down list, click Soft Body.2.
Click the green + button.3.

Result: The Soft Frame is created and added to the list in the Body Frames widget.

Once the frame is created, you may double-click and type a new name on the default name cell, and
click Enter. By default, a Soft Frame is given a name of 'SF(ID)'. You must click Apply Changes after a
name change.

Assigning LEDs to a Soft Frame
Assign LEDs to a soft frame by dragging individual beacons from the global Beacons widget to the Frame
LEDs widget with a soft frame selected in the Body Frames widget. The order of the LEDs for a soft frame
does not matter because all soft frames are tracked at the centroid of the frame.

 

Constructing the Frame
Once the LEDs have been assigned, the frame can be initialized and the solution can be calculated. Click
the Apply Changes button in the Rigid Frame Construction widget to initialize and calculate the solution.
This will change the status of all current frames with LEDs assigned to them from "Done" to a list of the
LEDs that have not yet appeared (visible to the tracking system). This will send all ready frames to the
global Beacons widget(s), and allow them to be assigned to a trackable. The Reset All Frames button will
not affect soft frames. The centroid of a soft frame cannot be set as the centroid is constantly being re-
calculated based on the position of the LEDs that the frame is made up of.
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Global Widgets
Table of contents:

Beacon Patch
BTWYG Patch
Beacons
Messages
System Log
Project Properties
System Configuration

System Section
Fixture Calibration Section
Frame Calibration Section
BTWYG Section
Sensors Section
Beacons Section

Output Configuration
Active Outputs
Edit Output
Sending Trackables
Output Options
Output Configuration Settings for Third Parties

System Status Widget

BlackTrax Wiki 283 May 2021

http://wiki.blacktrax.ca/tiki-index.php?page=Beacon+Patch&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=BTWYG+Patch&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Beacons&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Messages&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=System+Log&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Project+Properties&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=System+Configuration&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=System+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Fixture+Calibration+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Frame+Calibration+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=BTWYG+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Sensors+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Beacons+Section&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Output+Configuration&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Active+Outputs&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Edit+Output&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Sending+Trackables&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Output+Options&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=Output+Configuration+Settings+for+Third+Parties&structure=BlackTrax+GUI
http://wiki.blacktrax.ca/tiki-index.php?page=System+Status+Widget&structure=BlackTrax+GUI


Beacon Patch
The Beacon Patch widget is where information on the BTBeacon, Mini Beacon, Rigid and Soft Frames are
displayed and the assignment of BTBeacons, Mini Beacons, Rigid and Soft Frames to Trackables is
controlled. To know the position of a Trackable in the BTSystem, a BTBeacon or Mini Beacon or Rigid
Frame or Soft Frame must first be assigned to the Trackable. The assignment will link the location of the
BTBeacon/Mini Beacon/Rigid Frame/Soft Frame with the position of the Trackable.

The X, Y, Z position of a Trackable is based on the position of the assigned BTBeacon or Frame's centroid
in the Space. The orientation of a Trackable is based on the IMU within the BTBeacon or the calculated
orientation of a rigid frame. BlackTrax interprets the data based on the configuration of the Trackable as
it was set in the Trackable Settings widget. BTBeacons broadcast data at all times when the BTBeacon is
on, even if it is not assigned.

The Mini Beacon has a single built-in LED, no radio and no internal inertial measurement unit (IMU). The
Mini beacon icon will display only the Mini Beacon number and the centroid positional coordinate.

 Beacon Patch 

Assigning Beacons To A Trackable 
For the BTSystem to detect the location and orientation information of a Trackable, a BTBeacon or Mini
Beacon or Rigid Frame or Soft Frame must first be assigned to a Trackable. The assignment will associate
the data of the BTBeacon with the Trackable.

To assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable

Drag and drop the Beacon Icon of the BTBeacon/Mini Beacon/Rigid Frame/Soft Frame from the1.
Available Beacons section to the Trackable Container of the Trackable in the Available
Trackables section.
Click Apply Changes. 2.

Result: The BTBeacon or Mini Beacon or Rigid Frame or Soft Frame will be assigned to the
Trackable.
Note: Assigning a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable that
already has a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame assigned will cause the
BTBeacon or Mini Beacon or Rigid Frame or Soft Frame that was previously assigned to be
unassigned.

To un-assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame from a Trackable

Drag and drop the Beacon Icon of the assigned BTBeacon/Mini Beacon/Rigid Frame/Soft Frame from1.
the Available Trackables section to the Available Beacons section.
For the changes to take effect, click Apply Changes.2.

Different types of Beacons
There are three different types of beacons, which can be categorized by their heading colour:

Blue: Regular or 'Classic' Beacon - this is a physical BTBeacon connected to stringers
Burgundy: Mini Beacon - this is a physical Mini Beacon connected to stringers
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Orange: A rigid frame - a 'virtual' BTBeacon that is constructed using at least three LEDs from any
number of BTBeacons
Pink: A soft frame - a 'virtual' BTBeacon that is constructed using at least one LED from any
number of BTBeacons

Beacon Patch Filtering
The Available Beacons section can be set to show only the selected types of beacons. By default, the
section opens with all types of Beacons selected.

To select the Beacon type that will appear in this section

On the top right corner of the Available Beacons section, click on the Beacons drop-down menu.1.
Select the checkboxes of either the Classic Beacon, or the Rigid Frame, or the Soft Frame or Mini2.
Beacons that you want to show in the section.

Result: Only the selected Beacon types will appear in the Available Beacons section.

Beacon Data
When BTBeacons are in the Space, their location and orientation are known by the BTSystem. This
information is displayed in the Beacon Icon for easy reference. BTBeacon data can be separated into
three categories: General, Centroid and LED.

Note: If any BTBeacon information is unavailable, it will appear as “?”. This could be because the
BTBeacon LEDs are not visible by the BTSystem, or the LEDs are unplugged.

Beacon Number: This is the identifying number of BTBeacon. It is used to tell BTBeacons apart
and is assigned to the BTBeacon automatically.
Battery Icon: This icon represents the percentage of power remaining in the BTBeacon. The timer
next to the icon gives an estimate of how long the BTBeacon can operate using the current LED
configuration.

Centroid Beacon Data
Centroid BTBeacon data is primarily information based on the average Cartesian coordinates position all
visible LEDs connecting to the BTBeacon. Additional information about the BTBeacon is also displayed.

X : This is the current X coordinate of the BTBeacon. This position is based on the average X
coordinate position of all visible LEDs connected to the BTBeacon.
Y : This is the current Y coordinate of the BTBeacon. This position is based on the average Y
coordinate position of all visible LEDs connected to the BTBeacon.
Z : This is the current Z coordinate of the BTBeacon. This position is based on the average Z
coordinate position of all visible LEDs connected to the BTBeacon.
R : This is the current roll (rotation of X axis) value of the BTBeacon. This is based on the IMU inside
the BTBeacon or the solution based on the rigid frame.
P : This is the current pitch (rotation of Y axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Y : This is the current yaw (rotation of Z axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Button A : This indicates the current status of the A button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in fixture calibration. 
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Button B : This indicates the current status of the B button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in fixture calibration. 

 LED Beacon Data
LED BTBeacon data is information on the individual Cartesian coordinate position of every LED connected
to the BTBeacon.

LED 1 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 1.
LED 1 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 1.
LED 2 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 2.
LED 2 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 2.
LED 3 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 3.
LED 3 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 3.
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BTWYG Patch
The BTWYG Patch widget is where patching information from BTWYSIWYG is displayed. In BTWYSIWYG,
BlackTrax Trackable Frames are created and patched to a DMX and Motion Universe for motion control.
The BlackTrax System tracks the position and location of the Trackable Frames in real-time. See Patching
Trackables in BTWYSIWYG for more information.

 BTWYG Patch

Motion Patching:
WYG Trackable: Name of the Trackable object created in BTWYSIWYG.
WYG Patch ID: The patch name/number assigned to the motion universe corresponding to the
Cartesian axis of the Trackable object.

Consoles:
Console Name: Name of the patched control console.

Console Mode: Console mode setting.

Console Ports: Output ports assigned to the patch universe.

BT Port: Number of assigned BlackTrax System port sending and receiving data.
Port: Number of the output port from the console sending data.
Patched To: Number of the Patch Universe assigned to the console.

Lighting Patching:
Universe: Number of the DMX Universe where the lighting fixtures are patched to.

Spot ID: Assigned identifier number used for automated fixtures.
Offset: Assigned starting DMX value.
Size: Total number of DMX values used in the patched fixture's attributes.
Fixture: Name of the fixture.
Pan Inverted: Yes or No confirms if the fixture pan control attribute is inverted or not.
Tilt Inverted: Yes or No confirms if the fixture tilt control attribute is inverted or not.
Profile: Features of the fixture type.

Fixture Profiles:
Name: Identifies the names of the fixture and its features.
Type: Identifies the type of fixture, Moving Head, Moving Mirror, or Conventional.
Pan/Tilt:

8-bit: Confirms Yes or No if the fixture has 8-bit pan and tilt control.
16-bit: Confirms Yes or No if the fixture has 16-bit pan and tilt control.
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Intensity:
8-bit: Confirms Yes or No if the fixture has 8-bit dimming control.
16-bit: Confirms Yes or No if the fixture has 16-bit dimming control.
Virtual: Appears when the fixture only has RGB or RGBW or RGB with dimmer or HSI.

Zoom:
8-bit: Confirms Yes or No if the fixture has 8-bit zoom control.
16-bit: Confirms Yes or No if the fixture has 16-bit zoom control.

Iris: 
8-bit: Confirms Yes or No if the fixture has 8-bit Iris control.
16-bit: Confirms Yes or No if the fixture has 16-bit iris control.

Errors: Displays the profile errors when fixture modes or control profiles are not fully compatible
with BlackTrax, which is determined when BlackTrax receives the fixture from BTWYSIWYG. For the
list of error codes, see  Error Codes for Unsupported Fixtures.

For example, the Errors column in the Fixture Profile section (below) displays the profile
error referring to the virtual dimming channel values of the Source 4 LED Lustr fixture that
are not supported in BlackTrax.                                                                                                  
          
If an error is reported, the Messages log will appear to alert you of the error. Please contact
BlackTrax Support with the error code reported and the fixture mode to help resolve it.

Zones:
Uri: Source identifier value from BTWYSIWYG.
Name: Name assigned to the zone created in BTWYSIWYG. 

User Origin:
The User Origin will always appear at 0, 0, 0 unless you specify a User Origin in BTWYSIWYG. The
User Origin will display the X, Y, Z relative to the document origin if you specify a User Origin in
BTWYSIWYG.

X: Coordinate value of the origin on the X axis.
Y: Coordinate value of the origin on the Y axis.
Z: Coordinate value of the origin on the Z axis.

To open BTWYG Patch

From the View menu in Live, Edit or Calibration view, choose the BTWYG Patch menu.

Result: The BTWYG Patch Information widget appears.
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Beacons
The Beacons widget is where an overview of the Beacons in the BTSystem is displayed and where
Beacons in the BTSystem are controlled.

Beacons, Mini Beacons, Rigid Frames and Soft Frames seen by the BTSystem.
Battery percentage per Beacon (Mini Beacon does not show Battery Percentage).
Status if the Beacon, Mini Beacon, Rigid Frame or Soft Frame is visible or not.
LED indexes with the corresponding bit codes (binary values) for every Beacon.
You can lock or unlock the Beacon list from the Lock checkbox.
You can add and remove classic Beacons from the new add and remove buttons.

Beacons widget

Beacons Widget Filtering
In the Beacons widget, you can click on either the Beacons tab or the Mini tab or the Rigid tab or the Soft
tab to select the Beacon type that you want to show in this widget.

Detailed Beacon Patch: Click this button to open the Beacon Patch widget.
Beacons tab: Click on the Beacons tab to show Regular or Classic Beacons, which are the physical
BTBeacons connected to the stringer.
Mini tab: Click on the Mini tab to show Mini Beacons, which are the physical Mini Beacons with an
LED embedded on top of the device.
Rigid tab: Click on the Rigid tab to show only the Rigid Frame 'virtual' BTBeacons.
Soft tab: Click on the Soft tab to show only the Soft Frame 'virtual' BTBeacons.
Lock: Select this checkbox to lock the Beacons list and disable the Beacon ID box, adding and
deleting Beacons in the table.(Available only in the Beacons tab.) 

Notes:
When the list is locked, Beacons will not update automatically from radio data.1.
By default, the list is locked when a new project is loaded and when Apply Changes is2.
pressed.

Beacon ID: Assign a unique name for the Beacon. (Available only in the Beacons and Mini tabs.)
Add button: Adds a Beacon to the list in the table. (Available only in the Beacons and Mini tabs.)

Notes:
All Beacons follow a preset rule. (Beacon 1 = LED 1, 2, 3; Beacon 2 = LED 4, 5, 6, etc.)1.
When adding Beacons, you can enter either a single Beacon ID or range. (e.g. 10-45)2.

Delete button: Deletes a Beacon to the list in the table. (Available only in the Beacons and Mini
tabs.)

Specific BTBeacons, Mini Beacons, Rigid Frames or Soft Frames can be assigned to Trackables for specific
chapters. These settings will override any assignment made on the Beacon Patch page.

To assign a BTBeacon, Mini Beacon, Rigid Frame or Soft Frame to a Trackable for a specific
chapter

In the Chapters tab, select the chapter the Trackable is in.1.
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Select a Trackable.2.
Go to the Beacons widget.3.
Drag and drop icons the desired BTBeacon, Mini Beacon, Rigid Frame or Soft Frame from the list4.
onto the currently assigned Beacon of the desired Trackable.

Result: The chosen BTBeacon, Mini Beacon, Rigid Frame or Soft Frame will be assigned to
the Trackable for the specific chapter. A book icon will appear next to the Assignment setting
in the Trackables section.
Note: To revert back to the globally assigned BTBeacon, click the Book icon.

For the changes to take effect, click Apply Changes.5.
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Messages
The Messages widget is where the history of error warnings and status updates of the state of the system
are displayed.

By default, the Messages widget will auto hide from view after 5 seconds of display. You can toggle on or
off the auto hide in the Messages widget.

The Messages widget will appear whenever there is a change to the state of the system, or an error has
occurred. As an alternative, you can manually open the widget by selecting the speech bubble on the
Status Bar.

The Messages widget can be set to appear only when a warning or error message has been generated. In
this mode, the color of the Messages Icon on the Status Bar turns blue when information is added to the
Messages widget.

Messages widget

To disable auto hide

In the Messages widget, clear the Auto Hide checkbox.1.
Click OK.2.

Note: Clicking the OK button will hide the Messages widget manually.

To enable only appears for errors and warnings

In the Messages widget, select the Only Appears For Errors and Warnings checkbox.1.
Click OK.2.

To clear all information

In the Messages widget, click Clear.1.

Result: The Messages widget will be cleared of all the information listed.
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System Log
The System Log widget displays system information about the BlackTrax project. The various features of
the system log are:

Enable Logging: Select this checkbox to log all events in System Log widget.
Log Data: Select this checkbox to record all data transmitted. Used primarily for debugging
purposes.
To File: Select this checkbox to save the System Log to C:\bt_run_time.
Auto Scroll: Select this checkbox to automatically scroll to the latest event when it is created in the
System Log.

Note: If logging data To File is enabled, you may accumulate Gigabytes of data in a single day of use.
We recommend that the log file is removed periodically to conserve BTSystem memory.

 

To set the system log as a separate window

Double-click the System Log heading.

Result: The System Log window appears as a separate window.

To reattached the system log window to BlackTrax

In the System Log window, on the top right of the window, click Attach.

Result: The System Log window reattaches to the main widget.

BlackTrax Wiki 292 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=181&display


Project Properties
The Project Properties widget is where descriptive data and properties of the BlackTrax project are
created, displayed and managed. You can change the properties that were set in the Project Properties
widget.

 Project Properties widget

The Project Properties widget displays the following:

Show Name:  Type the name of the current project in this box.
Show Author:  Type the name of the author of the current project in this box.
DMX Control:  On the Source drop-down menu, select the source of the DMX input for the
Universe and the Chapter Control Channel.  On the Source drop-down menu, select from either Art-
Net or sACN.

Note: As Art-Net starts at 0 instead of 1, universe selection reflects that when changing
between sACN and Art-Net.

Chapter:  Set the Chapter Control Channel number and the Universe for the assigned control
channel of the active Chapter.

Universe: Click on this scroll box to set the Universe for the assigned control channel of the
active Chapter.
Chapter Control Channel:  Click on this scroll box to set the channel number for the control of
the active Chapter.
Note:  Book Control Channel scroll box is displayed in this section when the project is in Multi
Book Mode.  

Merging Channel:  Set the channel number that will only monitor the Merging Channel that was
set in the merge node.

Universe:  Click on this scroll box to set the Universe for the assigned control channel of the
Merging Channel monitor.
Channel:  Click on this scroll box to set the control channel for the Merging channel monitor.
Note: The Merging Channel is a single DMX channel that is patched into your lighting console
to enable the control of moving fixtures from BlackTrax. This can be a dimmer channel that
controls intensity fading between BlackTrax and the lighting console, or a simple On/Off
control. This channel must be patched in your console and set as the trigger channel in your
merge node. See DMX/Ethernet Node for Tracking with Moving Lights.

Display Units:  BlackTrax allows for either metric or imperial measurement to be used. This setting
can be changed in the Display Units section. The default unit settings of BlackTrax is metric.
Loading a project will revert BlackTrax to the default unit of measurement. Click on the Display
Units drop-down menu to select the measurement unit.      

To open the project properties widget

From the Settings menu, choose Project Properties.

Result: The Project Properties widget appears.

To set the DMX control source
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In the Project Properties widget, in DMX Input section, select from the Source drop-down menu.

Result:  The selected source will set the DMX input for the Chapter Control Channel of the BlackTrax
project.

To set the universe and chapter control channel

Open the Project Properties widget.1.
In the Chapter section, click on the Universe scroll box.2.
Click on Chapter Control Channel scroll box.3.

To enable the merging channel monitoring

Open the Project Properties widget.1.
In the Merging Channel section, click on the Universe scroll box.2.
Click on the Channel scroll box.3.

To set the units of measurement

Open the Project Properties widget.1.
In the Display Units section, click on the drop-down menu to select Metric or Imperial.2.
Select the desired measurement type.3.

Result: The selected unit of measurement will apply to the BlackTrax project.

Attention: Inputs will always be in metric.

BlackTrax Wiki 294 May 2021



System Configuration
The System Configuration widget is where BlackTrax software behavior can be configured.

 System Configuration Widget

The System Configuration widget displays the following buttons to access the sections:

System: System prompts can be toggled On or Off. See Editing section page.
Fixture Calibration: Settings that affect the collection of measurement points of the fixtures can be
toggled On or Off. See Fixture Calibration Section page.
Frame Calibration: Click on the Updating offsets interval (seconds) scroll box to set the time
interval for the Centroid and Orientation Offset values to be applied to the selected Rigid Frame.
See Frame Calibration Section page.
BTWYG: Settings that enable incoming and outgoing links to BTWYSIWYG can be toggled On or Off.
See BTWYG Section page.
Sensors: Settings that affect how tracking data is processed by the Sensors, which include Noise
Filter, Legacy Mode, and Pixel Threshold. See Sensors Section page.
Beacons: Settings that affect the function and reporting of Beacons. See Beacons Section page.
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System Section
The System section in the System Configuration widget is where system prompts can be toggled On or
Off.

 System section

System: Toggle system prompts.
Enable confirmation prompts for System Changes: Select this checkbox to display a dialog
box asking for confirmation to proceed when you click Apply Changes, toggle Normal
Mode/Fixture Calibration Mode to switch modes, and click BTNet Active to disconnect from
BTNet. The corresponding dialog boxes will not appear if this checkbox is not selected.
Open most recent Portfolio when BlackTrax starts: Select this checkbox to open BlackTrax
with the last Portfolio that was opened, or clear this checkbox to open the Portfolio Manager
when opening BlackTrax.

Note: The Open most recent Portfolio when BlackTrax starts feature is disabled when a
license check fails while opening the Main GUI of BlackTrax.

Automatically Apply Changes when BlackTrax starts: Select this checkbox to enable
BlackTrax to apply changes automatically when it starts, with Tracker, Follower, and Monitor
running. This checkbox is unchecked by default.

If BTWYG is set to launch with the BlackTrax Portfolio, then BlackTrax applies the
changes only after the BTWYG connection is complete.
If all modules are not running when BlackTrax starts, Automatically Apply Changes
when BlackTrax starts does not activate.

Auto Save Project every (minutes): Select this checkbox to enable, and set the duration of
Auto Saving of the .btprj associated with a Portfolio. Auto Save can happen anywhere from 5
minute to 30 minute intervals, and the timer is activated by editing changes in the BlackTrax
GUI.
Launch BTWYG file with Portfolio: Select this checkbox to open the BTWYG file associated
with the launched Portfolio at time of launch.
Auto Select for Fixture Groups: Select this checkbox to have fixtures in a Fixture Group be
selected automatically in the Libraries Widget when selecting a group from the Group drop-
down list. 
Enable vertical fixture pan lock: Select this checkbox to prevent the pan range of a fixture
from moving when a fixture is within 5 degrees of its "Home" or 0,0 position. This prevents
the fixture from moving sporadically when performing chapter fades, but does result in
slightly less accurate tracking when standing directly below the fixture.
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Fixture Calibration Section
The Fixture Calibration section of the System Configuration widget is where the settings that affect the
collection of measurement points of the fixtures can be toggled On or Off.

  Fixture Calibration section

Fixture Calibration: 
Use calibrated fixture position for beam Zone collisions: Select this checkbox to use the
calibrated beam zone settings of the fixture that was calibrated in BlackTrax. Clear this
checkbox to use the beam zone settings applied to the fixture as drawn in BTWYSIWYG.
Use calibrated fixture position for zoom/iris control: Select this checkbox to use the calibrated
zoom and iris settings of the fixture that was calibrated in BlackTrax. Clear this checkbox to
use the zoom and iris settings applied to the fixture as drawn in BTWYSIWYG. 
Check if motion from beacon is gone: Select this checkbox to disable the collection of
measurement points when the signal from a beacon is not seen and a warning is displayed.
Clear this checkbox to enable the collection of measurement points and the warning will not
be displayed. 
Enable Automatic Calibration: Select this checkbox to enable the automatic collection of the
measurement points after the 5th measurement point and every point thereafter.
Clear Fixture Properties: Select the checkboxes for Clear Colour, Clear Gobo, and Clear
Prism to remove the colour, gobo, and prism attributes from the fixtures selected in
BlackTrax.
The fixture goes to white when Clear Colour is selected.
The gobo is removed from the fixture when Clear Gobo is selected. 
The prism is removed from the fixture when Clear Prism is selected. 
Uncheck All/Check All: Click on Uncheck All or Check All buttons to include or exclude the
colour, gobo, and prism from the selected fixture in BlackTrax.

 

 

BlackTrax Wiki 297 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=646&display


Frame Calibration Section
The Frame Calibration section in the System Configuration widget is where you can set the time interval
for the Centroid and Orientation Offset values of the selected Rigid Frame.

  Frame Calibration section

Frame Calibration: Click on the Updating offsets interval (seconds): scroll box to set the time
interval for the Centroid and Orientation Offset values to be applied to the selected Rigid Frame.
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BTWYG Section
The BTWYG section in the System Configuration widget is where the settings that enable the incoming
and outgoing links to BTWYSIWYG can be toggled On or Off.

 BTWYG section

BTWYG: Toggle incoming and outgoing links to BTWYSIWYG.
Allow outgoing selection to WYSIWYG: Select this checkbox to enable the selection of fixtures
in WYSIWYG from BlackTrax.
Allow incoming selection from WYSIWYG: Select this checkbox to enable the selection of
fixtures and trackables in BlackTrax from WYSIWYG.
Send tracking information to WYSIWYG: Select this checkbox to send information from
BlackTrax to WYSIWYG.  
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Sensors Section
The Sensors section in the System Configuration widget is where you activate and configure Noise Filter,
Pixel threshold, and Legacy Mode settings.

Sensors section

Noise Filter: Determines if the point is valid or not by using a probability algorithm to determine
how likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100
frames, but it then appears for one frame 10m away (typically caused by IR noise), then the filter
tosses that single frame away and continues to track the real LED. As the system does not have a
concept of 'real' and 'fake', the system uses a history to determine the 'real' LED. This means that
in rare cases, noise may pass through the outlier filter if the noise is consistent, such as a
reflection. There are other tricks to mask out reflections and to trim out extra parts of the tracking
area. Please see Motive reconstruction bound settings for more information.

Enable: Select this checkbox to activate the noise filter.
Minimum covariance: Click this scroll box to set how 'wide' or 'narrow' the range of noise
suppression. Minimum covariance affects a higher tolerance of points in a given spectrum.
Maximum z-square score: Click this scroll box to set how 'wide' or 'narrow' the range of noise
suppression. Maximum z-square score affects a wider tolerance of points in a given spectrum.
Maximum iterations: Click this scroll box to set the maximum number of repetitions per frame
the same data point is analyzed to determine the noise level. The range to this field is from 0
to 1000, and the default is 150.

Tip: The easiest way to adjust the outlier filter is to increase or decrease the Minimim
covariance and then click Apply Changes. There is a large range that you may use, so it
is best to step the field by either +0.1 or -0.1 each time to see if the noise becomes
better or worse.

Legacy Mode: If the Legacy Mode checkbox is not selected, Sensor settings, Focusing, and Tracking
will happen within BlackTrax. The Legacy Mode checkbox is selected by default, where you interact
with Motive in the same way as the previous versions of BlackTrax (BlackTrax Version 2.4 and
earlier).

Note: You need to reboot BlackTrax and Motive when switching between Legacy and Non-
Legacy modes as configuration and sensor calibration are reset.

Pixel threshold: Click this scroll box to set minimum brightness value of the sensor(s) output image
in bits. When sensors are in tracking mode, only the pixels with brightness values greater than the
configured value are captured and processed, and all other pixels below the brightness level are
filtered out. Only the clusters of pixels along the threshold are filtered to be considered for stringer
reflections.

Note: 
We do not recommend Pixel threshold values lower than the default 200 to prevent
false reconstructions and noise in the data.
The Pixel threshold option appears only when Legacy Mode is not selected.
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Beacons Section
The Beacons section in the System Configuration widget is where settings that affect Beacon reporting
and behavior within the system can be configured.

 Beacons section

Beacons: Settings that affect the display of Beacon battery life.
Radio becomes stale after (seconds): Click on this scroll box to set how long after a packet of
battery life data of the beacon is received (without receiving new packets) for the radio
indicator in Live View to turn red. The radio indicator is also visible in Table View via the
Radio column. 

Live View:

Icon with Fresh data (Gray)    Icon with Stale data (Red)   Icon

with no orientation data

Table View:

 Radio column with Fresh data (Green)

 Radio column with Stale data (Red)

Number of battery packets to average: Click on this scroll box to set the number of times the
battery life information is collected to be averaged.
Display raw battery values in the Beacon Widget: Select this checkbox to display the raw battery
life percentage (non-averaged) as a separate column in the Beacons Widget.
Frame batteries updated every (minutes): Click on this scroll box to set (in minutes), how the
battery status of the beacons in rigid and soft body frames will update by displaying the lowest
beacon's battery when that timer runs out (and repeats).
Detect battery time based on: Select either 1 Stringer or 2 Stringers or 3 Stringers as the reference
for monitoring the battery life capacity.
Process Classic Beacon Orientation: By default, this checkbox is clear. This will prevent orientation
of Classic Beacons being reported once the Beacon has been patched to a Trackable. Therefore
Classic Beacon orientation will not affect:

Dynamic Zones
Avatar Rotation in BTWYG Live View
RTTrPM Outputs 

Smoothed Centroid Jumps: Select this checkbox to enable the option of setting the timing of the
centroid updating when shifting from one calculated centroid to a newly calculated centroid. For
example, when a Stringer contributing to a centroid becomes hidden from BTSensor view.
Smoothing time (milliseconds): Click on this scroll box to set the time (in milliseconds) it takes for
the calculated centroid updating to complete when a Stringer contributing to a centroid becomes
hidden, or is visible again in the BTSensor view. The shift will be smoother (but takes more time to
complete) when the timing is longer.
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Output Configuration
The Output Configuration widget displays the active tracking output data from the Output Modules and
Trackable Settings as a result of the tracking operation in BlackTrax.

The Output Configuration widget is used by the BTSystem to create, customize and remove Real-
Time Tracking Protocol data for Third Party use (RTTrPL, RTTrPM, and Art-Net).
The Output Configuration widget receives data based on preferences configured in Output
Configuration. The customized data is then sent to designated Third Party programs.

Note: Output Configuration data can be imported and exported for use of current tracking output and
saved for later use. You can activate Import or Export Outputs from the File menu.

 Output Configuration widget

The Output Configuration widget displays the following sections:

Active Outputs: The list data and settings of created outputs for the current BlackTrax project.
See Active Outputs page.
Edit Output: The section for managing the network connections of the selected output. See Edit
Output page.
Sending Trackables: The list of every active Trackable detected by the BTSystem and their third-
party output status (only applicable to RTTrPM outputs). See Sending Trackables page.
Output Options: The section enables you to select which RTTrPM modules to the output of the
selected active module (only applicable to RTTrPM and outputs). See Output Options page.

Note: As a general rule, click Apply Changes to apply all changes that you set in Output Configuration.
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Active Outputs
The Active Outputs section displays the list of output connections that are detected by the BlackTrax
System. The connection settings and output statuses for every active module can be monitored via the
Active Output table. 

Active Outputs section

Enable checkbox: Select the checkbox to enable the active output connection and determine if the
connection is sending data externally.

Note: When the number of active outputs exceed your system's license, the warning dialog
box appears prompting for you to click OK to disable a selected output or click Disable All and
turn off all other outputs. A selected output that is within the number of Licensed Outputs will
be enabled.

Label: The unique name of the active module that you specified for the BTSystem.
Type: The type of data protocol being sent to the selected module.
Output NIC: The IP address where the output is being sent through from the selected active
module.
Communication: The type of connection, such as multicast, unicast or broadcast.
Details: The target IP address where the output data will be sent to.
Status: Connection status of the detected module.
Enable All: Select this checkbox to enable all active output connections and display if all the
licensed outputs are sending output data externally from the server.

Note: The Enable All checkbox is not available if the number of output connections displayed
in the table exceed the number of Licensed Outputs authorized for the BlackTrax system.

Add: Click this button to add a new active output connection.
Delete: Click this button to delete an active output connection.

Note: Deleting an output marks it for deletion and it will be deleted when the user clicks
Apply Changes next. As a general rule, click Apply Changes to apply all changes that you set 
in Output Configuration.
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Edit Output
The Edit Output section is where you can set or change the network data of the output connection
module that is added to the Active Outputs section. You can configure RTTrPM outputs' parameters.

Network Tab

 Network tab

Label: Type the unique name of the active connection module that is added to the Active Outputs
section.
Type: Click on this drop-down menu to select the type of data protocol being sent to the selected
active module.
NIC: Click on this drop-down menu to select the local IP address where the output data is being
sent through for the selected active module.

Notes:
When a project is opened in a server that is missing the saved NIC, BlackTrax will ask
what NIC you would like to use for each output.
When BlackTrax detects an IP change in Windows, the Messages dialog box will alert
you once to reboot BlackTrax to reload the settings.

Communication: Click on this drop-down menu to select the type of IP address in the connection,
such as multicast, unicast or broadcast. The default output address corresponding to multicast and
broadcast will be entered automatically according to the selected type.

Notes:
The default multicast output address for the selected output is entered automatically if
Multicast is selected.
The broadcast output address will be based off the selected NIC for the output and
entered automatically if Broadcast is selected.
The user must enter the unicast address if Unicast is selected.
Address and Port fields are editable per output, where applicable if user settings are
specified instead of the defaults.

Address: The target IP address where the output data will be sent to.
Port: The port number where the IP address for the output data is connected to.
Apply: Click to apply the settings. 

Note: As a general rule, click Apply Changes to apply all changes that you set in Output Configuration.

Advanced Tab

 Advanced tab

Coordinate System: Choose which type of coordinate system to use with positional data. Click on
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this drop-down menu to choose between the Stage (WYSIWYG) or Screen coordinate systems.
Stage (WYSIWYG): In the Stage coordinate system, the Z axis refers to the upward direction,
and Y is on the same plane as the X axis. (Used in WYSIWYG)
Screen: In the Screen coordinate system, the Z (and -Z) axis is on the same plane as the X
axis, and the Y axis refers to the upward direction.

Integer: Choose how integer data is sent. Click on this drop-down menu to change the network
order of integer fields output in RTTrPM packets from Big Endian (Network Order) to Little Endian
(Intel Order).
Float Point: Choose how the float variable value is defined. Click this drop-down menu and select
Big Endian (Network Order) or Little Endian (Intel Order).
Orientation: Click on this drop-down menu to change the Beacon orientation to Euler or Quaternion
coordinates.
Decimal Precision: Click this scroll box and set the decimal point precision for the X, Y, Z values
coming out of the RTTrPM.
Apply: Click to apply the settings.

Note: As a general rule, click Apply Changes to apply all changes that you set in Output Configuration.
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Sending Trackables
The Sending Trackables section is where Trackables are displayed and selected. The Trackable
Settings in the Output Options section are then applied to the selected Trackable.

Beacon IDs and Trackables are sent over RTTrPM.
When you patch a Beacon or Mini Beacon or Rigid Body Frame or Soft Body Frame to a Trackable, a
BlackTrax output sends the name of the Trackable (for example Luke instead of 1).

The position and orientation of the Trackable is generated from the Beacon or Frame that is
patched to it.
When you repatch a Trackable to a different Beacon or Frame, the position of the new Beacon
or Frame is sent to the Trackable and out to the third party.

Beacons and Frames that are not patched to a Trackable will send as Beacon IDs. You can repatch
Trackables to different Beacons and Frames in the BlackTrax software and all connected third
parties will receive the update automatically. You do not need to manually repatch Beacons in
every third party.

 Sending Trackables section

In the Sending Trackables section:

Send Trackables checkbox: Select the checkbox to enable the Trackables tab.
Result: The Trackables tab is displayed.
Note: By default, the Trackables tab is off. Not all third parties are compatible with this
feature; consult with BlackTrax Technical Support or the third party support to confirm
compatibility.

Trackables tab: Click the tab to display the list of Trackables and their output status: Enabled,
Trackable, Patched Beacon and Smoothing.

Enabled: Displays a check mark when enabled.
Trackable: Displays the name of the Trackable.
Patched Beacon: Displays the ID or name of the Beacon or Frame assigned.
Smoothing: Displays the Smoothing value that was set in the Trackable Settings tab.

Beacons/Mini/Rigid/Soft tab: Click the tab to display the table with the list of Trackables.
Enabled: Displays a check mark when enabled.
Beacon: Displays the Beacon ID or name.
Smoothing: Displays the Smoothing value that was set in the Trackable Settings tab.

To enable sending trackable data to third parties

On the Sending Trackables section, select the Send Trackables checkbox.1.
Result: The Trackables tab appears.

Click the Trackables tab or Beacons tab or Mini tab or Rigid tab or Soft tab.2.
Result: The list of detected Trackables/Beacons/Mini Beacons/Rigid Frames/Soft Frames are
displayed in their tabs.

On each of the tab list, select or highlight the Trackable or Beacon or Mini Beacon or Rigid Frame or3.
Soft Frame.
Click Enable Selected.4.

Result: The Enabled column displays a check mark.
Tip: You can select/highlight several Trackables or Beacons or Rigid/Soft Frames at once and
then click Enable Selected to send to third parties, or click Disable Selected to stop sending.
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(By default, no Beacons are sending to third parties.)

Notes: 

If a Beacon or Frame is patched to a Trackable, the Beacon or Frame will not be available for
selection to enable in their respective tab.
Rigid and Soft bodies display their name instead of Beacon ID.
Click Apply Changes to apply all changes that you set in Output Configuration.
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Output Options
The Output Options section is where Trackable data that is being sent can be altered.

Attention: The settings affect Output Modules that are sending data from BlackTrax, and applies to
RTTrPM outputs.

Trackable Settings tab: Set tracking smoothing response for a single or multiple trackables. The
Smoothing option is enabled when Acceleration and Velocity in the Output Modules is selected.

 Trackable Settings tab

Smoothing: Set how fluid the XYZ values of the Trackable become.
Use the slider and the scroll box to adjust the range of fluidity from Smooth to Responsive, to
set the range between -4 to +2. Both slider and the scroll box correspond to the same
perimeter.
A more smoothed Trackable will result in less jitter going to the third party, and can help
smooth out less than ideal calibrated volumes, but it will introduce a slight delay as well.

To set the smoothing response of a selected trackable

On the Output Modules tab, select the Acceleration and Velocity checkbox and clear the Output1.
Raw Position checkbox.

Result: Smoothing is enabled on the Trackable Settings tab.
On the Sending Trackables section, select a single or multiple Trackable(s).2.
On the Trackable Settings tab, use the Smooth to Responsive slider or click the scroll box to set the3.
range of fluidity between -4 to +2.

Result: The smoothing range that was set is displayed in the Smoothing column of the
Sending Trackables section.

Output Modules tab: Select which data to send through the selected output module.

 Output Modules tab

Send: Select the checkboxes to choose the output connection data that will be sent through.
LED: Select this checkbox to send BTBeacon LED data.
Centroid: Select this checkbox to send BTBeacon Centroid data.
Orientation: Select this checkbox to send BTBeacon orientation data.
Timestamps: When enabled, the Frame ID generated by the TimeKeeper is used as a time
stamp.
Acceleration and Velocity: Select this checkbox to send centroid and/or LED position
acceleration and velocity data.

Note: The Smoothing option on the Trackable Settings tab is enabled when
Acceleration and Velocity checkbox is selected.

Output Raw Position: Select this checkbox to turn off the filter that is used for the
acceleration and velocity data that was sent.

Notes:
Acceleration and velocity data is not 100% accurate due to inaccuracies that can
occur, such as BTSensor jitter, poor BTSensor calibration, reflections and IR
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interference. This creates imperfect data or noise. Filtering the data is a way to
correct any noise that enters the data.
Enabling Output Raw Position, or disabling Acceleration and Velocity will de-
activate the smoothing slider from the Trackable Settings tab.

Zones: Select this checkbox to send Static and Dynamic Zones collision detection data for the
selected Trackable over RTTrPM . Zones checkbox is selected by default.

Notes: 
When a Trackable or Beacon collides a Zone, that Zone is sent as part of the Zone
Collision module.
If a Zone is not listed, the Trackable is not colliding with that Zone.

RTTrPM (Real-Time Tracking Protocol - Motion)
RTTrPM is the protocol that is used to stream to third party listeners that are interested in the position
and orientation of a tracking point, relative to the origin of the coordinate system (as defined by the
user). Go to https://rttrp.github.io/RTTrP-Wiki/RTTrPM.html  to see RTTrPM Modules and Packet
Structure information for Trackable, Centroid and Tracked Point Position, Orientation, Centroid and
Tracked Point Acceleration and Velocity, and Zone Collision Detection.

Note: As new modules can be added to the RTTrPM protocol for different features, ensure the third party
has written support for the apropriate module. Contact CAST or the Third Party for information.
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Output Configuration Settings for Third
Parties
Known Output Configuration settings for third parties:

Media Servers:
Avolites Ai
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Big Endian (Network Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Checked

disguise
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamps: Checked
Acceleration and Velocity: Checked

Green Hippo
Edit Output > Advanced tab

Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
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Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Checked

Modulo Kinetic
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Big Endian (Network Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Checked

Touch Designer
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Checked

Watchout
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Unchecked
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Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Unchecked

Widget Designer
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Unchecked

Isadora
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Accelaration and Velocity: Checked

 

Camera Control:
CamBot Designer
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion

BlackTrax Wiki 313 May 2021



Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamps: Unchecked
Acceleration and Velocity: Unchecked

MRMC Flair
Edit Output > Advanced tab

Coordinate System: Screen
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamps: Unchecked
Acceleration and Velocity: Unchecked

Rushworks CTRL+R
Edit Output > Advanced tab

Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked

Please Note: Rushworks CTRL+R will only work with the default RTTrPM Multicast network settings.

 

Lighting Visualization:
Capture
Edit Output > Advanced tab

Coordinate System: Screen
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Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamps: Unchecked
Acceleration and Velocity: Checked

WYSIWYG
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

 

Motion Control:
Raynok Motion Control Software & System
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Unchecked
Acceleration and Velocity: Unchecked
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Spatial Audio:
L-Acoustics L-ISA
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamps: Unchecked
Acceleration and Velocity: Unchecked

SPAT
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler

Output Options > Output Modules tab

LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamps: Unchecked
Acceleration and Velocity: Checked

Spacemap Go
Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Big Endian (Network Order)
Orientation: Euler

Output Options Output Modules > tab

LED: Checked
Centroid: Checked
Orientation: Unchecked
Timestamps: Unchecked
Acceleration and Velocity: Unchecked
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d&b Soundscape
Edit Output > Network tab

Communication: Unicast

Edit Output > Advanced tab

Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Big Endian (Network Order)
Orientation: Quaternion

Output Options Output Modules > tab

LED: Checked
Centroid: Checked
Orientation: Checked
Timestamps: Checked
Acceleration and Velocity: Checked
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System Status Widget

 System Status Widget

System Status displays the connection status, and data information for Tracker, Follower, Tracking
Adapter outputs, and Stage path location. You can click Alt+S on the keyboard to launch the System
Status widget. System Status checks for any RTTrPM outputs when the widget opens, and if so, a pop-up
dialog appears before opening and displays the text Analyzing System...Please Wait.... You may click on
the Cancel button to abort the operation, otherwise the pop-up dialog appears for one minute. If you
decide to skip the system being analysed, the widget will still be displayed, however any output latency
will display as "No Information" in Red.

 System Status pop-up dialog box

Each connection has the following information.

Connection:

Tracker
Motive

Internal input from Motive for motion data
Router

Input from physical Router for battery and button pushes from Beacons
Tracking Adapter Output

Internal output to Tracking Adapter(s)
Follower

Motion
Internal input from Tracker for motion data

DMX in
Input from a lighting console for sACN/Art-Net

BTWYG
Internal output to BTWYG for lighting visualization

RTTrPL
Output to a DMX Merge node for sending to a physical lighting system

Tracking Adapter
Traker Input

Internal input from Tracker for motion data
RTTrPM

Output to a third party using the RTTrPM protocol
Stage

Profile XML
Path location of the Motive profile

Current Calibration
Path location of the calibration data of the current project.
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Status: Connected/Disconnected at time of System Status being launched.

Packets: Number of Packets sent at time of the System Status being launched.

Data Sending: Yes/No depending on if packets are increasing.

Note: (Follower only. Displays DMX in Source.)

The System Status widget will also analyze and display the output latency in milliseconds of any Tracking
Adapter outputs running at the time of launching the widget. To accurately determine system latency,
the system needs to be measured over a full minute. Latency does not account for any latency within
Motive, from Stringer to BTSensor, or the network to the Third Party.

Latency will increase slightly with more active Beacons, so when using this tool, ensure all Beacons you
wish to measure are actively tracking before starting the test.
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Keyboard shortcuts
Standardized BlackTrax keyboard shortcuts are defined below:

Description Keyboard shortcuts

New Project Ctrl+N

Open Project Ctrl+O

Save Ctrl+S

Apply Changes Ctrl+Enter

Apply BTWYG Updates Ctrl+W

Copy Ctrl+C

Paste Ctrl+V

Select All Ctrl+A

Undo Ctrl+Z

Undo Stack Ctrl+Shift+Z

Redo Ctrl+Y

Live View Ctrl+1

Edit View Ctrl+2

Sensor Calibration View (Not available in Legacy Mode) Ctrl+3

Fixture Calibration View Ctrl+4 (Ctrl+3 in Legacy Mode)

Frame Calibration View Ctrl+5 (Ctrl+4 in Legacy Mode)

Close All Widgets Ctrl+'

Beacon Patch Ctrl+B

Beacons Ctrl+Shift+B

Output Configuration Ctrl+T

Messages Ctrl+M

Fullscreen Toggle F11

About BlackTrax F1

Close Alt+F4

Record Tracking and Lighting Data Ctrl+R

Launch System Status Widget Alt+S
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Record Tracking and Lighting Data
This feature enables BlackTrax to automatically record tracking and lighting data in the form of packets
while receiving incoming tracking data from Motive. This data will save in the C:\bt_run_time folder as a
.rec file. The recording can be played back in the Cue application.

To start/stop record tracking and lighting data

On your keyboard, click the shortcut Ctrl+R once to start recording.1.
Result: Tracking and Lighting Data starts recording automatically and the status bar displays
the record icon.                                                                                                            
Record icon

Click the shortcut Ctrl+R again to stop the recording.2.
Note: Three files are saved in C:\bt_run_time.

Motion data: Tracker-N1.
Radio data: Tracker-R2.
RTTrPL packets: Follower-L                                                                         3.

 Sample files saved in C:\bt_run_time
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Simulator & Cue Modules
Table of contents:

1 Simulator Module :
1.1 Layout of the Simulator Module :

2 Cue Module :
2.1 Layout of the Cue Module :
2.2 Record and Playback Tracking Data in the Cue Module :

 

BlackTrax Wiki 322 May 2021

http://wiki.blacktrax.ca/tiki-index.php?page=Simulator+Module&structure=Simulator+%26+Cue+Modules
http://wiki.blacktrax.ca/tiki-index.php?page=Layout+of+the+Simulator+Module&structure=Simulator+%26+Cue+Modules
http://wiki.blacktrax.ca/tiki-index.php?page=Cue+Module&structure=Simulator+%26+Cue+Modules
http://wiki.blacktrax.ca/tiki-index.php?page=Layout+of+the+Cue+Module&structure=Simulator+%26+Cue+Modules
http://wiki.blacktrax.ca/tiki-index.php?page=Record+and+Playback+Tracking+Data+in+the+Cue+Module&structure=Simulator+%26+Cue+Modules


Simulator Module
The Simulator Module is where the identification and positional data of BTBeacons can be created,
configured and managed in simulation. The Simulator can send and receive simulated data to and from
the other modules. The sections in the Simulator layout are:

Beacon Configuration
Beacon Position
Network Configuration
Message Log

 Simulator Module
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Layout of the Simulator Module
Beacon Configuration:
In the Beacon Configuration section, Beacons are created, identified, configured, and removed.

Create: Click this button to create a single Beacon using the Beacon and LED 0, LED 1, and LED 2
fields and add to the list in the table.
LED Bit Code: Select the LED Bit Type from the drop-down list.

Attention: Beacon LEDs are identified by flashing a specific bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system.  A real system is based on 12-bits.

Delete: Click this button to remove the selected Beacon(s) from the list in the table.
Beacon: In the box, type the number assigned for the Beacon that you will create and assign the
corresponding index numbers.
LED 0, LED 1, LED 2: In the boxes, type the LED indexes for each LED ID corresponding to the
Beacon number that you have set in the Beacon box.
Update: Click this button to apply the LED Indexes to the Beacon, which will be displayed in the
table.
Table: Displays the list of Beacon(s) created and LED Indexes, Bit Codes and position for each
corresponding LED.
LED 1, LED 2, LED 3: Select the checkbox to enable position data for that LED, and then type the
measurement (in meters) for the offseted X, Y and Z positions.
Apply: Click this button to apply the LED positions for the selected LEDs.

Note: LED positions are relative to the centroid position.
Batch Beacon Creation: Creates Beacons in a batch.

Count: In the box, type the number of Beacons you want to create in a batch.
Create: Click this button to create the batch of Beacons and add to the list in the table. When
created this way, Beacons follow the standard Preset Beacon numbering for ID and LED
indexes.

Beacon Position
In this section, the virtual positional offset coordinates of the centroid are displayed, and can be re-
configured.

Path Type: Click this drop-down list to select Manual or Circle.
Manual: Use the slider to set the measurements (meters) for X, Y, Z positions and RX, RY and
RZ (rotation). You can also type the measurement values in the boxes beside the sliders.

Update: Click this button to apply the entered centroid position to the selected
Beacon(s).
Range: In the boxes, type the measurement values (meters) in this section to set the
maximum and minimum ranges of the movements.
Update: Click this button to apply the range values to all Beacons.

Circle: Automatically rotates the Beacon with reference to the set position and rotation of the
centroid. You can also type the measurement values in the boxes beside to specify the
rotation location and angle. R=Radius of the circle's movement, and A=Angle of the circle
around the world coordinate system.

Update: Click this button to apply the position and rotation values to the selected
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Beacon(s).
Start/Stop: Toggle this button to start or stop the movement.
Pulse: Click this button to trigger a single pulse of movement.

Network Configuration
In this section, the network address and port information linked to the internal IP addresses of the
BTServer are displayed.

Motive Sender: Displays the network address and port information used for sending position data to
the other modules. Unmark the checkbox to disable the connection and stop sending position data.
Router Listener: Displays the network address and port information used for receiving data packets
(such as commands) from the Beacons. Unmark the checkbox to disable the connection and stop
receiving data.

Note: This feature is not currently used.
Router Sender: Displays the network address and port information used for simulating sent data
packets from the Beacons (such as battery status). Clear the checkbox to disable the connection
and stop sending data. 

Message Log
In this section, information on data that passes through the Simulator and system events are displayed.
This information can also be saved to a separate file for review later. Message Log files can be found at
C:\bt_run_time.

Display Log Data: Select this checkbox to display detailed packet information in the Message Log.
Write to File: Select this checkbox to save the log as a text file in the C:\bt_run_time folder.
Clear Log: Click this button to clear all messages in the log.
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Cue Module
Cue Module is where real-time or simulated tracking data in BlackTrax can be recorded as Time Stamp
Frames that will be saved as Chapters and played back in sequence. The sections in the Cue layout are:

Motive Input
Record
Recording Mode/Show Mode
Chapter Content
Chapter List Table
Log
Chapter Command

  Cue in Recording Mode

  Cue in Show Mode
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Layout of the Cue Module
Motive Input
In the Motive Input section, network settings are displayed showing the port and the input/output
connections to Motive.

Record
In the Record section, you can specify the Time Stamp Frame ID sequence to record by setting the start
and end Frames.

Frame ID: Specify the Frame time stamp data you want to record.
Start: In this box, type the Frame number where you will start the recording.
End: In this box, type the Frame number where you will end the recording.
Current Frame: Displays the actual Frames that are currently running.
Recorded: Displays the actual number of Frames that were recorded.

Start/Stop: Click this button, to start or stop the recording.
Note: You will not be able to Start before your Start Frame. The recording will also
automatically stop when you reach the end Frame.

Save To File: Click this button to save the recorded Frames as a .rec file to any location that you
choose.

Note: The Save To File button appears when a recording is completed. Once pressed a
browse window appears.

Chapter Content
In the Chapter Content section, you can select the recorded file that will be used in the Chapter that
you want to create.

File: Type the file name and path or click the browse button to locate and select the recorded
Frame.
Name: Type a name for the Chapter that you want to create.
Chapter ID: Type the number for the Chapter that you want to create (this corresponds to the
Chapter ID in the Main GUI).

Note: When the Main GUI enters Chapter 1, it sends a command to Cue to start playing
Chapter 1 as well (if in Show Mode). If the Main GUI enters a Chapter that does not exist in
Cue, then Cue will stop playing the current recording.

Loop: Select this checkbox to set the recorded file to play in a loop.
Delay (ms): Type the playback delay (in milliseconds) for the Chapter to wait after being triggered
to start playing data.

Recording Mode/Show Mode
In this section, you can toggle between Recording Mode or Show Mode.

Recording Mode: Saved files are created as Chapters and added to the table for editing and
playback.

Note: Click the Recording Mode button to toggle into Show Mode, which will display the list
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of Chapters in the table, and editing and playback from the Cue Module are disabled. Click
Enable Auto-Scroll to enable automatic scrolling through the Chapter list.

Load List: Click this button to load the list of saved Chapter(s) that were created and stored as a
BlackTrax Cue File (.bcf) file.
Save List: Click this button to save the list of Chapter(s) that were created in this module and
added to the list in the table. This saves a .bcf file.

Note: A .bcf file only contains references to the Chapter's .rec files. It does not contain the
.rec themselves. Ensure .rec files are still at the same path when loading .bcf files back into
Cue.

Play: Click this button to playback a selected Chapter from the table. Click the Stop button that
appears to stop the playback.
Delete Chapter: Click this button to remove the selected Chapter(s) from the table.
Create Chapter: Click this button to create a Chapter that consists of the file that has been
accessed and displayed in the Chapter Content section.

Table of Chapters
The table section displays the list of Chapters that have been created, showing in columns the Chapter
number, Name, File, Loop, Delay, Information, and Status.

Log
In the Log section, information on data that passes through the Cue module and system events are
displayed. This information can also be saved to a separate file for review later. Log files can be found at
C:\bt_run_time.

Enable Logging: Select this checkbox to display playback information.
To File: Select this checkbox to enable saving the log of data information into a file in the
bt_run_time folder.
Clear: Click this button to clear all the displayed log data.

Chapter Command
Received: Displays the number of Chapter changes received from the Main GUI.
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Record and Playback Tracking Data in
the Cue Module
The Cue Module is where you can record simulated tracking data and real-time tracking data in live mode
from Motive.  

In the Cue Module, the tracking data are recorded as Chapters that are stacked as a series of cues which
can be recalled from the Main GUI in BlackTrax. The Cue Module follows the Chapter in the Main GUI in
BlackTrax.

To record cues from tracking data recorded in Motive

Note:  By default,the Enable In and Enable Out checkboxes in the Motive Input section of Cue Module
are enabled and the network settings are displayed showing the port and the input/output connections to
Motive.

In Motive, go to the Recording view mode which will display the Timeline of the recorded file in the1.
Timeline section.
Open a recorded tracking data file (.tak) from Motive.2.
In Motive, identify the frame ID number where you want to start the cue that you will record.3.
In the Record section of the Cue Module, type the start frame ID number in the Start box of the4.
Frame ID section.
In Motive, identify the frame ID number where you want to end the cue that you will record.5.
In the Record section of the Cue Module, type the end frame ID number in the End box of the6.
Frame ID section.
In the Record section of the Cue Module, click Start.7.
In Motive, click the Play button in the Timeline section.8.

Note: You can type the start and end frame ID numbers in the preset boxes at the bottom of
the Timeline section in Motive.

In the Record section of the Cue Module, click Stop.9.
Result: The Save to File dialog box appears.

Click Save to store the file in your specified location.10.
Result: The recorded frame is saved as a chapter content file (.rec) which will be used to
create the stack of cues.

To create the chapters cue stack in recording mode

In the Chapter Content section of the Cue Module, type the file name and path of the recorded1.
Frame in the File box or click the browse button to locate and select the recorded Frame that you
want to create as a chapter in the cue stack list.
In the Chapter Id box, enter the number for the chapter you want to create. The Chapter ID number2.
will correspond and sync with the Chapter that you wish to recall and playback in the BlackTrax
GUI.
In the Name box, type the name that you want to add to the chapter that you will create.3.
Select the Loop checkbox to set the created chapter to play in a loop.4.
In the Delay (ms) box, you can type the length of time (in milliseconds) for the chapter to delay the5.
playback after it was triggered to start playing.

Result: The recorded Frames that were created as Chapters will be displayed in the table as
a stack of Chapter cues in series and sorted according to the Chapter ID number.

On the cue stack list of created Chapters, you can apply the following options:6.
Click Save List to save the current cue stack series of created Chapters as a BlackTrax Cue
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File (.bcf).
Click Load List to load the list of saved Chapters that was created and stored as a BlackTrax
Cue File (.bcf).
Click Create Chapter to add a Chapter that consists of the file that has been accessed in the
Chapter Content section.
Click Delete Chapter to remove the selected Chapter from the cue stack list.
Click Play to playback a selected Chapter from the cue stack list.

Click Recording Mode to toggle into Show Mode.7.
Result: The table will display the cue stack of Chapters in the table which will be played back
from the BlackTrax GUI. For example, when the Main GUI enters Chapter 1, Cue will also start
playing back the recorded file in Chapter 1 as well. When the Main GUI enters the Standby
Chapter or a Chapter that is not present in Cue, Cue will stop all playback. Editing and
playback from the Cue Module are disabled.
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BlackTrax Device Manager
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Device Manager User Interface
 Table of contents:

Introduction
Layout of the BlackTrax Device Manager GUI
Menu Bar

File Menu
Widgets Menu
Settings Menu
Help Menu
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Introduction
The BlackTrax Device Manager is a software application where external hardware used in the
BlackTrax system can be accessed and managed directly through a PC.

In the Device Manager, firmware can be uploaded to the Charging Stations, Sync Docks, Beacons,
Mini Beacons, TimeKeepers and Routers.
The Device Manager works with Charging Stations and Sync Docks that are connected to the
BlackTrax network.
Device Manager is connected and integrated to the BlackTrax Main GUI if running on the same PC.
Beacon and Trackable information will be shared between BlackTrax and Device Manager when
connected and integrated.
Mini Beacons connected to a Sync Dock will send battery status information to BlackTrax Main GUI.
Device Manager can be launched from the Modules menu in BlackTrax.
Device Manager will appear in the Modules Status widget when connected to BlackTrax and will log
connection status in Messages.

When Device Manager launches, it opens to the last used layout by default. When Device Manager opens
for the first time, the Main Panel, Device Settings, Charging Stations and System Log widgets are
displayed. The following section describes the various parts of the user interface.

 

Important Note: When uploading firmware, Device Manager will check if your TimeKeeper or Router
can run the desired Firmware based on the version number of the current device.

If the TimeKeeper or Router is running a 2.x version, then Device Manager will not upload 3.x
firmware.
The TimeKeeper or Router must run on an existing 3.x version for Device Manager to allow the
device to be updated to 3.x firmware.
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Layout of the BlackTrax Device Manager
GUI
The Device Manager displays the table of connected devices for TimeKeepers, Routers, Beacons and Mini
Beacons on the Main panel, the docking widgets for Device Settings, Charging Stations, System Log and
the Charging Station Settings tab.

Main Panel: The Main panel (center area) of the Device Manager displays the table of connected devices
for TimeKeepers, Routers, Beacons and Mini Beacons that are connected to the Device Manager.

 

Device Settings: The Device Settings widget displays the properties and settings for the control of the
devices connected to the Charging Station and/or Sync Dock. Each device type (Beacon, Mini Beacon, 
TimeKeeper, Router) has unique settings and properties. The Device Settings widget for each device type
displays the different settings.

 

Charging Stations: The Charging Stations widget displays identification, firmware information, and status
of all connected remote Charging Stations for BTBeacons and remote Sync Docks for Mini Beacons. In the
Charging Stations widget, you can select and display a Charging Station, and the settings of the selected
Charging Station will be displayed in the Charging Station Settings widget.

 

Charging Stations Settings: The Charging Stations Settings widget is where you can configure the
settings of a selected remote Charging Station or Sync Dock. When you select a Charging Station or Sync
Dock in the Charging Stations widget, the settings of the selected Charging Station or Sync Dock will be
displayed in the Charging Stations Settings widget.

  

System Log: The System Log widget displays the messages and data information from events that occur
in the Device Manager.
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Device Manager Menu Bar
 Device Manager Menu Bar

The Menu Bar across the top of the interface is where you will find menu commands to all functions of
the software. The different menus are:

File: Closing the Device Manager.
Widgets: Access to all the docking widgets, advanced mode and reset view toggle.
Settings: Access to the Device Manager Configuration module and the System Log widget.
Help: About information for the current release of Device Manager.
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Device Manager File Menu
 Device Manager File Menu

The File menu is where you can close the Device Manager when you click File > Exit Device Manager.
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Device Manager Widgets Menu
 Device Manager Widgets Menu

The Widgets menu provides: 

Access to the dockable widgets: Device Settings, Charging Stations and Charging Stations Settings.
Close and reset functions.
Access to advance mode controls.

The docking widgets comprise of a 'float' and 'close' function. Floating a widget will detach it from the
GUI, and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the Widgets menu.
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Device Manager Settings Menu
 Device Manager Settings Menu

The Settings menu provides access to the Device Manager Configuration module and the System Log
widget.
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Device Manager Help Menu
 Device Manager Help Menu

The Help menu provides access to the About Device Manager dialog box with information about the
Device Manager, product version, and build number.
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Device Manager Widgets
 Table of contents:

Main Panel
Device Settings
Charging Stations
Charging Station Settings
System Log
Device Manager Configuration
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Main Panel of Device Manager
When Device Manager launches, it displays the table of connected devices for TimeKeepers, Routers,
Beacons and Mini Beacons on the Main panel, and the docking widgets for Device Settings, Charging
Stations, System Log, and the Charging Station Settings tab.

The Main panel (center area) of the Device Manager displays the table of connected devices for the
TimeKeepers, Routers, Beacons and Mini Beacons that are connected to the BlackTrax. Click on the
Device Type Filter drop-down to choose which type of device to display: All or TimeKeeper or Router or
Beacon or Mini Beacon.

Note: TimeKeepers and Routers may be connected to a Charging Station via the USB port on the back of
the unit.

The Beacon, Mini Beacon, TimeKeeper, Router devices listed in the Main panel can each be selected and
the settings of the selected device will be displayed in the Device Settings widget and available for
modification. You can also select multiple devices to apply several settings at once.

 Main panel of Device Manager

The configuration settings displayed in the Main panel are:

Refresh Selection: Click this button to update the selection in the list.
Device Type Filter: Click this button to choose which type of device to display, All or TimeKeeper or
Router or Beacon or Mini Beacon.
ID: Identification number of the Beacon or Mini Beacon device. 

The Beacon ID is different from its 3 LED IDs (aside from Beacon 1).
The Mini Beacon ID is the same as its LED ID.

Trackable: Name of the Trackable to which this device is assigned within BlackTrax.
Type: The type of devices such as TimeKeeper, Router or Beacon or Mini Beacon. Click the column
heading Type to change the order of the list.
Status: If the device is Connected or Disconnected.
Station: Identification of the Charging Station where the device is currently plugged, or USB if
plugged via USB. Mini Beacons display the port where it is plugged in on the Sync Dock (for
example: 101:1 is Port 1 on Sync Dock 101).
Battery: Percentage level of the battery life.
Radio: Shows if the radio signal from the connected device is On or Off. The Mini Beacons do not
have radio and will not be reflected in this column.
Version: The firmware version of the connected device.
Preset: Displays the assigned Preset number if the settings of the connected device match a
Preset configuration or Custom if the settings have been modified.
Calibration: Indicates if the device is a calibration Beacon.
Notes: Displays packets of feedback information that is sent to the device for firmware upload.

Note: When a device is added to the list, it stays in the table, even if disconnected (will display status as
Closed). When a device is added again, it will compare the unique hardware IDs to determine if the same
device or not, and will update its previous location in the table.
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Device Manager Device Settings
The Device Settings widget displays the properties and settings for the control of the devices connected
to the Charging Stations and Sync Docks. Each device type (Beacon, Mini Beacon, TimeKeeper, Router)
has unique settings and properties. The Device Settings widget for each device type displays different
settings.

When a device is selected in the Main Panel, the Device Settings widget will display the preset settings
by default.

Device Settings for a Beacon
To open device settings widget for a Beacon

In the Main Panel, click on the Beacon that you want to select.1.
Result: The Device Settings widget displays the settings of the selected Beacon.                   

   

Selected Device: The type and ID number of the selected Beacon.
Serial Number: The serial number of the selected Beacon.
Product Info: The additional information or name that was set to identify the selected Beacon.

To change the settings in device setting for a Beacon

On the Preset Beacon scroll box, click the arrows and select the Preset Beacon number (or type a1.
new number, from 1-85). 
Click Apply.2.

Result:
The default Beacon settings based on the selected Preset Beacon are applied to the
selected Beacon. Preset Beacon settings contain Beacon ID, Wireless Channel, Subnet,
LED Brightness, and other system level settings. 
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration), or Custom when the settings of the Beacon were changed and currently
do not match a Preset Beacon.

Select the Calibration Beacon checkbox if the selected Beacon should be programmed as a3.
calibration unit. A Calibration Beacon automatically transmits signal packets faster.

Note: To unassign a Beacon as a Calibration Beacon, clear the checkbox and re-apply the
Preset Beacon.

On the Beacon ID scroll box, click the arrows and select a Beacon ID number (or type a new4.
number, from 1-85) if you want to customize the ID of the Beacon.
Click Apply.5.

Result: The Beacon ID number is changed and the Current Preset displays Custom.
On the Wireless Channel scroll box, click the drop-down list and select the Wireless Channel6.
number if you want to change the previously assigned Wireless Channel.
Click Apply.7.

Result: The Wireless Channel is changed and the Current Preset displays Custom.
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On the Subnet scroll box, click the arrows and select the wireless Subnet number (or type a new8.
number) that devices on the same Wireless Channel will use to communicate.
Click Apply.9.

Result: The Subnet is changed and the Current Preset displays Custom.
On the LED Brightness (ms) scroll box, click the arrows and select the length of exposure (in10.
milliseconds) (or type in a number, from 1-8) to increase or decrease the brightness of the LED.
Click Apply.11.

Result: The LED Brightness is changed and the Current Preset displays Custom.
Note: The increase in the level of LED Brightness will decrease the battery life of the Beacon
but may result in the LED being seen at farther distances. (Default = 3ms)

 In the Loaded Firmware section, a device firmware can be located, selected and uploaded into12.
the selected Beacon(s).

To upload a firmware

Click Browse and select the firmware file and load into memory.1.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update begins.4.
When firmware update is complete, a checksum is performed to verify the upload.5.
When checksum is complete, the device reboots.6.

Status: Displays the current state of the firmware in the selected device.
Not Ready (no file loaded)
Ready (file loaded/previous flash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually flashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a Mini Beacon
To open device settings widget for a Mini Beacon

In the Main Panel, click on the Mini Beacon that you want to select.1.
Result: The Device Settings widget displays the settings of the selected Mini Beacon. 

 

Selected Device: The type and ID number of the selected Mini Beacon. The Mini Beacon ID is the
same as its LED ID.
Serial Number: The serial number of the selected Mini Beacon.

To change the settings in device settings widget for a Mini Beacon

On the Preset Beacon scroll box, click the arrows and select the Preset Beacon number (or type a1.
new number, from 1-255).

BlackTrax Wiki 343 May 2021

http://wiki.blacktrax.ca/tiki-download_file.php?fileId=537&display


Click Apply.2.
Result: 

The default Mini Beacon settings based on the selected Preset Beacon are applied to
the selected Mini Beacon. Preset Beacon settings contain Beacon ID, LED Brightness,
and other system level settings.
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3),
or Custom when the settings of the Mini Beacon were changed and currently do not
match a Preset Beacon.

On the Beacon ID scroll box, click the arrows and select a Beacon ID number (or type a new3.
number, from 1-255) if you want to customize the ID for the Mini Beacon.
Click Apply.4.

Result: The Beacon ID number is changed and the Preset Beacon ID is updated (provided the
brightness remains at 2.5ms).

On the LED Brightness (ms) scroll box, click the arrows and select the length of exposure (in5.
milliseconds, or type in a number, from 1-8) to increase or decrease the brightness of the LED.
Click Apply.6.

Result: The LED Brightness is changed and the Current Preset displays Custom.
Note: The increase in the level of LED Brightness will decrease the battery life of the Mini
Beacon but may result in the LED being seen at farther distances. (Default = 2.5ms)

In the Loaded Firmware section, a device fimware can be located, selected and uploaded into the7.
selected Mini Beacon(s).

To upload a firmware

Click Browse and select the firmware file and load into memory.1.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update begins.4.
When the update is complete, the device reboots.5.

Status: Displays the current state of the firmware in the selected device.
Not Ready (no file loaded)
Preparing firmware file upload
Transferring firmware file
File loaded, ready to upload

Device Settings for a TimeKeeper
To open device settings widget for a TimeKeeper

In the Main Panel, click on the TimeKeeper that you want to select.1.
Result: The Device Settings widget displays the settings of the selected TimeKeeper.

Selected Device: Displays TimeKeeper.
Serial Number: The serial number of the selected TimeKeeper.
Product Info: The additional information or name that was set to identify the selected
TimeKeeper.

To change the settings in device settings for a TimeKeeper

Click on the Wireless Channel drop-down arrow and select the Wireless Channel number from the1.
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drop-down list if you want to change the previously assigned Wireless Channel.
Click Apply.2.
On the Subnet scroll box, click the arrows and select the Subnet number (or type a new number)3.
that devices on the same Wireless Channel will use to communicate.
Click Apply.4.
In the Loaded Firmware section, a device firmware can be located, selected and uploaded into5.
the selected TimeKeeper(s).

Note: The Mini Beacon must connect to the latest TimeKeeper (Rev J) model. Contact BlackTrax
Technical Support (CAST) for the firmware version required to run Mini Beacons with the TimeKeeper,
Router and Beacons.

To upload a firmware

Click Browse and select the firmware file and load into the memory.1.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update begins.4.
When firmware update is complete, a checksum is performed to verify the upload.5.
When checksum is complete, the device reboots.6.

Status: Displays the current state of the firmware in the selected device.
Not Ready (no file loaded)
Ready (file loaded/previous flash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually flashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a Router
To open device settings widget for a Router

In the Main Panel, click on the Router that you want to select.1.
Result: The Device Settings widget displays the settings of the selected Router.

Selected Device: Displays Router.
Serial Number: The serial number of the selected Router.
Product Info: The additional information or name that was set to identify the selected Router.

To change the settings in device settings for a Router

Click on the Wireless Channel drop-down arrow and select the Wireless Channel number from the1.
drop-down list if you want to change the previously assigned Wireless Channel.
Click Apply.2.
On the Subnet scroll box, click the arrows and select the Subnet (or type a new number) that3.
devices on the same Wireless Channel will use to communicate.
Click Apply.4.
In the Loaded Firmware section, a device firmware can be located, selected and uploaded into5.
the selected Router(s).

To upload a firmware
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Click Browse and select the firmware file and load into the memory.1.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update is complete, a checksum is performed to verify the upload.4.
When checksum is complete, the device reboots.5.

Status: Displays the current state of the firmware in the selected device.
Not Ready (no file loaded)
Ready (file loaded/previous flash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually flashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

BlackTrax Wiki 346 May 2021



Device Manager Charging Stations
The Charging Stations widget displays identification, firmware information, and status of all connected
remote Charging Stations for BTBeacons and remote Sync Docks for Mini Beacons .

In the Charging Stations widget, you can select and display a Charging Station or Sync Dock, and the
settings of the selected Charging Station or Sync Dock will be displayed in the Charging Station Settings
widget.

The Auto Get (minutes) scroll box on the Charging Stations widget sets the length of time interval when
Device Manager will auto poll devices for connected Charging Stations, Sync Docks, and their connected
devices.

 

The Charging Stations widget displays the following settings:

Connect:
Click this button to connect the newly added Charging Station or Sync Dock.
For Sync Docks, click this button to apply the ID change after a firmware upload is complete.

Get Beacon List: Click this button to poll the connected Charging Stations and Sync Docks for all
connected Beacons and Mini Beacons and then add them to the main list.

Note: Sync Docks update its status once every 5 minutes. When connecting or disconnecting
Mini Beacons, click Get Beacon List for the up to date reporting. 

Auto Get (minutes): Click the Up or Down arrows or type a value to set the length of time interval
when Device Manager auto polls all devices for connected Charging Stations, Sync Docks, and their
connected devices.
ID: Identification number of the Charging Station or Sync Dock in the range between 101 to 254.
The default ID number is 201. The ID will always match the last octet of the IP Address (ID 201 =
10.133.5.201).

Note: For Sync Docks, 30 seconds after a firmware upload is complete, the ID changes will
take effect only after you click Connect.

Type: Charging Station or Sync Dock.
Serial Number: The serial number of the hardware.
IP Address: The network IP address where the Charging Station or Sync Dock is connected.
Status:

Connected or Disconnected.
For Sync Docks, when firmware is uploading, the Status column will display Disconnected
and the Notes column will display the warning text Please wait up to 30 seconds, then click
Connect for ID change to take effect.

Version: Firmware version.
Notes: Other information.
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Device Manager Charging Station
Settings
The Charging Stations Settings widget is where you configure the settings of a selected remote Charging
Station or Sync Dock. When you select a Charging Station or Sync Dock in the Charging Stations widget,
the settings of the selected Charging Station or Sync Dock will be displayed in the Charging Station
Settings widget.

 

Selected Device: Identification number of the selected Charging Station or Sync Dock.
CS ID/IP: Type the ID of the selected Charging Station or Sync Dock, then click Apply.
Loaded Firmware: In this section, a device firmware can be located, selected and uploaded into
the selected Charging Station or Sync Dock. 

To upload a firmware

Click Browse and select the firmware file and load into the memory.1.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update is complete, a checksum is performed to verify the upload.4.
When checksum is complete, the device reboots.5.

Status: Displays the current state of the firmware in the selected device.
Not Ready (no file loaded)
Ready (file loaded/previous flash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually flashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)
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Device Manager System Log
Data collected from events which occur in the Device Manager, such as system messages, configuration
changes, and other events can be displayed in the System Log widget. This information can be saved
into a separate file for review later.

The System Log widget displays the date and time of the event, type of data, and the information.

 

In the System Log widget, the checkboxes available to choose what and how messages are displayed or
logged.

Warnings/Errors Only: Select this checkbox to log and display only the notifications that
indicate errors that occurred or predictive warnings.
To File: Select this checkbox to record all Device Manager data and events into a remote file,
marked with the current date and time. This file is saved at "C:\bt_run_time\Device Manager".
Auto Scroll: Select this checkbox to automatically scroll to the most recent data or event that has
occurred.
Clear: Click this button to clear all messages.
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Device Manager Configuration
The Device Manager Configuration widget is where you can configure the settings for the Device
Manager application, such as Beacon LED Bit Pattern, Radio Status, and the Charging Station Network
Address.

 

To configure the settings of the device manager

From the Settings menu of the Device Manager, choose Device Manager Configuration.1.
Result: The Device Manager Configuration window appears.

On the LED Bit Pattern scroll box in the Device Manager Configuration window, select the LED Bit2.
Type that will apply to the Beacons connected to the Device Manager.

Attention: Beacon LEDs are identified by flashing a specific bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system. A real system is based on 12-bits.

Select the Radio On checkbox to indicate when a device is connected that its radio should stay on.3.
Radio On checkbox is clear by default.
The jump settings scroll box displays how the Device Manager behaves when a new device is4.
connected to the Charging Station. These jump settings are accessible in Advanced Mode.

No Jump: By default, the device will apply whatever it's firmware is set to.
Jump to Bootloader: Device Manager sets the device to jump to its bootloader.
Jump to Main Firmware: Device Manager sets the device to jump to the main firmware.

On the CS NIC Address scroll box, select the address for the Network Interface Card for the5.
Charging Station that is connected to the BlackTrax System. Charging Stations are locked to the
10.133.5.x network.
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Common Functions of the Device
Manager
To set preset Beacons

The use of Preset Beacon numbers acts as an easy and convenient way to configure all perimeters of
Beacons without manually entering all settings.

Connect the Charging Station to the BlackTrax System.1.
Open the Device Manager.2.

Note: All devices that are connected to the Charging Station are displayed in the Device
Manager automatically showing the connection status and preset settings.               

 

From the table in the Main panel of the Device Manager, select a Beacon.3.
Result: The Device Settings widget displays the settings (default preset or previously set
custom settings) of the selected Beacon.                                                                              

 

On the Preset Beacon scroll box of the Device Settings widget, scroll and select the Preset Beacon4.
number.
Click Apply.5.

Result: All the pre-programmed settings associated with Preset Beacon number is applied to
the selected Beacon.
Note:

Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration).
You may select several Beacons which assigns all Beacons with a different preset
number, incrementing by 1.

Select the Calibration Beacon checkbox if you want to set the Beacon as a calibration unit.6.
Result: The Calibration Beacon is set at Time Slot 1 and IMU is enabled. A Calibration Beacon
automatically transmits signal packets faster.
Note: To unassign a Beacon as a Calibration Beacon, you must uncheck the checkbox and
re-apply the Preset Beacon.

Example of the Preset Beacon settings:

Current Preset: 2
Wireless Channel: 26
Subnet: 35
LED Brightness: 3ms

 

To upload firmware from device settings
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In the Device Settings widget of a selected device, click Browse and select the firmware file and1.
load into memory.
Click Upload.2.

Result: The upload proceeds and the firmware upload process is displayed in the Status
section.

Device Manager checks if the selected device matches the firmware.3.
The firmware update begins.4.
When firmware update is complete, a checksum is performed to verify the upload.5.
When checksum is complete, the device reboots.6.
Status resets to display "Ready" if a file is loaded, or "Not Ready" if no file is loaded.7.

 

To program charging stations

When Device Manager opens, all devices that are connected to the Charging Station are automatically
displayed in the Device Manager widget showing the connection status and the latest applied settings.

  

Select a Charging Station from the list in the Charging Stations widget.1.
Result: The Charging Station Settings widget displays the identification number of the
selected Charging Station. The ID number includes the network address information. 

 

If you added or replugged a Charging Station to the system, click Connect to check the network for2.
any Charging Station on the system.

Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you may need to enable the connection again.

If you added or replugged a Charging Station with Beacons, click Get Beacon List to poll the3.
Charging Stations and update the main list with any connected Beacons.

Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you may need to refresh the list of devices connected to the
Charging Station.

 

To upload firmware from charging station settings

Select a Charging Station from the Charging Stations widget.1.
Result: The Charging Station Settings widget displays the settings of the selected Charging
Station.

In the Charging Station Settings widget of the selected Charging Station, click Browse and select2.
the firmware file and load into memory.
Click Upload.3.
Device Manager checks if the firmware matches the selected device and proceeds to update.4.

 

To configure TimeKeeper for USB camera system
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Note: Connect the TimeKeeper to the BlackTrax server via a USB cable.

Open Device Manager.1.
From the Widgets menu of the Device Manager, choose Advanced Mode.2.

Result: The Advanced Mode warning dialog box appears with cautionary information
resulting from access to the advanced function of devices.                                          

 

Click Yes.3.
Result: The Advanced Device Settings window appears.                                                   

 

On the Main panel, select the TimeKeeper.4.
On the Advanced Device Settings window, select Any legacy command typed down below from the5.
Commands drop-down menu.
Ensure Trace is enabled. The status log reports show - > as an indicator at the beginning of the6.
line.
If Trace is disabled, type "t 0".7.

Result: - > appears in the status log reports.
On the Parameters field, type "t 51 9".8.
Click Send Command.9.
Type "t 0" again to disable Trace.10.

Result: - > disappears from the status log reports.

Attention: After completing these steps, you must select Basic Mode from the Widgets menu to close
the Advanced Mode window.                              
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Health and Safety Information
Table of contents:

1 BTBeacon Lithium-Ion Battery Information :
2 Mini Beacon Lithium-Ion Battery Information :
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BTBeacon Lithium-Ion Battery
Information
The BTBeacon contains a rechargeable lithium-ion battery that is used to power the device. Improper use
of a lithium-ion battery can result in fire or serious injury. Please read and understand the following
general warnings on lithium-ion batteries.

General Warnings
Do not place the battery near fire, heaters, other high temperature locations, or apply heat to the
device.
Do not pierce the battery with any sharp objects, strike with heavy objects, or otherwise damage
the casing.
Do not expose the battery to water or any other type of liquid, or allow the device to get wet.
Never short-circuit, damage or heat the battery to approximately 60°C (140°F) ±.
If the lithium-ion battery does catch fire, it may burn even more violently if it comes into contact
with water or moisture in the air. DO NOT THROW WATER ON A BURNING BATTERY OR ITS LITHIUM-
ION BATTERY! A fire extinguisher must be used.

Shipping Information
When transporting lithium-ion batteries, the following regulatory guidelines are followed:

Section II of Packing Instructions 965 for Lithium Ion Battery Pack.
UN manual of Tests and Criteria, Part III, sub-section 38.3 (withstanding a 1.2M Drop Test).
The content of Lithium is less than 100Wh per battery.
The quantity per package is less then 10kg (gross) for UN3480. Thus the consignment is not
classified as dangerous goods.

 

BlackTrax Wiki 355 May 2021



Mini Beacon Lithium-Ion Battery
Information
The Mini Beacon contains a rechargeable lithium-ion battery that is used to power the device. Improper
use of a lithium-ion battery can result in fire or serious injury. Please read and understand the following
general warnings on lithium-ion batteries.

Name:               Rechargeable Li-ion Polymer Battery
Model:              ABI-H493027
Description:    Single Cell Lithium ion Battery
Watt-hour:      1.11 Wh
Weight:            6.3 g
Size:                 30.5 x 30.1 x 4.95 mm

General Warnings
Do not place the battery near fire, heaters, other high temperature locations, or apply heat to the
device.
Do not pierce the battery with any sharp objects, strike with heavy objects, or damage the casing.
Do not expose the battery to water or any other type of liquid, or allow the device to get wet.
Never short-circuit, damage, or heat the battery to approximately 60°C (140°F).
If the lithium-ion battery catches fire, it may burn even more violently if it comes into contact with
water or moisture in the air.
DO NOT THROW WATER ON A BURNING BATTERY OR ITS LITHIUM-ION BATTERY! A fire extinguisher
must be used.

Shipping Information
When transporting lithium-ion batteries, the following regulatory guidelines are followed:

UN 3481 (PI967) - Lithium Ion Batteries contained in equipment (Section 2). Equipment must be
packed in strong outer packaging that conform to the below.
Net quantity of Lithium Ion cells or batteries per package:

Passenger: 5 kg
Cargo: 5 kg

The content of Lithium-ion is less than 100 Wh per battery.
Section II of Packing Instruction 965 for Lithium Ion Battery Pack.

Additional Requirements:

The equipment must be secured against movement within the outer packaging and must be
equipped with an effective means of preventing accidental activation.
Cells and batteries must be protected to prevent short circuits.
The equipment must be packed in strong outer packaging constructed of suitable material of
adequate strength and design in relation to the packaging's capacity and its intended use unless
the battery is afforded equivalent protection by the equipment in which it is contained.
Each package containing more than four cells, or more than two batteries installed in equipment
(including circuit boards).
Each consignment with packages bearing the lithium battery handling label must be accompanied
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with a document with an indication that:
the package must be handled with care and that a flammability hazard exists if the package
is damaged;
special procedures must be followed in the event the package is damaged, to include
inspection and repacking if necessary; and 
a telephone number for additional information.

Where a consignment includes packages bearing the lithium battery handling label, the words
"Lithium Ion Batteries in compliance with Section II of PI967" must be placed on the air waybill,
when an air waybill is used.
Any person preparing or offering cells or batteries for transport must receive adequate instruction
on these requirements commensurate with their responsibilities.
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